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Chapter 1

Introduction

1.1 About this manual

This manual is a reference to TOPSPIN acquisition or acquisition related
commands and parameters. Every command is described on a separate
page with its syntax and function as well and its main input/output files
and parameters. Although file handling in TOPSPIN is completely transpar-
ent to the user, it is sometimes useful to know which files are involved and
where they reside. For example, if you have permission problems or if
you want to process or interpret your data with third party software.

Some of the commands referred to in this manual are processing com-
mands. They are all described in the Processing reference manual.

1.2 Conventions

Font conventions
zg - commands to be entered on the command line are in courier bold
italic

Restore - commands to be clicked are in times bold italic
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go=2 - pulse program statements are in courier small
fid - filenames are in courier
contents - any contents of a text file is in courier small

name - any hame which is not a filename is in times italic

File/directory conventions
<tshome> - the TOPSPIN home directory (default C\:Bruker\Topspin under
Windows or /opt/Topspin under Linux)

Header conventions
SYNTAX - only included if the command described requires arguments

USED IN AU PROGRAMS - only included if an AU macro exists for com-
mand described

1.3 About dimensions

ToPSPIN can acquire up to 8 D dimensional data. The directions of a da-
taset are indicated with the terms F1, F2, F3 etc. which are used as fol-
lows:

1D data
F1 - acquisition direction
2D data:

F2 - acquisition or direct direction
F1 - indirect direction

3D data:

F3 - acquisition or direct direction
F2 - indirect direction
F1 - indirect direction

In 3D processed data, F2 is always the second and F1 the third direction.
In 3D raw data, this order can be the same or reversed, depending on the
value of AQSEQ (see the description of this acquisition parameter).

A-6
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1.4 About digitally filtered Avance data

The first points of the raw data measured on an Avance spectrometer are
called group delay. These points represent the delay caused by the dig-
ital filter and do not contain spectral information. However, they contain

information about the digital filtering and are required for processing. The
first couple of points of the group delay are always zero. The group delay
only exists if digital filtering is actually used, i.e. if the acquisition param-
eter DIGMOD is set to digital.

1.5 Usage of acquisition commands in AU programs

Many acquisition commands described in this manual can also be used
in AU programs. The description of these commands contains an entry
USAGE IN AU PROGRAMS. This means an AU macro is available which
is usually the name of the command in capitalized letters. Note that ICON-
NMR automation automatically calls acquisition AU programs. If, in this
manual, the entry USAGE IN AU PROGRAMS is missing, no AU macro
is available. Usually, such a command requires user interaction and it
would not make sense to put it in an AU program. However, if you still
want to use such a command in AU, you can do that with the XCMD mac-
ro which takes an TopsPIN command as argument. Examples are:

XCMD("eda")
XCMD("setdef ackn no")

AU programs can be set up with the command edau.

Acquisition commands can also be used in an TOPSPIN macro. These are
scripts created with edmac containing a sequence of TOPSPIN commands
or Python commands.

1.6 Starting commands from the TOPSPIN menu

This manual describes all acquisition commands as they can be entered
on the command line. However, they can also be clicked from the upper
toolbar or from the TOPSPIN popup menus. Most acquisition commands
can be found under the Spectrometer menu. Note that this menu is only
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available after TOPSPIN has been configured as a spectrometer (com-
mand cf£). There, the command line commands which correspond to the
menu entries are specified in square brackets.

1.7 Command queuing

A-8

In ToPsPIN 2.1 and newer, command spooling has been implemented.
Acquisition commands like zg, rga, atma and go are automatically
queued, if this feature is on (default off, can be set with the command
set). All other commands can be queued with the command qu, e.g. qu
x£fb.

Queued commands can be viewed in the Spooling field of the acquisition
status bar. Note that the spooling field must be activated in the User Pref-
erences window (command set).
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TOPSPIN parameters

2.1 About TOPSPIN parameters

TopPsPIN parameters are divided in acquisition and processing parame-
ters. In this manual, we will mainly concern ourselves with acquisition pa-
rameters. Furthermore, we will discuss the acquisition related lock and
prosol parameters.

The following terms will be used:

acquisition parameters

Parameters that must be set by the user, for example with eda, and that
are interpreted by acquisition commands, for example zg.

acquisition status parameters

Parameters that are set by acquisition commands like zg. They repre-
sent the status of the raw data and can be viewed, for example with dpa.
Some acquisition status parameters are used as input by processing
commands.

lock parameters
Parameters that are used for locking the magnetic field. They can be set
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up with the edlock command and are interpreted when you lock in, ei-
ther with the Tock command or from the BSMS keyboard/BSMS display.

prosol parameters

Probehead and solvent dependent parameters, mainly pulse lengths and
power levels. They can be set up with the edprosol command. The
getprosol command reads the prosol parameters and copies them to
the corresponding acquisition parameters. Note that entering get-
prosol is equivalent to clicking the AcquPars tab and the clicking ]
button.

input parameters

Parameters that are interpreted by the commands described in this man-
ual. They can be:

» acquisition parameters (input of, for example, zg)
* lock parameters (input of edlock, lock and lopo)
+ prosol parameters (input of edprosol and getprosol)

output parameters

Parameters that are set or modified by commands described in this man-
ual. They can be:

* acquisition status parameters (output of, for example, zg)
* lock parameters (output of edlock)
» prosol parameters (output of edprosol)

temporary parameters

Parameters that are not stored in parameters files and not interpreted di-
rectly by acquisition commands. They are related to other parameter that
are directly interpreted by acquisition commands. If you change a tempo-
rary parameter, for example in eda, the related parameters will be auto-
matically adjusted. An example of a temporary parameter is AQ that is
determined by the equation:

AQ = 2*TD/(SW*SFO1)

Acquisition parameters can be set with the parameter editor eda and
acquisition status parameters can be viewed with dpa. Alternatively, each
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parameter can be set or viewed by entering its name in lowercase letters
on the command line. For example, for the parameter TD:

* td- set the parameter TD
* s td- view the status parameter TD

The dimensionality of the dataset is automatically recognized. For exam-
ple, for a 2D dataset the following dialog box is offered:

Mo x|

Size of fid (F2, F1)

D= |256

(8] | Cancel |

Although status parameters are normally not changed by the user, a
command like s td allows you to do that. This, however, would make the
dataset inconsistent.

Before an acquisition has been performed, the acquisition status param-
eters of a dataset do not contain significant values. After the acquisition,
they represent the status of the raw data.

Most acquisition status parameters are set to the same values as the cor-
responding acquisition parameters. In other words, the acquisition com-
mand has done what you told it to do. There are, however, some
exceptions:

* when an acquisition was interrupted, the acquisition status parame-
ters might not have been updated yet.

* some acquisition parameters are automatically adjusted by the acqui-
sition command, e.g. RG and FW.

+ the values of some parameters are a result of the acquisition. They
cannot be set by the user (they do not appear as acquisition parame-
ters) but they are stored as acquisition status parameters. Examples
are AQSEQ, YMAX a and NC.

A-11
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2.2 Parameter value types

With respect to the type of values they take, acquisition parameters can
be divided into three groups:

» parameters taking integer values, e.g. NS, TD, DR
» parameters taking real (float or double) values, e.g. SW, O1, DE
» parameters using a predefined list of values, e.g. AQ_mod, DIGTYP

You can easily see to which group a parameter belongs from the param-
eter editor opened with the command eda. Note that the values of pa-
rameters which use a predefined list are stored in the parameter file as
integers. The first value of the list is always stored as 0, the second value
as 1 etc. Table 2.1 shows the values of the parameter AQ_mod as an ex-

ample:
Parameter | Integer stored in the proc(s)
value | file

gf 0
gsim 1
gseq 2
DQD 3

Table 2.1

2.3 Parameter files

ToPsPIN parameters are stored in various files in the dataset directory
tree.

In a 1D dataset:
<dir>/data/<user>/nmr/<name>/<expno>/

acqu - acquisition parameters
acqus - acquisition status parameters

In a 2D dataset:

<dir>/data/<user>/nmr/<name>/<expno>/
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acqu - F2 acquisition parameters

acqu?2 - F1 acquisition parameters

acqus - F2 acquisition status parameters
acqu2s - F1 acquisition status parameters

In a 3D dataset:

<dir>/data/<user>/nmr/<name>/<expno>/

acqu - F3 acquisition parameters

acqu? - F2 acquisition parameters

acqu3 - F1 acquisition parameters

acqus - F3 acquisition status parameters
acqu2s - F2 acquisition status parameters
acqu3s - F1 acquisition status parameters

2.4 Acquisition (eda) parameters

This paragraph contains a list of all acquisition parameters with a descrip-
tion of their function. Most of them are interpreted by various acquisition
commands like zg, go, ii, resume, gs and rga. Some, however, are
only interpreted by specific commands which are then specified in the list
below. Acquisition parameters can be set by entering eda on the com-
mand line, clicking the AcquPars tab of a data window or by typing the
parameter names in lowercase letters on the command line.

AQ - acquisition time in seconds

takes a float value
temporary parameter calculated from the equation:

AQ = TD/(2*SW*SFO1)

AQ represents the time to acquire one scan. If you change AQ, TD is
changed accordingly. The above equation holds for DIGTYP =
SADC. Other digitizers require a 1-4 extra dwell times. This number
is automatically detected from your digitizer by the acquisition soft-
ware.

AMP[0-31] - amplitude of pulses

takes float values in percent
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can be set from eda by clicking AMP ** Array **

can also be set by entering amp0, amp1 etc. on the command line
can also be set from the gs window

interpreted by the pulse program statements amp0, amp1, amp2 etc.

The parameter AMP defines the percentage of the maximum pulse
power. It can be used instead of or in addition to the parameter PL.
The advantage of AMP is that the relation between AMP values and
pulse power is more linear than in the case of PL. Furthermore the
pulse phases is more stable.

AQ_mod - acquisition mode

takes one of the values qf, gsim, gseq, DOD
can be set from eda or by entering aq_mod on the command line
The values of AQ_mod have the following meaning:

gf = single channel detection.

gseq = quadrature detection in sequential mode. Two channels are
used, whose reference phase differs by 90°. In the resulting fid, two
successive data points have been acquired by different detectors with
a time difference of DW.

gsim = quadrature detection in simultaneous mode. Two channels are
used, whose reference phase differs by 90°. In the resulting fid, two
successive data points have been acquired simultaneously by the two
detectors. The time difference between these points is 2* DW.

DQD = digital quadrature detection. Simultaneous mode that elimi-
nates quad images and O1 spikes. AQ_mod can only be set to DQD
when the parameter DIGMOD is set to digital or homodecoupling dig-
ital. When you set DIGMOD to analog, AQ_mod automatically chang-
es to gsim. Furthermore, DQD can only be used up to a certain
spectral width as is shown in table 2.6. Above this value, acquisition
commands automatically switch the acquisition mode to gsim. In that
case, the acquisition parameter AQ_mod = DQD but the acquisition
status parameter AQ_mod = gsim.

AUNM - name of an acquisition AU program

takes a character array value
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* can be set from eda or by entering aunm on the command line
* interpreted by xaua

* The command xaua executes the AU program specified by AUNM.
Although this can be any AU program, AUNM is normally used to
specify an AU program that performs an acquisition. For example, in
several standard parameter sets, AUNM is set to au_zg. The com-
mand xaua can be entered on the command line or called from AU
program with its macro XAUA.

BF1 - BF8 - basic frequency for frequency channel f1 to f8
+ take a double value (MHz)

» are automatically set when NUC1, NUC2 etc. are selected from
edasp

* When you set up an experiment and define NUC1 in the routing
table, BF1 is automatically read from the nucleus table. In the same
way, BF2 is automatically read when NUC2 is defined etc. The rout-
ing table can be opened with edasp or by clicking NUC1 in eda. The
nucleus table is created with the command cf that can be executed
by the NMR Superuser. This command prompts you for the 1H basic
frequency and then automatically calculates the basic frequencies for
all other nuclei. For each nucleus, cf sets the basic frequency such
that the most common reference substance for that nucleus would
resonate at about 0 ppm. If you want to change the nuclei table, you
can do that with the command ednuc. This is, for example, neces-
sary if you are using a different reference substance for a certain
nucleus. Note, that if you execute cf and change the 1H basic fre-
quency, you must click RESTORE in the nuclei table and execute
cfbsms, after cf has finished.

CNSTI[0-31] - array of constants used in pulse programs
» takes float values
» can be set from eda by clicking CNST ** Array **
» can also be set by entering cnst0, cnst1 etc. on the command line

» interpreted by the pulse program statements cnst0, cnst1, cnst2
etc.
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The values of the parameter array CNST can be used as constants in
a pulse program. For example, the pulse program line:

"d2 = 1s/cnst2*2"

uses the value of CNST2 as a coupling constant. Note the difference
between the pulse program statement cnst2 and the TOPSPIN com-
mand cnst2. The latter is actually not a command but a way of setting
the value of CNST[2].

CPDPRG1 - CPDPRGS - names of CPD programs

take a character string value

can be set from eda by entering a name or by clicking the down
arrow and then selecting a CPD program from the appearing list

can also be set by entering epdprgl, cpdprg2 etc. on the com-
mand line

interpreted by the pulse program statements cpd1 - cpd8, cpdsi-
cpds8 and cpdngsl - cpdngs8

The values of CPDPRG1 - CPDPRGS are the names of composite
pulse decoupling (CPD) programs. The pulse program statements
cpd1 executes the CPD program defined by CPDPRG1, cpd2 exe-
cutes the CPD program defined by CPDPRG2 etc. In several Bruker
CPD type parameter sets, the CPD program is specified by
CPDPRG2 and executed on frequency channel f2. For example, the
parameter set C13CPD contains the following settings:

CPDPRG2 = waltz16
PULPROG = zgpg30

and the pulse program zgpg30 contains the following line:

dl cpd2:f2
The statements cpd3 and cpd4 which execute the CPD programs
specified by CPDPRG3 and CPDPRG4, respectively, are often used
in 3D experiments. Note, however, that the cpdl - cpd8 commands

are equivalent and can be used to run any CPD program on any fre-
quency channel.

cpds1 works like cpd1, except that it will execute the CPD program
synchronously with the pulse program. This means cpds1 always
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starts the CPD program at the beginning, whereas cpd1 continues the
CPD program where it was last stopped by the do statement. The dif-
ference between cpds2 and cpd2, cpds3 and cpd3 etc. is equivalent.

cpdngl works like cpdi, except that the transmitter gate for channel
f1 will not be opened. cpdngs1 works like cpds1, except that the trans-
mitter gate for channel f1 will not be opened. For the channels f1, f2
ect. the statements cpdng2, cpdng3 etc are available.

The list of CPD programs which appears when you click the down ar-
row in eda, contains both Bruker and user defined CPD programs.
Bruker CPD programs must be installed, once, with expinstall.
You can set up your own CPD programs with the command edcpd.

D[0-31] - array of delays

takes float values (seconds)
can be set from eda by clicking D ** array **
can also be set by entering d0, d1, d2 etc. on the command line

interpreted by the pulse program statements 40 - 431, i1d0 - id31,
dd0 - dd31, rd0 - rd31

The pulse program statement 4o causes a delay of DO seconds, d1
causes a delay of D1 seconds etc. In principle, all delays can be used
for any purpose. In Bruker pulse programs, however, some conven-
tions are followed. These are listed in the file Param.info that can be
viewed with edpul. For example, D1 is used as a relaxation delay,
DO is used in combination with INO and NDO as incrementable delay
in 2D experiments. DO and D10 are used as incrementable delays in
3D experiments. Note however, that all delays D1 - D31 are incre-
mentable, not only DO and D10. For more information click:

Help > Manuals ° [Programming Manuals] Pulse Programming
Manual

DDR - digital digitizer resolution

takes an integer value
temporary parameter calculated according to the equation:

DDR = “log(DECIM) + 1

A-17
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cannot be set by the user

DDR expresses the enhancement of the digitizer resolution by digital
filtering. The total digitizer resolution, as defined by DR, is the sum of
the hardware resolution (see table 2.2) and DDR.

DE - pre-scan delay

takes a float value (microseconds)
can be set from eda or by entering de on the command line

DE is executed as a part of the go statement. DE consists of 4 pre-
scan subdelays DEPA, DERX, DE1 and DEADC. These subdelays
start simultaneously at the beginning of DE and after each subdelay
a certain action is performed:

DEPA: the preamplifier is switched from transmit to observe mode
(default 2 usec)

DERX: the receiver gate is opened (default 3 usec)

DE1: the intermediate frequency (if required) is added to the fre-
quency of the observe channel. This corresponds to the execution
of the syrec statement (default 2 usec). The intermediate frequen-
cy is only used for AQ_mod = DQD or, if your spectrometers has
an RX22 receiver, for any value of AQ_mod.

DEADC: the digitizer is enabled (default 4 usec)

DE can be set from eda or from the command line. The subdelays can
be set with the command edscon. Their maximum value is DE - 1
usec.

After DE, the digitizer starts to sample the data points.

For DIGMOD = analog, the parameter DE has a different purpose. It
is used to achieve a near zero first order phase correction of the spec-
trum. In this case, DE does not consist of the above subdelays and is
automatically adjusted when SW or DW are changed.

DECIM - decimation factor of the digital filter

takes an integer value
cannot be set by the user
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Avance spectrometers use the concept oversampling which means
that the data points are sampled much faster than specified by DW.
This results in a larger number of points than specified by the user; a
multiple of TD. Before the data are written to disk, they are digitally fil-
tered which reduces (decimates) their number to TD. The decimation
factor is defined by the following equation:

DECIM = DW/DWQOV

where DWOV is the oversampling dwell time. Note that DECIM can
only take an integer value and DWOV must be greater than the mini-
mum value for the current digitizer (see table 2.2). See also the acqui-
sition status parameter DECIM.

DIGMOD - digitizer mode

takes one of the values analog, digital, homodecoupling-digital, base-
opt
can be set from eda or by entering digmod on the command line

In most standard parameter sets, DIGMOD is set to digital which
means that oversampling and digital filtering is used. Oversampling
means that the data points are sampled much faster that specified by
DW. This results in a larger number of points than specified by the
user; a multiple of TD. Before the data are written to disk, they are
digitally filtered during which their number is reduced (decimated) to
TD. For homodecoupling experiments on a Avance-AQX spectrome-
ters, DIGMOD must be set to homodecoupling-digital. Digital filtering is
then switched on but the amount of oversampling is smaller (a larger
DWOV is used). For homodecoupling experiments on Avance-AQS
spectrometers, DIGMOD must be set to digital because the reduction
of the oversampling rate is not necessary. For DIGMOD = analog, dig-
ital filtering is switched off and analog filters are used. In that case,
your Avance spectrometer works like a AMX/ARX spectrometer.
However, since only a limited number of analog filter values is availa-
ble for Avance, setting DIGMOD to analog is not recommended.

In ToPsPIN 2.0 and newer, DIGMOD can also be set to baseopt (for a
description of this value, see parameter DSPFIRM).

DIGTYP - digitizer type

takes one of the values listed in table 2.2.

A-19



TOPSPIN parameters

A-20

can be set from eda or by entering digtyp on the command line

DIGTYP must be set to the value which corresponds to the digitizer
in your spectrometer. If you enter digtyp on the command line, you
can choose from all digitizers which are available for Bruker spec-
trometers. However, if you click on DIGTYP in eda, only the digi-
tizer(s) which exist in your spectrometer will appear. If you start your
experiment with a Bruker standard parameter set (read with rpar),
DIGTYP is usually set to the correct value. This is the value that was
entered during the installation of the parameter sets with expin-
stall. If your spectrometer contains more than one digitizer, you
might want to change the default value of DIGTYP. Note that the
SADC digitizer cannot be used for sequential acquisition (AQ_mod =

gseq).

digtyp digitizer resolution = DWOV range
(bit) (microseconds)
FADC (BC133) 12 0.05

HADC (HRD16) 16 25-50
SADC 16 3.325-6.65

HADC+ 16 25-50
SADC+ 16 3.325-6.65

IADC 16 0.1/0.05

Table 2.2

DQDMODE - sign of the frequency shift during digital quadrature detection

takes one of the values add or subtract
can be set from eda or by entering dgdmode on the command line

DQDMODE defines the frequency shift applied in Digital Quadrature
Detection mode as positive (add) or negative (subtract).

DR - digitizer resolution

takes an integer value

DR is the sum of the hardware resolution (see table 2.2) and the dig-
ital digitizer resolution DDR. It is automatically set to the maximum
resolution of the current digitizer (DIGTYP). Because Avance spec-
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trometers use the principle of oversampling, this value can be higher
than the resolution of the digitizer.

Usually, you want to use maximum resolution and keep this value of
DR. In some cases, however, it is useful to set DR to a lower value.
For example, if you want to acquire a large number of scans which
might cause overflow for the maximum value of DR. However, to solve
this problem, you can also set the parameter OVERFLW to check to
halt the acquisition as soon as data overflow would occur.

DS - number of dummy scans

takes an integer value

interpreted by the pulse program statement go=n, gonp=n and
rcyc=n

can be set from eda or by entering ds on the command line

Dummy scans are scans during which no fid is accumulated. Other
than that, they are identical to normal scans, which means they take
the same time (AQ) and perform phase cycling. Dummy scans are
used to reach steady state conditions concerning T1 relaxation. This
is necessary whenever the recycle delay of the experiment is shorter
then 4 times the T1 value of the measured nucleus. Furthermore,
they are used to establish a stable temperature. This is especially
important in decoupling and TOCSY experiments where the irradia-
tion high power increases the sample temperature. Dummy scans
are performed if DS > 0 and the pulse program contains a ze state-
ment before the go=n or rcyc=n loop. If a zd is used instead of ze,
dummy scans are omitted.

DSLIST - dataset list

takes a character array value

can be set from eda by entering a name in the DSLIST field or by
clicking the down arrow and selecting a name from the appearing list.

can also be set by entering ds1ist on the command line

interpreted by the pulse program statements wr #n, wr ##, ifp, dfp,
rfp

DSLIST defines the name of a variable dataset list. Such a list can be
created with edlist’ List type : ds and has the following format:
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sucrose 1 1 C:\ guest new
sucrose 2 1 C:\ guest new
fructose 1 1 D:\ guest old

where the option newlold is used to delete/keep a possibly existing da-
taset.

ToPsPIN 2.1 and newer support the usage of blanks in the top level di-
rectory, data name and user name, by specifying them in double
quotes, e.g.:

"sucrose low" 1 1 "C:/my documents" "John Smith" new

The list defined by DSLIST is interpreted by pulse program state-
ments:

wr ## - stores the data in the dataset defined at the current list po-
sition

wr #n - stores the data in the dataset defined at list position n

ifp - increments the dataset list position

dfp -decrements the dataset list position

rfp - resets the dataset list position

where n = 1,2,3 etc.

DSPFIRM - firmware used for digital filtering

takes one of the values sharp, user_defined, smooth, medium, rectangle
can be set from eda

DSPFIRM defines the filter function used for digital filtering. This
determines the maximum spectral width that can be used. For high
resolution experiments, DSPFIRM is usually set to sharp. The values
medium and smooth are used for other applications. Note that smooth
cannot be used for AQ_MOD = DQD. For DSPFIRM = user-defined,
an external file is read from <tshome>/exp/stan/nmr/lists/DSPFIRM.

In TOPsPIN 2.0 and newer, DSPFIRM can also be set to rectangle. The
oversampled data are then filtered in such a way that the initial points
of the FID are corrected. Setting DSPFIRM to rectangle will automati-
cally set the parameter DIGMOD to baseopt and vice versa. In order to
be able to correct the first points at the start of the FID, the exact po-
sition of the time 0 point must be known. This point is normally some-
where within the excitation pulse; for instance, for a normal 1-pulse-
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DW -

experiment with a 90° excitation pulse p0, itis at p0 * (1 - 2/ pi). How-
ever, this depends on the experiment. Therefore, a new parameter
ACQTO was introduced in TopsPIN 2.0, which can only be set within
the pulse program. It measures the zero time from the beginning of the
delay DE which is also the start of the go macro or the end of the ex-
citation pulse. For the example given above, the following line has to
be added at the beginning of the pulse program zg:

acqt0=-p0*2/3.14159;

This information enables the alignment of the data acquisition relative
to the time 0 point of the FID. As always, the time is measured from
left to right, and since this time is before the start of the FID, a negative
time results. If this statement is missing, it is not possible to use the
rectangle filter. As a result, the value of DE chosen by the operator
may be temporarily prolonged by the program. The effects of this filter
are:

* No first order phase distortion, so first order phase correction is
not necessary.

* No so-called smilies (distortions of the spectrum at the left and
right edges of the spectrum).

* The baseline of the resulting spectrum will be exactly 0 pro-
vided that no other effects distort the FID and that a correct
zero order phase correction has been done.

» Signals at the very edge of the spectrum are not attenuated or
distorted nor are they folded in.

The method needs some more internal memory, therefore, for larger
TD, the memory on the DRU (RCU) may be a limiting factor.

dwell time

takes a float value

can be set from eda or by entering dw on the command line

temporary parameter, calculated from the equation:
DW=10e6/(2*SW*SFO1)

The dwell time is the time between the acquisition of two successive
data points. Although it is normally calculated from SW, you can also
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set dw. In that case, the spectral width is adjusted according to the
equation:

SW=10e6/(2*(0.05+DW)*SFO1)
When you set DW, you will often notice that the value you enter is

slightly adjusted. The reason is that, when oversampling is used, the
relation

DW=DWOV*DECIM
must be fulfilled and DECIM can only take integer values.

DWOV - oversampling dwell time
» cannot be set by the user
» automatically set according to DIGTYP and DW
* has a minimum value which depends on the digitizer (see table 2.2)

» The parameter DWOQV reflects the principle of oversampling. This is
used when DIGMOD = digital and means that the data are sampled
much faster than specified by the user. In other words, a data point is
sampled every DWQOV us rather than every DW us where DWOV is
only a fraction of DW. DWOQV is set to the minimum value that can be
handled by the digitizer or DSP-firmware (see table 2.2). Actually the
value of DWOV is often a little above the minimum because the fol-
lowing relation must be fulfilled:

DWQV = DW/DECIM

Here, DECIM is the decimation factor that can only take integer val-

ues. For DIGMOD = analog (oversampling/digital filtering is switched
off), DECIM is automatically set to 1 and DWOV is set to the value of
DW.

EXP - experiment performed
» takes a character array value
* is set by ICON-NMR

* |ICON-NMR sets EXP to the value of the parameter set that was used
for the experiment.

FCUCHANIJO0-8] - routing between logical frequency channels and FCU’s
» array of integer values
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can be set from eda but is normally set graphically from the edasp
window (see this command for more information)

The values of FCUCHAN define the relation of the FCU’s to the logi-
cal frequency channels. For example, FCUCHANI[1] = 2 means that
FCU 2 is used for logical channel f1.

FIDRES - FID resolution

takes a float value (Hz)
A temporary parameter calculated from the equation:

FIDRES=SW*SFO1/TD

Although FIDRES is normally calculated from SW, you can also set
FIDRES. In that case, TD is adjusted while SW remains the same.
Note that the value that you enter for FIDRES if often adjusted a little.
The reason is that TD is recalculated according to TD =
SW*SFO1/FIDRES and rounded to the nearest power of two. FID-
RES is then adjusted to fulfil the same equation.

FNMODE - Acquisition mode of the indirect directions (data > 2D)

takes one of the values described below
can be set with eda or by entering fnmode
interpreted by the pulse program statement mc

The parameter FNMODE defines the acquisition mode of the indirect
directions in a multi-dimensional experiment. Compared to wr, the mc
statement simplifies the switching of the acquisition mode and allows
you to use the same pulse program for various experiments. FnMODE
can take the following values:

undefined
this value must be used if the pulse program contains no mc state-
ment.

OF

successive fids are acquired with incrementing time interval with-
out changing any phase program. This corresponds to the mc
clause F1QF or F2QF.

OSEQ

successive fids will be acquired with incrementing time interval and
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phases 0 and 90°. This corresponds to the mc clause F1PH or
F2PH.

TPPI

successive fids will be acquired with incrementing time interval and
phases 0°, 90°, 180° and 270°. This corresponds to the mc clause
F1PH or F2PH.

States

successive fids will be acquired incrementing the time interval after
every second fid and phases 0° and 90°. This corresponds to the
mc clause F1PH or F2PH.

States-TPPI

successive fids will be acquired incrementing the time interval after
every second fid and phases 0°, 90°, 180° and 270°. This corre-
sponds to the mc clause F1PH or F2PH.

Echo-Antiecho
special phase handling for gradient controlled experiments. This
corresponds to the mc clause F1EA or F2EA.

For more information on the mc statement and the use of FNMODE
click:

Help > Manuals ° [Programming Manuals] Pulse Programming
Manual

FQ1LIST - FQ8LIST - irradiation frequency lists

take a character array value

can be set from eda by entering a name or by clicking the down
arrow and selecting a name from the appearing list

can also be set by entering fgqllist, fq21list etc. on the com-
mand line

interpreted by the pulse program statements fq1 to £q8

The parameters FQ1LIST to FQ8LIST define the names of frequency
lists and are interpreted by the pulse program statement £q1 to £g8.

For example, the first time £q1 is executed, the first value in the fre-

quency list defined by FQ1LIST is read. The second time fq1 is exe-
cuted, the second value in this list is read etc. At the end of the



TOPSPIN parameters

frequency list, the list position is set back to the first value. Note that
fgl can be executed multiple times because it occurs on several
lines of the pulse program or because it occurs on a line that is part of
a loop. In the same way £q2 reads the list defined by FQ2LIST etc.
The fq1 to £g8 statements must be preceded with a delay and fol-
lowed by the frequency channel on which the pulse will be executed,
for example:

dl fqg2:f£2
In Bruker pulse programs, £q1 is normally used on channel f1, and g2
on channel f2 but any combination is allowed. The delay must be great-

er than 2 us. The frequency lists can be created or modified with the
command edlist.

FW - analog filter width
+ takes a float value
+ can be set from eda or by entering £w on the command line

» FW defines the width of the analog filter. For DIGMOD = dig-
ital/homodecoupling-digital, FW is automatically set for maximum
oversampling. The value depends on the digitizer type, typically
125000 for HADC/2.

GPO031 - gradient parameter table
» takes a list of real values (gradients) and character strings (filena-

mes)
Table 2.3
gradient parameters

Index GPX GPY GPzZ Filename

0 0.0 0.0 50.0 SINE.100

1 -50.0 -50.0 -50.0 RECT.1

2 75.0 75.0 75.0 GRADRECS

m

» can be set from eda by clicking GP031 edit
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the gradients are interpreted by pulse program statements grono -
gron31l and :gp0 - :gp31

the filenames are interpreted by pulse program statements :gp0 -
:gp31l

ToPsSPIN allows you to use static gradients and shaped gradients.
Static gradients have a constant strength during the time they are on.
They are switched on by the pulse program statements grono -
gron31. These read the gradient strength for each direction from the
GPO031 table. The groff command switches the static gradients off.
According to table 2.3, the pulse program section

d21 gron2
dz2
d23 groff

would switch the X, Y and Z gradient on during the time D1+D2 with
gradient strengths 75.0, 75.0 and 75.0, respectively. The gradient
strength is expressed as a percentage of the maximum strength and
runs from -100.0 to 100.0%. Static gradients do not use the Filename
entry of the GP031 table.

Shaped gradients have a strength that varies in time. They are
switched on by the pulse program statements gp0 - gp31. These inter-
pret the Filename field of the gradient table. A file which is defined here
contains a list of values between -1 and 1. Each value represents the
relative gradient strength for a given time interval. They are multiplied
with the values of GPX, GPY and GPZ to give the percentage of the
maximum gradient strength for the respective direction. According to
the table 2.3, the statement p16:gp2 would switch on the X, Y and Z
gradient on during the time P16 with gradient strengths 75.0, 75.0 and
75.0, respectively. The strength of each gradient would then vary in
time according to the list of values in the file gradrec5m. When you
click the down arrow to the right of each Filename field, a list of avail-
able files will appear. Such a list contains both Bruker and user defined
gradient files. The former must be installed once with expinstall,
with the option Install Library Gradient Files selected. The latter can be
created with the Shape Tool (command stdisp). The gradient files
reside in the directory:

<tshome>/exp/stan/nmr/lists/gp
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The gradient parameters can also be set from the keyboard. For ex-
ample, entering gpx2, gpy2, gpz2 allows you to set the gradient
strength for the three respective directions. With gpnam2 you can set
the shaped gradient file name.

GRDPROG - gradient program name
» takes an ascii string value
» interpreted by the pulse program statement ngrad

» Standard gradient programs are delivered with TOPSPIN. They must
be installed once, with the command expinstall with the option
Install Library Gradient Files selected. The ngrad pulse program
statement is mainly used on AMX/ARX spectrometers. On Avance
systems, the gron/groff are normally used for gradient control. An
exception is gradient shimming, where the ngrad statement is used.

HDDUTY - homodecoupling duty cycle (in percent)
+ takes a float value
» can be set from eda or by entering hdduty on the command line

« HDDUTY describes the ratio between the time used for homodecou-
pling and the time used for actual signal detection.

HPMOD - routing between high power amplifiers and preamplifier modules
» array of integer values

» can be set from eda but is normally set graphically from the edasp
window (see this command for more information)

HPPRGN - high power preamplifier gain
» takes one of the values normal or plus

» Gain selection for spectrometers equipped with HPPR preamplifiers.
By default, HPPRGN is set to normal. The value plus is only used for
test purposes and should not be used for experiments.

INP[0-31] - array of increments for pulses P[0-31]
» takes double values (usec)
* can be set from eda by clicking INP ** array **
* can also be set by entering inp0, inpl, inp2 etc. on the command
line
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interpreted by the pulse program statements ipu0 - ipu31 and dpu0-
du3l

The pulse program statement p0 executes a pulse with a length
specified by PO. This length can be modified by the following pulse
program statements:

ipu0 increments the pulse length by INP[0]
dpu0 decrements the pulse length by INP[0]
rpu0 resets the pulse length to the value of P[0]

In the same way, you can modify the length of the pulses executed by
pl to p31 with INP[1] to INP[31], respectively.

IN[0-31]- array of increments for delays D[0-31]

takes double values (sec)
can be set from eda by clicking IN ** array **
can also be set by entering in0, inl, in2 etc. on the command line

interpreted by the pulse program statements 140 - id31 and ddo-
dd31

The pulse program statement d0 causes a delay with a length speci-
fied by D[0]. This length can be modified by the following pulse pro-
gram statements:

id0 - increments the delay by IN[0]
ddo - decrements the delay by IN[0]
rdo - resets the delay to the value of D[0]

In the same way, you can modify the length of the delays caused by
d1 to a31 with IN[1] to IN[31], respectively.

In 2D dataset, IN[0] and NDI[0O] play a special role. In eda, they appear
as the single parameters INO and NDO in the F1 direction. They are
determined by the following equation:

SW(F1) = 1/(SFO1 * INO * NDO)

where INO is the spectral width and NDO the number of occurrences
of d0 in the pulse program. If you change INO or NDO, SW is automat-
ically recalculated. If you change SW, INO is recalculated and NDO re-
mains the same. You can set these parameters in eda or, from the
command line, with:
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in0
ndo0
sSw

Note that INO and NDO only exist in the F1 direction but SW exists in
F2 and F1.

In a 3D dataset, INO and NDO play the same role in F1 indirect direc-
tion as they do in the 2D dataset. F1, however, is the third direction
now. For the F2 indirect direction F2, the parameters IN10 and ND10
are used. In 3D, the following equations hold:

SW(F1) = 1/(SFO1 * INO * NDO)
SW(F2) = 1/(SFO1 * IN10 * ND10)
You can set these parameters in eda or, from the command line, with:
in0
ndo0
inl0
ndlo
SwW

Note that INO and NDO only existin F1, IN10 and ND10 only in F2 but
SW exists in F3, F2 and F1.

L[0-31] - array of loop counters

takes integer values
can be set from eda by clicking L ** array **
can also be set by entering 10, 11, 12 etc. on the command line

interpreted by pulse program statements 10-131, iu0-iu31, du0-
du3l and ru0-ru3l

The parameters L[0] - L[31] are read by the pulse program state-
ments 10 - 131. These are mainly used in loop structures like 10 to x
times 10 where x is a pulse program label; a number or a string
which labels a previous line in the pulse program. An example of
such a structure is:

4 (pl phl)
d2
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lo to 4 times 13

The loop counter values can be varied as follows:
iu0 - iu31 increment the loop counter used 10 - 131 by 1.
du0 - du31 decrement the loop counter used 10 - 131 by 1.

Note that these increments and decrements only count during the ex-
ecution of the current pulse program. They are not stored in the pa-
rameters L[0] - L[31]. Furthermore,

ru0 - ru31 reset the loop counter used 10 - 131 to L[0] - L[31]

The statements 10 - 131 are also used in if structures (conditions).
Two simple conditions are:

if " (13 !'= 0)" :trueif 13 is unequal zero
if " (13 == 0)" :trueif 13 equals zero

Further conditions are:
if " (13 operand expression)"

where operand can be: ==, !=, >, <, >=0r <= and expression can be
a number or an arithmetic expression built from pulses, delays and/or
loop counters. The statements effected by a certain condition must be
put between curly brackets. Furthermore, you can use the e1se struc-
ture for statements which must be executed if the condition is not true.
An example is:

if " (15 > 2)"
{
prl phl

}

else

{
}

Note that the syntax of the conditional statements is similar to C lan-
guage syntax. However, you cannot use the C "else if" statement.

LOCNUC - lock nucleus
» takes a character string value
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can be set from eda by entering a name in the LOCNUC field or by
clicking the down arrow and selecting a nucleus from the appearing
list

can also be set by entering 1ocnuc on the command line
is interpreted by edlock, lock, lopo, sref

High resolution samples are usually locked on 2H or 19F. For these
two nuclei, standard lock parameter files are delivered with TOPSPIN.
These can be edited with the command edlock.

NBL - number of blocks (of acquisition memory)

takes an integer value
interpreted by the pulse program statements st, st0, ze, zd, wr, if.

The parameter NBL is used to acquire FID’s in multiple memory
blocks, for example in NOE difference experiments. For NBL = 1 (the
default value), one FID (NS averages) is written to disk at the end of
the acquisition. For NBL > 1, multiple FIDs are acquired in the acqui-
sition memory before these are written to disk. The st statement
increments the memory pointer by TD in order to use the next block.
The statement wr #0 will write NBL FIDs to disk. The following pulse
program statements interpret NBL.:

st - increment the memory pointer by TD

wr - write NBL blocks to disk

st0 - set the memory pointer to the position of the first FID
ze, zd - clear the acquisition memory of all NBL blocks

if - increment the file pointer in the raw data file by NBL*TD
df - decrement the file pointer in the raw data file by NBL*TD
nbl - loop counter specifying the number of blocks

If TD is not a multiple of 256 (1024 bytes), successive FIDs will still be-
gin at 1024 byte memory boundaries. This is so for the FIDs in the ac-
quisition memory as well as on disk. The size of the raw data file (ser)
is therefore always a multiple of 1024 times NBL.

NDO - number of delays DO

takes an integer value
temporary parameter
only used in 2D and 3D datasets in the F1 direction
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Number of d0 statements in the increment loops of a pulse program
for 2D or 3D experiments. Used to calculate the spectral width in the
F1 direction according to:

SW=1/(SFO1 * NDO * INO)

NO is set to 2, if the evolution time contains a 180° pulse (e.g. HMQC,
HMBC, HSQC). Otherwise, it is setto 1 (e.g. NOESY, CO-
SY,ROESY,TOCSY).

ND10 - number of delays D10

takes an integer value
temporary parameter
only used in 3D datasets in the F2 direction

Number of 410 commands in the increment loops of a pulse program
for 3D experiments. Used to calculate the spectral width in the F2
direction according to

SW =1/ (SFO1 * ND10 * IN10)

ND10 is typically set to 2, if the evolution time contains a 180° pulse.
Otherwise, it is set to 1. Usually this is described in the pulse program
comment section.

NS - number of scans

takes an integer value

interpreted by the pulse program statement go=n, gonp=n and
rcyc=n

can be set from eda or by entering ns on the command line

The pulse program statements go=n and rcyc=n loop NS times to
the line which the label n. In Bruker pulse programs, the label n is
usually 2. The acquired data are accumulated in memory. After NS
scans, the pulse program continues with the next statement which is
often wr #0. This statement writes the accumulated data to disk.

After setting NS, you can calculate the resulting experiment time with
the command expt. Then you can adjust NS such that the available
time is properly used. Alternatively, you can set NS to a high value and
halt the experiment (with the command halt) when time is up (see
also DS and OVERFLW).
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NUC1 - NUCS - nucleus for frequency channel f1 - f8

take a value from a predefined list of nuclei
can be set from eda by clicking Edit
can also be set from edasp

The parameter NUC1 assigns a nucleus to the frequency channel 1,
NUC2 assigns a nucleus to the frequency channel f2 etc. In most
routine experiments, only NUC1, NUC2 and NUC3 are used. For
example:

a 1D PROTON experiment without decoupling:

NUC1 =1H
NUC2 = off
NUC3 = off
a 1D C13 experiment with 1H decoupling:
NUC1=13C
NUC2 = 1H
NUC3 = off
a 2D 1H experiment with 13C and 15N coupling:
NUC1 =1H
NUC2 =13C
NUC3 = 15N

In 2D datasets, NUC1 in the indirect direction (F1) must be set by se-
lecting a nucleus from the listbox. In 3D datasets, this principle holds
for both indirect directions, F2 and F1.

O1 - O8 -irradiation frequency offset for frequency channel f1 - f8 in Hz

take a double value (Hz)
can be set from eda or by entering o1, o2 etc. on the command line

can also be set from edasp by adjusting OFSH1, OFSX1, OFSH2
etc.

can also be set from gs by adjusting Offset (FID display)
O1 - O3 can be set by clicking the button ¢ in the upper toolbar
01 can be set by clicking the button kY in the upper toolbar
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The parameter O1 represents the irradiation (carrier) frequency off-
set. It is the center of the spectral region to be acquired. O1 is related
to the basic frequency and the carrier frequency according to:

01 =SFO1 - BF1

The button 4. can be used if you are setting up your experiment from
an existing spectrum. It sets the It sets O1 to the center of the currently
displayed spectral region. The button ¢ puts the cursor on the spec-
trum. You can then set the corresponding frequency offset by moving
the mouse and clicking the left mouse button on a certain position. Be-
cause most Avance spectrometers are equipped with a maximum of
four channels, O5 to O8 are normally unused. Therefore, they appear
at the end of the eda table. See also O1P - O8P.

O1P - O8P - irradiation frequency offset for frequency channel f1 - f8 in

ppm

take a double value (ppm)
temporary parameters calculated from the equations:

O1P = O1/BF1
O2P = O2/BF2
etc.

can be set from eda or by entering o1p, o2p etc. from the command
line

can be set by setting O1 - O8 (see these parameters)

The parameter O1P represents the irradiation (carrier) frequency off-
set in ppm. Because chemical shift values are expressed in ppm, it is
usually more convenient to set O1P rather than O1.

OVERFLW - data overflow check

takes one of the values check or ignore (default is ignore)
can be set from eda or by entering overflw on the command line

For OVERFLW = check, acquisition commands check for possible
data overflow. Note that for OVERFLW = check, the performance of
the spectrometer RCU is decreased and the smallest possible dwell
times cannot be used any more. Thus, if no overflow is to be
expected, you should set OVERFLW to ignore.
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P[0-31] - array of pulse lengths

takes float values (useconds)

can be set from eda by clicking P ** array **

can also be set by entering p0, p1, p2 etc. on the command line
interpreted by the pulse program statements p0 - p31, ipu0 - ipu3i,
dpuO - dpu3l, rpul - rpu3l

The pulse program statement p0 executes a pulse of P[0] useconds,
pl executes a pulse of P[1] useconds etc. In principle, all pulses can
be used for any purpose. In Bruker pulse programs, however, certain
conventions are used. You can view the file that contains these con-
ventions by entering the command edpul param. info

PARMODE - dimensionality of the raw data

takes one of the values 1D, 2D,..., 8D

can be set by changing the dimension from the parameter editor
(eda) toolbar.

interpreted by zg, rpar and by all processing commands which
access raw data (see Processing Reference Manual)

The parameter PARMODE defines the dimensionality of the raw
data. 1D-8D. It is interpreted by acquisition commands like zg and
cross checked with the current pulse program. If the dimensionality of
PARMODE and the pulse program are different, a warning will
appear. If you want, you can still continue the acquisition.

PARMODE is also interpreted by processing commands which access
the raw data. If, for example, you enter £t on a 1D dataset, it is simply
Fourier transformed. If however, you enter £t on a 2D dataset, you
are first prompted to enter the FID number you want to Fourier trans-
form. Processing commands which access processed data, like abs,
interpret the processing parameter PPARMOD rather than the acqui-
sition parameter PARMODE.

If you change PARMODE and set it to a lower dimension, the unnec-
essary files are deleted. For example, if you change it from 2D to 1D
the files acqu2 and proc2 are deleted. Furthermore, the processing
status parameter PPARMOD is automatically set the chosen lower di-
mension. However, you are warned before this actually happens and
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you have the possibility of keeping all files.

If you enter rpar to read a parameter set with a different dimension-
ality then the current dataset, a warning about this will appear. If you
click OK, the data files and superfluous parameters files will be delet-
ed. However, if you enter rpar with two arguments on the command
line, i.e. rpar <name> <type>, this will happen without a warning.
The reason is that rpar is often used in automation.

PHCOR[0-31] - array of correction angles for phase programs

takes float values (degrees)

can be set from eda by clicking PHCOR ** array **

can also be set by entering phcor0, phcorl etc. on the command
line

interpreted by the pulse program statements ph0:r - ph31:r

The option : r after a phase program statement in a pulse program
adds phase correction factor to the phase. For example, the state-
ment:

pl ph8:r

executes a pulse with the current phase from phase program phs plus
the value of PHCORJ[8.] For ph8 =0 1 2 3 and PHCOR]8] = 2, the
phase cycle would be 2° 92° 182° 272°.

PCPD[1-8] - array of CPD pulse lengths

takes float values (usec)

can be set from eda by clicking PCPD ** array **

can also be set by entering pcpdi, pcpd?2 etc. on the command line
interpreted by the CPD program command pcpd

The PCPD parameters represent pulse lengths for CPD decoupling.
They are interpreted by the CPD command pcpd. Which PCPD pulse
is used depends on the frequency channel on which the CPD pro-
gram runs. For example, the pulse program statement:

dl cpd2:f2

runs the CPD program defined by CPDPRG2 on channel f2. There-
fore, a pcpd command in this CPD program will execute a pulse of
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length PCPDJ2].

Note that the element PCPD[0] exists but cannot be used because
there is no channel that corresponds to it.

PH_ref - receiver phase correction

takes a float value (degrees)
interpreted by the pulse program statement go=n phxx:r

PH_ref adds a value to the receiver phase. For example, the pulse
program statement:

go=2 ph30:r
starts the acquisition with receiver phase:
ph30 + PH_ref

The AU program phtran calculates the value of PH_ref for a 2D da-
taset from the spectrum phase correction values of a 1D row (for more
information, type edau phtran and view the header of the AU pro-
gram).

PL[0-31] - array of power levels

takes float values (dB)

can be set from eda by clicking PL ** Array **

can also be set by entering p10, p11 etc. on the command line
can also be set from the gs dialog window

interpreted by the pulse program statements p10, p11, p12 etc.

The power levels PL[0] to PL[31] can be used to set the power for the
frequency channels. The default power for channel fn is PL[n] (PL[1]
for f1, PL[2] for f2 etc.) You can, however, explicitly assign a certain

power level to a certain channel in the pulse program. For example,

the pulse program statements:

pll:f2
pl3:£f4

set the power of channel f2 to PL[1] and the power of channel f4 to
PL[3] Note the difference between the pulse program statement p11
and the command p11 entered on the TOPSPIN command line. The lat-
ter is not really a command but simply a way to set the parameter
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PL[1]. The parameters PL[0-31] can also be used to set the power of
hard or shaped pulses in CPD programs. For example, the CPD pro-
gram statement:

p3l:spl:180 pl=pll
sets the power of the shaped pulse sp1 to PL[1].

POWMOD - power mode
» takes one of the values low, high or linear
+ POWMOD defines the power mode for spectrometers equipped with
a high power accessory. The value linear is unused.
PRECHAN - routing between Switchbox outputs and Preamplifier modules
» array of integer values

* can be set from eda but is normally set graphically from the edasp
window (see this command for more information)

* The values of PRECHAN define the connection between the switch-
box outputs and the HPPR preamplifier modules. For example:

PRECHANI1] = 0 : Output 1 is connected to HPPR module 0
PRECHANI3] = 1 : Output 3 is connected to HPPR module 1
PRECHANI1] = 2 : Output 1 is connected to HPPR module 2
PRECHAN]J2] = 3 : Output 2 is connected to HPPR module 3

For a standard HPPR configuration the module number correspond to
the following units: 0 = 2H, 1 = X-BB, 2=1H, 3=User-Box and 4 = 19F.
For more information on the HPPR preamplifier see the BASH spec-
trometer documentation.
PRGAIN - high power preamplifier gain
+ takes one of the values low or high
» Gain selection for spectrometers equipped with MSL preamplifiers.
Normally, PRGAIN is set to kigh. The value low is only used for very
strong NMR signals.
PULPROG - pulse program used for the acquisition
» takes a character string value

* can be set from eda by entering a name or by clicking the down
arrow and selecting a pulse program from the appearing list.
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can also be set by entering pulprog on the command line
also set by the command edcpul <name>

Acquisition commands run the pulse program defined by PULPROG.
If you set the pulse program in eda, you can click the down arrow to
the right of the PULPROG field. A list of Bruker and user defined
pulse programs will appear and you can click the one you need. Note
that Bruker pulse programs must be installed once with expin-
stall. If you start your experiment by reading a standard parameter
set (with rpar), PULPROG is usually set to the appropriate pulse
program.

QNP nucleus selection

takes one of the values 1,2 or 3

If the current probehead is set to a QNP probe (see edhead), acqui-
sition commands will interpret the parameter QNP to switch the probe
to the correct nucleus. QNP is a normally set with the AU program
gnpset. Type edau gnpset to view this AU program.

RECCHAN[0-15] - array of receiver channels

takes integer values
can be set from eda by clicking RECCHAN ** Array **

RECCHAN enables the use of a different FCU than routed with
edasp to generate the observe reference frequency. As such, the
delay for the 22 MHz switching can be skipped.

RG - receiver gain

takes an integer value

RG controls the amplitude of the FID signal before it enters the digi-
tizer. It is usually determined automatically with the command rga.
This command performs an automatic determination of the optimum
receiver gain. It runs several acquisitions with varying receiver gain
until the maximum value is found that does not cause overflow. The
parameter RG is then set to this value. If the RG value is already
known from previous experiments, it can be set from eda or by enter-
ing rg on the command line. RG can also be set from the gs dialog.

On AV-ll spectrometers, the maximum RG value is 200 or 2000, de-
pending on the spectrometer receiver. If you enter a larger value is en-
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tered it is automatically reduced to the maximum allowed value.
RO - sample rotation frequency in Hz
» takes an integer value
* can be set from eda or by entering ro or ro <value>
* interpreted by ro acqu
* The command ro acqu will set sample rotation to the value of RO. It

Start or stop rotation of sample

Ratation frequency of zample [Hz]: 2IZI|

Zet value H Start ratation H Stop rotation H Cancel

Figure 2.1

will wait for 60 seconds and then check if the specified rate has been
reached. If this is not the case, an error message is displayed

RSEL - routing between FCU’s and amplifiers
» array of integer values

» can be set from eda but is usually set graphically from the edasp
window (see this command for more information)

» The values of RSEL define the connections between the FCU’s and
the amplifiers. For example:

RSEL[1] =2 : FCU 1 is connected to amplifier 2
RSEL[2] = 0 : FCU1 is not connected to any amplifier
RSEL[0] is unused

SFO1 - SFO8 - irradiation (carrier) frequencies for channels f1 to f8
+ take a double value (MHz)
+ are automatically calculated from the equation:
SFO1 =BF1 + O1

SFO2 =BF2 + 02
etc.
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where O1, O2 etc. are set from edasp or eda
can also be set with gs by adjusting Frequency (FID display)
SFO1 can be set by clicking

The parameter SFO1 represents the iradiation (carrier) frequency for
channel f1. It is usually set from the by defining the nucleus and fre-
quency offset for channel f1 in the routing table (opened with edasp).

SPO07 - shaped pulse parameter table

can be set from eda by clicking SP07 edit

allows you to set power level, frequency offset, phase alignment and
filename for 32 shaped pulses.

interpreted by pulse program statements like sp0 - sp31

When you open eda and click on SP07 edit, a list of shaped pulse
parameters will appear as displayed in table 2.4.

Table 2.4
parameters for shaped pulses
Index Power[dB] Offset- Phase- Filename
Freq Align
0 1.0 0.0 0.5 Gauss
1 20.0 0.0 0.5 Sinc1.1000
2 120.0 0.0 0.55 Q3.1000
3

The table has 32 entries (index 0-31) which are interpreted by the
pulse program statements sp0 - sp31. These occur on pulse program
lines like:

pl:sp2:fl

This line interprets entry 2 of the table and execute a Q3.1000 shaped
pulse on channel f1 with length P1, Power 120.0, Offset 0.0 and
Phase 0.55. When you click the down arrow to the right of a Filename
entry, a list of available shape files will appear. This lists contains both
Bruker and user defined shape files. The former must be installed
once with expinstall. The latter can be created with the Shape Tool
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(command stdisp).

The SP07 entries are also available as acquisition parameters. They
do not appear individually in eda but they can be set from the com-
mand line (see table 2.5)

Description  Acquisition parame- Commands
ters
power level SP[0-31] sp0 - sp31
frequency off- SPOFFS[0-31] spoffs0 - spoffs31
set
phase align- SPOAL[0-31] spoall - spoal3l
ment
file name SPNAM[0-31] spnam0 - spnam31
Table 2.5

They also appear as acquisition status parameters when you enter
dpa.

SOLVENT - the sample solvent

SW -
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takes a character string value

can be set from eda by entering a name or by clicking the down
arrow and selecting a solvent from the appearing list

can also be set by entering solvent on the command line
interpreted by getprosol and ICON-NMR automation
also interpreted by 1lock -acqu, lopo and sref

The parameter SOLVENT must be set to the name of the solvent
used in the current sample. Some acquisition parameters like pulse
length and power level are dependent on the probehead and the sol-
vent. The command getprosol interprets SOLVENT and PROBHD
and sets all dependent parameters accordingly. These parameters
must be defined once, with edprosol, for all probeheads and sol-
vents. In ICON-NMR automation, getprosol is automatically per-
formed after a standard experiment has been read.

spectral width in ppm
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takes a double value (ppm)
can be set from eda or by entering sw on the command line
SW can be set by clicking the button %, in the upper toolbar

The spectral width should be set to such a value that all relevant
peaks are expected to fall within that range. This means, for an
unknown sample, SW should be set to a large value, like 50 ppm for
a proton spectrum. The spectral width determines the dwell time
according to the following equation:

DW=1/(2*SW*SFO1)
where DW is expressed in usec.

When you enter a certain value for SW, you may notice that it is slight-
ly adjusted by TOPSPIN. The reason is that the digitizer hardware can
only handle discrete values of DW. For DIGMOD = digital/homo-
decoupling-digital, the maximum allowed spectral width depends on
the digitizer, the acquisition mode and the DSP firmware (see table 2.6
and 2.7).

Clicking the button < in the upper toolbar will set SW to the region
currently displayed on the screen. It will also set SFO1 to the frequen-
cy of the center of that region. For 2D and 3D experiments, SW as it
is described above corresponds to the width in the acquisition direc-
tion. In the indirect directions, the spectral width are calculated from
the parameters INO, IN10, NDO, and ND10. In 2D, the following rela-
tions count:

SW(F1)=1/(SFO1*NDO*INO)
SWH(F1)= 1/(NDO*INO)

In 3D, the following relations count:

SW(F2)=1/(SFO1*ND10*IN10)
SWH(F2)= 1/(ND10*IN10)
SW(F1)=1/(SFO1*NDO*INO)
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SWH(F1)= 1/(NDO*INO)

DSPFIRM Sharp Medium

DIGTYP

FADC 25 100
HADC 25 25
HADC+ 25 25
HADC2 25 100
SADC 18.75 18.75
SADC+ 18.75 18.75
HRD16 25 25
IADC 25 100

Table 2.6 Maximum SW (kHz) for AQ_mod = DQD

DSPFIRM Sharp Medium Smooth

DIFTYP

FADC 100 150 200
HADC 100 100 100
HADC+ 100 100 100
HADC2 100 150 200
SADC 75 75 75
SADC+ 75 75 75
HRD16 100 100 100
IADC 100 150 200

Table 2.7 Maximum SWH (kHz) for AQ_mod = gsim

SWH - spectral width in Hz
+ takes a double value
* can be set from eda or by entering swh on the command line
+ isrelated to SW according to the following equation:
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SWH = SW * SFO1

During experiment setup, SW is usually defined and SWH is automat-
ically calculated from it. The maximum values depend on the digitizer,
the acquisition mode and the DSP firmware as it is shown in table 2.6
and 2.7.

Note that SWH is stored in the parameter file acqu as SW_h.

SWIBOX - routing between Switchbox inputs and Switchbox outputs

array of integer values

can be set from eda but is normally set graphically from the edasp
window (see this command for more information)

The values of SWIBOX define the connection between the swichbox
inputs and switchbox outputs. For example, SWIBOX[1] = 3 means
that Input 1 is connected Output 3.

TD - time domain; number of raw data points

takes an integer value

The parameter TD determines the number of raw data points to be
acquired. A large value of TD enhances the spectrum resolution, but
also increases the acquisition time AQ. TD is usually set to a power
of 2, for example 64k for a 1D spectrum. The FID resolution is related
to the number of data points according to:

FIDRES=SW*SFO1/TD

In a 2D experiment, TD in the acquisition direction (F2) has the same
meaning as in 1D. In the indirect direction (F1), it represents the
number of increments. As such, it is interpreted by pulse program
statements like:

lo ton times tdl

In a 3D experiment, TD in the acquisition direction (F3) has the same
meaning as in 1D. In the indirect directions (F2 and F1), it represents
the number of increments. As such, they are interpreted by statements
like:

lo ton times tdl ; F1loop in 2D or 3D experiments
lo ton times td2 ; F2 loop in 3D experiments
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As an alternative to 1o to n times td1, you can also use the mc state-
ment. Do not confuse this with the TOPSPIN processing command mc
that performs magnitude calculation.

TDO - loop counter for one-dimensional experiments

takes an integer value
interpreted by the pulse program statement mc

TDO is normally used as a loop counter for multiple 1D experiments
that are measured under varying conditions (for example varying
temperature or pressure) and that are stored as 2D data. Similarly, it
can be used for multiple 2D experiments that are stored as 3D data.

TE - demand temperature on the temperature unit

takes a float value
can be set from eda or by entering te on the command line
interpreted by teset

The command teset sets the temperature on the temperature unit
to the value of TE. It be entered on the keyboard, or called from AU
program with its macro TESET.

V9 - maximum variation of a delay

takes a float value (between 0.0 and 100.0 percent)
can be set from eda or by entering v9 on the command line
interpreted by pulse program statements like d1:r, pl:r

The pulse program statement d1 causes a delay D1. The statement
dil:r, however, causes a delay D1 plus a random value. As such, the
delay is a different every time the statement d1: r is executed. The
parameter V9 specifies, in percent, the maximum amount which is
added to or subtracted from D1. As such, the effective delay varies
between 0 and 2*D1. The :r option can be used for any of the state-
ments do - d31 and p0 - p31 to vary D[0-31] and p[0-31], respectively.
Note that the command gs ignores the : r option.

VALIST - variable amplitude (power) list

takes a character array value
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can be set from eda by entering a name or by clicking the down
arrow and selecting a name from the appearing list.

can also be set by entering valist on the command line
interpreted by user defined pulse program statements

The parameter VALIST defines de name of variable amplitude
(power) list. Such a list can be created with ed1ist va and has
entries like:

-6.0
0.0
3.0
6.0

that represent attenuation values in dB.

The usage of a VA list is different from pulse and delays lists. You must
define the statement by which a VA list is accessed in the pulse pro-
gram. Such a statement can have any name, for example the name
vanam is used in the examples below. The suffixes .inc, .dex and
.res can be used to increment, decrement and reset the lists position,
respectively. Furthermore, the caret operator (*) allows you to read a
list value and increment the list position with one statement. The fol-
lowing pulse program entries illustrate the use of a variable amplitude
list:

define list<power™ vanam = <$VALIST>
definition of the power list

dl vanam: £2 vanam.dec
set the power to the current value of the list and decrement the in-
dex

dl vanam[2] : f3
set the power to the second value of the list

"vanam.idx = vanam.idx + 3"
increment the list index by 3

dl vanam”:f4
set power to the current value of the list increment the index

As an alternative to using a list defined by the parameter VALIST, you
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can explicitly define a variable amplitude (power) list filename or even
the list values in the pulse program. The following examples illustrates
such definitions:

define list<power> vanam=<my filename>
define list<power> vanam={10 30 50 70}

Note that the second definition does not require a list file. For more in-
formation on using variable amplitude lists click:

Help > Manuals ° [Programming Manuals] Pulse Programming
Manual

VCLIST - variable counter list

takes a character array value

can be set from eda by entering a name or by clicking the down
arrow and selecting a name from the appearing list.

can also be set by entering velist on the command line

interpreted by the pulse program statements 1o to X times c, ive,
veidx

The parameter VCLIST defines de name of variable counter list.
Such a list can be created with ed1ist’ List type : vc¢ and has entries
like:

4
7
20

The currently defined list is interpreted by the pulse program state-
ment:

lo to x times ¢

where x is a pulse program label and c is the value at the current po-
sition of the counter list. When this statement is executed for the first
time, the current position is the first entry in the list. The position is in-
cremented by the statement ivec.

VDLIST - variable delay list

takes a character array value
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can be set from eda by entering a name or by clicking the down
arrow and selecting a name from the appearing list.

can also be set by entering vdlist on the command line
interpreted by the pulse program statements vd, ivd and vdidx

The parameter VDLIST defines de name of variable delay list. Such a
list can be created with ed1ist’ List type : vd and has entries like:

10m
50m
2s

where m = milliseconds and s = seconds. The currently defined list is
interpreted by the pulse program statement vd that reads the delay
value at the current position. When vd is executed for the first time, the
current position is the first entry in the list. The position is not incre-
mented by vd; this is done by the statement ivd. As such, vd is nor-
mally used in combination with ivd. The statement "vdidx=n" sets
the index to position n in the list.

VPLIST - variable pulse list

takes a character array value

can be set from eda by entering a name or by clicking the down
arrow and selecting a name from the appearing list.

can also be set by entering vplist on the command line
interpreted by the pulse program statements vp, ivp and vpidx

The parameter VDLIST defines de name of variable pulse list. Such a
list can be created with edl1ist ’ List type : vp and has entries like:

10u
50m
2s

where u= microseconds, m = milliseconds and s = seconds. The cur-
rently defined list is interpreted by the pulse program statement vp that
reads the pulse length value at the current position. When vp is exe-
cuted for the first time, the current position is the first entry in the list.
The position is not incremented by vp; this is done by the statement

ivp. As such, vp is normally used in combination with ivp. The state-
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ment "vpidx=n" sets the index to position n in the list. A variable
pulse list can only be used for hard pulses, not for shaped pulses or
shaped gradients. As an alternative to a VP list, you can also specify
a list of pulse values within the pulse program using a define state-
ment. For more information on this topic click:

Help > Manuals ° [Programming Manuals] Pulse Programming
Manual

VTLIST - variable temperature list

takes a character array value

can be set from eda by entering a name or by clicking the down
arrow and selecting a name from the appearing list.

can also be set by entering vtlist on the command line

interpreted by the AU program macros RVTLIST, VT, IVTLIST,
DVTLIST

The parameter VTLIST defines de name of variable temperature list.
Such a list can be created with ed1ist ’ List type : vt and has the fol-
lowing format:

300
320
340

where each entry is a temperature value in Kelvin.
Temperature lists are interpreted by the AU program macros:
RVTLIST - open the temperature list defined by VTLIST

VT - read the current value from the list and set it on the tempera-
ture unit

IVTLIST - increment the current position in the list to the next value

DVTLIST- decrement the current position in the list to the previous
value

Note that temperature lists are only interpreted by AU program macros,
not by pulse program statements.

WBST - number of wobble steps
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takes an integer value between 256 and 4096 (default 256)

can be set from eda or by entering wbst from on the command line
can also be set by clicking " in the wobb window

interpreted by wobb

The parameter WBST determines the number of steps (frequencies)
used for tuning and matching a probehead (wobbling). A probehead
is correctly tuned when the dip of the wobble curve is exactly at the
center of the display. Normally, the default value of WBST (256) is
high enough for exact tuning. If necessary, you can set WBST to a
higher value for a better resolution. Note, however, that the maximum
useful value is the screen resolution. Setting WBST to a higher value
would not give you any advantage; it would only reduce the refresh
rate. The command atma automatically calculates the optimum
number of steps and does not interpret WBST 1.

WBSW - wobble sweep width

takes a double value between 1 KHz and 4 MHz

can be set from eda or by entering wbsw from on the command line
can also be set by clicking 57 in the wobb window

interpreted by wobb

The parameter WBSW sets the frequency range for tuning and
matching a probehead (wobbling). The center of the wobble region is
determined by SFO1. When you change WBSW from the command
line, wobb is automatically restarted. The command atma automati-
cally calculates the optimum sweep width and does not interpret
wBsSw .

ZGOPTNS - acquisition (zg) options

takes a character array value
can be set from eda by entering zgoptns on the command line

The parameter allows you to set an option to acquisition commands
like zgand go. As an alternative, acquisition options can also be

1. During tuning/matching a tma temporarily sets the parameters WBST and WBSW to
the calculated values and then resets them to their original values.
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specified on the command line or in the pulse program. For example,
the option DQF can be set in the following three ways:

by setting the parameter ZGOPTNS to DQF

by specifying the option as an argument, e.g.:
zg -DDQF

by defining the option in the pulse program, e.g.:
#define DQF

2.5 Acquisition status (dpa) parameters
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This paragraph contains a list of all acquisition status parameters with a
description of their function. They are stored for each dataset in the file:

<dir>/data/<user>/nmr/<name>/<expno>/
acqus - acquisition status parameters

and can be viewed by entering dpa on the command line or clicking Ac-
quPars tab in the data window and then clicking the § button. Some ac-
quisition status parameters are interpreted by processing commands that
work on raw data. Others are only stored as information for the user.

After an acquisition has finished, most acquisition status parameters
have been set to the same value as the corresponding acquisition pa-
rameter. Sometimes, however, this is different. For example:

* some parameters are continuously updated during the acquisition,
e.g. NS, F1-TD (in 2D). When the acquisition is halted with halt, the
current values are stored as acquisition status parameters.

* some acquisition parameters are adjusted at the beginning of the
acquisition, e.g. RG, FW, DR, SW. The modified values are stored as
acquisition status parameters.

» the values of some parameters are a result of the acquisition. They
cannot be set by the user (they do not appear as acquisition parame-
ters) but they are stored as acquisition status parameters. Examples
are AQSEQ, YMAX _a, LOCSHFT, NC.

The acquisition status parameters which are a result of or adjusted by the
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acquisition are listed below.

AQ_mod - acquisition mode

takes one of the values qf, gsim, gseq or DOD

can be viewed from dpa or by entering s aq_mod on the command
line

Normally, the acquisition status parameter AQ_mod is set to the
same value as the acquisition parameter AQ_maod. If, however,
AQ_mod = DQD but DIGMOD = analog, zg performs an acquisition
in simultaneous mode and sets the status parameter AQ_mod to
gsim. The same thing happens if your spectrometer is not equipped
for DQD (see also the description of AQ_mod in chapter 2.4).

AQSEQ - Acquisition order

used for datasets with dimension > 3D

takes one of the values 321, 312 for 3D data

takes one of the values 4321, 4312, 4231, etc. for 4D data

can be viewed with dpa or by entering s agseq on the command line
interpreted by the processing command t£3 and ftnd

AQSEQ describes the order in which the directions have been
acquired. It is automatically set according to the loop structure in the
pulse program. For example, a 3D pulse program usually contains a
double nested loop with loop counters td1 and td2. If td1 is used in
the inner loop and td2 in the outer loop, AQSEQ is set to 312. Other-
wise it is set to 321.

AQSEQ is evaluated by commands which process raw nD data, like
ftndor t£3. If the acquisition status parameter AQSEQ is not set, the
processing parameter AQORDER is evaluated to determine the ac-

quisition order.

BYTORDA - byteorder of the raw data

takes one of the values big or little

can be viewed with dpa or by entering s bytorda on the command
line.

interpreted by all processing commands which work on raw data.

A-55



TOPSPIN parameters

* Big endian and little endian are terms that describe the order in which
a sequence of bytes are stored in a 4-byte integer. Big endian means
the most significant byte is stored first, i.e. at the lowest storage
address. Little-endian means the least significant byte is stored first.
ToPsPIN only runs on computers with byte order little endian. How-
ever, TOPSPIN’s predecessor XWIN-NMR also runs on SGI workstations
which are big endian. The byte order of the raw data is determined by
the computer which controls the spectrometer and is stored in the
acquisition status parameter BYTORDA (type s bytorda). This
allows raw data to be processed on computers of the same or differ-
ent storage types. The first processing command interprets
BYTORDA, stores the processed data in the byte order of the com-
puter on which it runs and sets the processing status parameter
BYTORDP accordingly (type s bytordp). All further processing
commands interpret this status parameter and store the data accord-
ingly. As such, the byte order of the computer is handled automati-
cally and is user transparent. 2D and 3D processing commands,
however, allow you to store the processed data with a byte order dif-
ferent from the computer on which they run. For example, the com-
mands xfb bigand t£3 bigon a Windows or Linux PC store the
data in big endian although the computer is little endian. The
processing status parameter BYTORDP is set accordingly.

DATE - date of acquisition
» takes an integer value (# seconds since 1970)
» Shows the date and time of the end of the acquisition specifying:
month day, year hour:minute:seconds time-zone
e.g.
November 10, 2004 6:06:19 PM GMT

* The date is stored as an integer number, which expresses the
number of seconds since January 1st 1970. Note that the start of the
acquisition is not stored as a parameter but is available in the acquisi-
tion audit trail (command audit acqu).

DECIM - decimation factor of the digital filter
» takes an integer value
+ can be viewed with dpa or by entering s decim on the command line
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interpreted by all processing commands which work on raw data.
also interpreted by abs and apk

Processing commands account for the group delay of digitally filtered
data, by interpreting the following parameters:

DSPFVS and DECIM (for DSPFVS < 20)

or

GRPDLY (for DSPFVS > 20)

DECIM must be interpreted by third party software which processes
digitally filtered Avance data.

For DSPFVS < 20, the commands abs and apk check whether
DECIM is 1 (no oversampling) or greater than 1 (oversampling) to
handle the so called smilies at the spectrum edges (see also the
description of DECIM in chapter 2.4).

DTYPA - Data type of the raw data

takes the value int or double
can be viewed with dpa or by entering s dtypa on the command line
interpreted by all processing commands which work on raw data.

In TopsPIN 2.0 and newer, 1D raw data are, if necessary, stored as
double precision (64-bit) data. The spectrometer internal processor
stores raw data in 32-bit integer format. If, during acquisition, data
overflow would occur, data are transferred to the computer that con-
trols the spectrometer where they are stored in 64-bit double preci-
sion format. The acquisition status parameter DTYPA shows whether
data are stored as integers (DTYPA = 0) or doubles (DTYPA = 2).
Note that processed data are always stored as integer data.

EXP - experiment performed

takes a character array value

ICON-NMR sets EXP to the value of the parameter set that was used
for the experiment.

FnMODE - Acquisition mode in the indirect directions (2D and 3D)

takes one of the values undefined, QF, OSEQ, TPPI, States, States-TPPI
or Echo-Antiecho.
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can be viewed with dpa or by entering s fnmode (2D)

interpreted by 2D and 3D processing commands that access raw
data. These are usually x£b or x£2 for 2D data and t£3 for 3D data.

It is interpreted by processing commands to determine the Fourier
transform mode in the indirect direction(s). For historical reasons,
MC2 is interpreted when the acquisition status parameter FnMODE
has the value undefined.

DSPFVS - DSP firmware version

takes an integer value between 10 and 23
interpreted by processing commands that access raw data

Different DSP firmware versions filter the raw data in a different way.
It is set according to the acquisition parameter DSPFIRM. Processing
commands account for the group delay of digitally filtered data, by
interpreting the following parameters:

DSPFVS and DECIM (for DSPFVS < 20)

or

GRPDLY (for DSPFVS > 20)

DSPFVS must be interpreted by third party software which processes
digitally filtered Avance data.

GRDLY - Group Delay

takes a double value > 0
interpreted by processing commands that access raw data

Processing commands account for the group delay of digitally filtered
data, by interpreting the following parameters:

DSPFVS and DECIM (for DSPFVS < 20)
or
GRPDLY (for 20 < DSPFVS < 23)

GRPDLY must be interpreted by third party software which processes
digitally filtered Avance data.

20 <= GRPDLY <= 23
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LGAIN - loop gain; lock regulator gain
» is setto a value between -80 and 0 dB
» can be viewed with dpa or by entering s 1gain

» LGAIN is set at the end of the acquisition to the loop gain value used
at that moment, i.e. the value currently set on the BSMS unit. This
usually, but not necessarily corresponds to the value of LGain in the
edlock table. For example, if lock-in was performed with the com-
mand lock, the loop gain is first read from the ed1ock table and set
on the BSMS unit. However, pressing the Autolock or Lock On/Off
key on the BSMS keyboard performs lock-in without first reading the
edlock table. Note in this respect that the current value of loop gain
can also be changed from the BSMS keyboard (by pressing the two
keys indicated with MENU) or by the command l1gain.

LOCSHFT - lock shift
» takes one of the values true or false
* can be viewed with dpa or by entering s 1ocshft

* The value of LOCSHFT indicates whether or not the sample was
locked at the time the acquisition of the first scan has been finished.

LTIME - loop time; lock regulator time
* is setto a value between 0.001 and 1.0 seconds
» can be viewed with dpa or by entering s 1time

» LTIME is a lock parameter (edlock) rather than an acquisition
parameter (see the description of LGAIN above).

LFILTER - loop filter; lock regulator cut-off frequency of the lowpass filter
* is setto a value between 1 - 200 Hz
+ can be viewed with dpa or by entering s 1filter

* LFILTER is a lock parameter (ed1ock) rather than an acquisition
parameter (see the description of LGAIN above).

LOCKPOW - lock power
» is setto a value between -60 and 0 dB
* can be viewed with dpa or by entering s Iockpow
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+ LOCKPOW is a lock parameter (edlock) rather than an acquisition
parameter (see the description of LGAIN above).

MASR - MAS spin rate
+ takes a float value
* can be viewed with dpa or by entering s masr
* set by masr get

» The acquisition status parameters MASR is continuously updated
when the MAS monitor is active (can be enabled with the command
set).

NC - normalization constant
» takes an integer value
» can be viewed with dpa or by entering s nc

» set by acquisition commands and by the processing commands
genfid, genser and addfid

» interpreted by all processing commands that access raw data

* Acquisition commands set NC to minus the value of DDR. Note that
for DIGTYP = analog, DDR is 0 and, as such, NC is also 0. The
processing commands mentioned above create pseudo raw and NC
is set according to the input processed data.

PROBHD - probehead
» takes a character string value

* can be viewed with dpa or by entering s probhd on the command
line

+ PROBHD is set at the end of an acquisition to the current probehead
as it was defined with edhead before the acquisition.

« LOCNUC

HOLDER - sample changer holder position

+ takes an integer value

» can be viewed by entering s holder

» set by ICON-NMR

AUTOPOS - identification information from BEST-NMR rack or well-plate
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» takes a character string value (A1-A12, B1-B12, ... , H1-H12)
* can be viewed by entering s autopos
* set by ICON-NMR
LOCKED - lock status during acquisition
» takes one of the values TRUE or FALSE
» can be viewed by entering s 1ocked on the command line

» The status parameter LOCKED indicates whether or not the mag-
netic field was permanently locked since the last successful 1ock
command. For an nD experiment the parameter LOCKED is updated
after the last FID has been acquired and stored to disk.

Routing (edasp) parameters

The command edasp opens the routing table where you can select the
nuclei and the spectrometer routing. When you select a nucleus for a cer-
tain frequency channel, the basic frequency and the default routing for that
channel are automatically set.

Parameters displayed in the routing table:
BF1 - basic frequencies for channel f1

same as the eda parameter BF1
NUC1 - nucleus for channel f1

same as the eda parameter NUC1
SFO1 - irradiation frequency for channel f1

same as the eda parameter SFO1
OFSX1 - irradiation frequency offset for the first X nucleus
OFSH1 - irradiation frequency offset for the first 1H
OFSF1 - irradiation frequency offset for the first F, 3H or Tl
OFSX2 - irradiation frequency offset for the second X nucleus

OFSH2 - irradiation frequency offset for the second 1H
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OFSF2 - irradiation frequency offset for the second F, 3H or Tl
ect.

when defined for channel f1, these parameters correspond to O1 in
eda

when defined for channel f2, these parameters correspond to O2 in
eda

ect.

Note that the command edsp reads the values for OF* that were
stored by the previous edsp or edasp command. It the latter was per-
formed on different dataset, the OF* values might differ from the cor-
responding O1, O2 etc. (see the description of edsp).

Parameters which can be viewed by clicking PARAM
FCUCHAN - connections between logical frequency channels and FCU’s

RSEL - connections between FCU’s and amplifiers

SWIBOX - connections between Switchbox inputs and Switchbox out-
puts

PRECHAN - connections between Switchbox outputs and Preamplifier
modules

HPMOD - connections between high power amplifiers and Preamplifier
modules

edasp stores its parameters under the current dataset in the file:
<dir>/data/<user>/nmr/<name>/<expno>/
acqus - acquisition parameters
and the dataset independent file:
<tshome>/conf/instr/<instrum>
specpar - edasp parameters

Note that the routing table can also be opened from the eda dialog box, by
clicking the NUC1 button.
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2.7 Lock (edlock) parameters

Lock parameters are used for locking the magnetic field and for referencing
the spectrum. The lock-in procedure can be performed from the BSMS
keyboard or with the command lock or 1opo. Referencing the spectrum
can be done with the command sref.

Lock parameters used for locking the magnetic field:
Lockfreq - lock irradiation frequency

Field - Field value (HO)
BFREQ - Basic frequency
Solvent - Sample solvent

LPower - Lock power; the power used to irradiate the lock nucleus (-60
to 0 dB).

LGain - Loop gain; lock regulator gain (-80 to 0 dB)
LTime - Loop time; lock regulator time constant (0.001 to 1.0 seconds)

LFilt - Loop filter, lock regulator cut-off frequency of the lowpass filter (1
to 200 Hz)

LPhase - Lock phase; the phase of the lock signal
Nucleus - Observe nucleus

Distance - chemical shift of the lock nucleus (irradiation frequency offset)

Lock parameters used for referencing:
Ref. - chemical shift of the reference signal (default 0)

Width - width of the region where the reference signal is searched
RShift - reference shift for default calibration

The parameters LPower, LPhase, LGain, LTime and LFilt are probehead
and solvent dependent. They are stored for each probehead and for each
solvent separately in:

<tshome>/conf/instr/<instrum>/prosol/<probelD>/<solvent>/

bsmspar - probehead dependent lock parameters
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The other edlock parameters are only solvent dependent and are stored
in the file:

<tshome>/conf/instr/

2Hlock - probehead independent lock parameters
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Chapter 3

Spectrometer configuration
commands

This chapter describes all TOPSPIN spectrometer configuration com-
mands. These are commands which must be executed once, after install-
ing a new version of the NMR Suite.
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ampup

NAME
ampup - resets the controller board that controls the external amplifiers

DESCRIPTION

The command ampup resets the controller board that controls the exter-
nal amplifiers. It can also be started from the menu as follows:

click Spectrometer > Accessories > Amplifiers > Transmitter power up
ampup is available in TOPSPIN 2.0 and newer and partly replaces the com-
mand acbdisp, Which no longer exists.

SEE ALSO
cf
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cf

NAME
cf - Configure the spectrometer

DESCRIPTION

The command cf allows you to configure the spectrometer. It should be
executed after installing a new version of TOPSPIN or if your spectrometer
hardware has changed. Furthermore, executing cf can be useful in case
of spectrometer communication problems.

cf can be started from the command line or clicked from the menus:
Spectrometer ° Setup or
Options ’ Spectrometer Tools

It starts with the following dialog box:

x

Pleaze enter the MMRE zuperuser
pazsward for "LEDAMdiminiztrator™

Ok Cancel

Figure 3.1
Enter the NMR Administrator password and click OK.

If it is the first TOPSPIN installation or TOPSPIN is installed in a different di-
rectory than the previous installation, only the standard configuration
Bruker_default_av5000 (delivered with TOPSPIN) is shown. If TOPSPIN is in-
stalled in the same directory as a previous TOPSPIN installation, the exist-
ing configuration (in our example spect, see Figure 3.2) is shown.

» To create a new configuration, click New
» To use an existing configuration, select its entry and click Edit

A-67



Spectrometer configuration commands

X

Spectrometer configuration ()

Configure the hardware of vour spectrometer or create a configuration far a datastation.

Active configuration: "spect”

Available spectrometer configurations

[

Select one of the available configurations or create a new onel

Press "Edit" to modify or use an existing configuration
(e.g. add nesw hardware or use previous installation)).

Press "Mew" to create a configuration fram scratch.

Spectrameter type Frequency [MHZ]

1 = Avance 500 Datastation

o

Pl | Eclit | Cancel |
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Figure 3.2
A new dialog window will appear (see Figure 3.3).
For a new configuration, enter the field Configuration name.

Note that if you specify an instrument name different from spect, this
name must be specified in the hosts file:

/etc/hosts under LINUX
CAWINNT\SYSTEM32\DRIVERS\ETC\HOSTS under Windows
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<[] x|

F
Edit configuration:
Configuration name =pect
Spectrometer o
Datastation i
Spectrometer type I,ﬂwance j
TH frequency of magnet |3|:||:|_1 3|
-
Rl | .

= Prewious | Mewt = Cancel |

Figure 3.3

You must keep the name spect and append a white space plus the new
instrument name, for example: "149.236.99.99 spect
my spectrometer"

Select Spectrometer and enter the spectrometer type. Note that the entry
Avance refers to Avance-AQS (spectrometers with an SGU) and Avance-
D*X types refer to the Avance-AQX/AQR (spectrometers with PTS).

Enter the 1H frequency that corresponds to the strength of your magnet.
Note that this frequency is typically, but not necessarily, one of the values
400.13, 500.13, 600,13 etc. Click Next to continue.

The next dialog box shows the RS channels for the external devices in
your spectrometer (see Figure 3.4). Normally, the correct channels are
found automatically. If, however, a unit could not be reached, it has the
value no. In that case, you must specify its channel number. The entry
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Specify the channel to which external devices are connected:

R5-232/485 channelzs for external devices
HPPR Preamplifier 1 w10 -
Fx22 Receiver w10 -
BSMS Smart Maonet Contral System 02 -
Lock Signal w03 -
BPsU w7 -

YTU Yariable Temperature Unit

o)
]
]

=]
Gradiert Temperature Unit (BCU-207

=
=]
1

MAS Pheurnatic Control Lnit

=
(=]
J

BACS Bruker Automatic Chanoger vOg -
Barcode Printer o -
Crya Cantraller ho -
HPCU High Paswer Contral Linit ho -
4 Phaze Modulstor o -
PreemphasiziGradient Lnit o -

Lockswitch

Lockswitch  |ho -

[ |

x|

.

= Previous | Mt =

Figure 3.4
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X

Additional configuration:

Lockswitch specifies the router output channel of the amplifier to which

the lock switch is connected (no if the lock switch does not exist). Click
Next to continue.

The next dialog box shows the security configuration and, if it exists, the
sample changer configuration (see Figure 3.5).

Security configuration

Enable peak power check (POWCHK): [

Sample changer configuration

Should the sample changer control the lit.

Delay between SX and next command [s)]: |1 1]

BACS options: ||

Fast SampleRail mode: -

ol

= Previous | Mext = | Zancel |

Figure 3.5

The default value of POWCHK is on if a Cortab table exists and off'if no
Cortab table exists (see command cortab).
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[ Q.. gotst &J

Power check is a useful TopSpin software tool to protect the probe
against pulses with too high power levels (PL) coming from the amplifier
(BLA). POWCHK does compare peak power values.

The power limits of the used probe and the power of the used pulses
(from the respective pulse program) are stored in TopSpin in order to be
checked by power check. The maximum power levels for the probe are
defined by edhead reading the values from the PICS oft the probe. For
oder probes without PICS edhead has to be edited manually. The max-
imum amplifier output values are stored by cortab, which liearizees the
amplifier for calculating all possible PL for the pulse program as well.
poweer check surveys the limits after starting the experiment but before
executing the pulse program and displays an error message (as shown
below; Figure 3.6 ) if the power level of the pulse program is too high for
the probe.

Power level (-6 dB == 41.11 W)
Q for nucleus 1H too high for selected probe channel |

The critical limit of 30.00 W (-4 .63 dB) must not be reached!

Close

Figure 3.6

The following error message (Figure 3.7) is shown if peak power check
is active, but no power limit is specified in the cortab table for the respec-
tive nucleus:
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Peak power check (FOWCHK) is active, but no power limit is
specified for the current nucleus 1H.

Please do 'edhead’ first, select the 'Peak Power Parameters'

menu and enter & power limit for 1H.

You also need to do this if you use probe parameter files stemrming
from swir-nmr or topspin 1.1/1.2, because the internal data format
has changed!

@ If wou nevertheless want to continue, please enter the
nrr-superuser password to switch off the peak power check
far the current acquisition.

MOTE THAT WITH INCORRECT POWWER SETTINGS YOU WILL SERIOUSLY DAMAGE YOUR PROBE!

This change will be recorded in the respective audit-file.
The peak power check will be re-enabled after the end of this acguisition.

Click OK to continue at your own risk, CANCEL to abort!

oK || Cancel |

Figure 3.7

Power check has to be activated during the configuration of the spec-
trometer running cf (please look up Figure 3.5).

Please note that for this action the nmr administration password is man-
datory.

Please note that a cortab table must exist for the transmission path used
and additionally the maximum amplifier output power must be defined for
this transmission path. The respective value is stored in the correspond-
ing cortab table (for further information about cortab please look up for
the command cortab).

An icon in the Acquisition Status Bar shows if / that peak power check is
active (Figure 3.8).

The BACS options field is normally left empty. It is only to be used for
special commands to the sample changer as instructed by a Bruker em-
ployee.
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Acquisition information Fid Flash Lock POWYCHI WL
- . 1 \/ [Kekvin]
no acquisition running
29p .2

Figure 3.8

Power check icon can be activated by left-click on

Options --> Preferences --> Acquisition Status Bar --> Include peak power
check (POWCHK) indicator in the TopSpin toolbar (Figure 3.9).

Acquisition status bar

Auto open acouisition status bar
Include spooler

Include time

Include sample temperature

Include acouisition status

Include acquisition indicatar

Include lock signal

Include MAS spinning rate

Include peak power check (POYWCHK) indicatar
Include sample state

Include B5MS status

Include amplifier cantral
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Figure 3.9

The Fast SampleRail flag is only relevant if you have a system con-
trolled by SampleTrack and ICON-NMR. When Fast SampleRail mode is
checked, the acquisition can start even though the carrier of the sample
rail has not returned yet.

Click Next to continue. The next dialog box shows the nuclei table (see
Figure 3.10). Normally, the default table is correct and you can just click
Next to continue. If you want to get back the default list, you must click
Restore. If, for some reason, you want to change the nuclei table, you can
do that here. Changes are automatically stored when you click Next. Note
that the nuclei table can also be changed at a later time with the com-
mand ednuc.
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x

Edit nuclei takle (delete or modify values:
Maote: You can also edit this takle with the command ednuc

4 Rucleus Matre eceptivity (rel. 1300 Frequency (rel. 1TH)
1H Hyedroggen SEZO0 142 S00.13
2H Deuteriurm 0.00521 1 TE.7T3
3H Tritivarm 1.0E-8 112 53345585583
3He Heliurm 0oo32e 152 350993893
BLi Lithivm 358 1 73509661
7Li Lithium 19400 382 194 369473
9Ee Beryllium Fi=R= I TO.277367
10B Boran 2241 3 53732257
1B Boron 7540 3R 160 4615749
13 Carban 1.0 1582 125.757784
14p Mitroger 568 1 36128816
150 Mitroger ooxa 152 SOETFTI3
. 170 Creygen 00811 582 E?.?EIEIT?SI
Add/Edit | Print | Delete | Restore | Save |

= Previous | et =

Figure 3.10

Next, the routing table will appear (see Figure 3.11). Here, you can only
set the connections between Switchbox output and Preamplifier mod-
ules, or, if there is no Switchbox, between the Amplifiers and Preamplifier
modules. As such, this step in ef corresponds to the command edasp
setpreamp. Note that in our example the Switchbox does not exist. If
the routing table shows invalid routing lines, remove them by click-
ing CLEAR preamplifier connections. Then define new lines according
to you hardware cable connections and click Save. If the routing table
is correct, you can click Cancel to close it.

The next dialog box shows an overview over the spectrometer configura-
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E_EEdil: Spectrometer Parameter ﬂ
frequency logical channel amplifier
rs
BF1 00 MHz ~ NUCH —
SFOA FCUA | XoAa0 e
OF 54
H &0 Wi
BF2 0.0 hMHz  HUCZ j
SFOZ 0.0 M Hz F2 | FCLUz | X
OFsz IIII.III Hz X300 g I—’
BF2 0.0 hMHz  HUCZ |-
SFO3 0.0 M Hz F3 | FCL3 |
-
2 | >
Sawve | Clear preamplifier connections | Cancel | Faram |
Figure 3.11
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tion (see Figure 3.12).

x|
e
Configuration sumimary (LEnme info):
COMFIGURATION INFORMATION
Late : Bat Sep Z0 10:04:45 Z003
Release : TopSpin Acquisition Wersion alphapl-0
Host : LEDA Windows NT 0 5 Pentium
Tser : LEDANAdministrator
System . Awance spectrometer
1H-frequency : 300.13 MH=
Hardware info: detected by hardware itself
# ____________________
# FCU configuaratiomn:
# ____________________
board # 1
MEMOPRY Oxl1ff000 (=511 k Words)
PAL-Version O0xl04 = new wversion (EC lewel 07 or
board § 2 : i
2 | >
= Previous | Cancel | Prirt |

Figure 3.12

This allows you to check if your spectrometer hardware has been detect-
ed correctly. If some of the hardware is missing, please run cf again. If
this does not change anything, run the spectrometer hardware checks.
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Click Next to continue.

Additional configuration programs:

Caonfig

Installation of standard experiments

Solvent table setup

Frobe tahle setup

Solvent dependent parameter setup

Lock parameter setup

Spectrometer parametes setup

Expinstall

Edsaly

Edhead

Edprosaol

Edlock

Edscan

= Previous |

Cancel

i

Figure 3.13

Finally, a list is shown of additional configuration programs like expin-
stall, edsolv. Click the respective button to execute these com-
mands. After they have finished, click Finish to close the cf dialog box.

After finishing cf, please save the spectrometer configuration by copying
the file uxnmr . par to floppy disk or CD and printing it out.
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INPUT FILES
<tshome>/exp/stan/nmr/form/

acqu.e.D - acquisition parameter format file (eda) for Avance

OUTPUT FILES
(also INPUT files for repeated configuration)
<tshome>/exp/stan/nmr/form/
acqu.e.D - acquisition parameter format file (eda) for Avance
<tshome>/conf/instr/
curinst
<tshome>/conf/instr/<instrum>

uxnmr . info - spectrometer configuration overview
uxnmr .par - spectrometer configuration
nuclei - nuclei table

<tshome>/conf/instr/<curinst>/rs232_device

acb - Amplifier control board rs232 channel

bacs - Sample changer rs232 channel

bsms - BSMS rs232 channel

lock - lock display rs232 channel

preemp - preemphasis rs232 channel

preampl - HPPR preamplifier rs232 channel
preamp?2 - second HPPR preamplifier rs232 channel L
preamp3 - third HPPR preamplifier rs232 channel 1
rx22 - rx22 or rxc receiver unit rs232 channel

temp - temperature unit rs232 channel

SEE ALSO

expinstall, edsolv, edhead, edprosol, edlock, edscon

1. For multiple RCU spectrometers only.

A-79



Spectrometer configuration commands

cortab

NAME
cortab - Setup acquisition correction table

DESCRIPTION

The command cortab opens a window from which amplifier and receiv-
er correction tables for acquisition can be created (see Figure 3.14).

Cortab Main Winbow

Mew Expenment  Scheduled Expenments Start Experments  View Vermcation Delete Tabie Edit Pawser Help

Avallable Corection Tables

Mucleus 4 Channel

1H SGU1 TH100_2 amp 4111
1ac SGU1 - mma

1H GG - mma

1H SEL2 1H100_2 amgp 4320
13c SGLU2 - mma

1H SGU2 - mma

1H SGU3 THI00_2 amg 43.30
2H SGL3 #3007 anmg 120.00
13 SGU3 - mma
15M SGL3 - mma

Figure 3.14

Before this window is opened, you are prompted for the NMR Adminis-
tration password. The correction tables are used to correct the non-line-
arity of the pulse power level versus the pulse length, and also to cancel
out the influence of the receiver gain on the phase of the resulting spec-
trum. The amplifier linearization is performed in a range from -6 to above
75 dB and involves both amplitude linearization and phase correction,
whereas the receiver phase correction is performed in a receiver gain
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range from 0.25 to above 1000. For the amplifier linearization, it is re-
quired that the amplifier output is connected to an external attenuator
which, in turn, is connected to the receiver input. The Cortab program will
inform you how to connect the cables and to which value you must set
the attenuator. The result of an amplifier linearization is a correction table
which is a list of correction values for the pulse amplitudes and phase val-
ues. It also contains a checksum which makes it possible to detect
whether the file has been changed in any way other than by Cortab.

An example of a correction table is shown in table 3.1.
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AMP_POWER
# power in dB correction in %
-6.000 0.000
-5.000 -32.644
-4.000 -38.510
-3.000 -37.361
-2.000 -35.032
-1.000 -31.672
0.000 -29.128
1.000 -24.939
2.000 -22.977
72.000 -0.008
AMP_PHASE
# power in dB correction in degree
-6.000 0.000
-5.000 -0.636
-4.000 0.622
72.000 4.323
# real amplifier output power in Watt (at -6dB)
AMP_VALUE
60.000000 0.00
#H#END
# hash MD5: 99 A6 79 CA 61 B175 1D 2E D1 6C 79 84 FD 08
2F

Table 3.1

Once a correction table exists, it is automatically used by acquisition
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commands like zg. If you want to check the accuracy of the ampilifier lin-
earization, Cortab allows you to do that by running a so called verification
test. This test is always performed after the linearization procedure but
can also be done in a separate experiment. Please note that TOPSPIN can
also handle correction tables created with Xwin-nmr. However, if you
want to use software power check features, amplifier correction tables
generated with TOPSPIN or Xwin-nmr 3.5 are required.

Amplifiers abbreviated 'BLA' and the multiplication unit of the Signal Gen-
eration Unit ('SGU MULT") require a Cortab correction. Because the SGU
appears earlier in the RF path, its correction table must be created first.
The result of the SGU correction is then automatically used for the ampli-
fier correction.

The receiver phase linearization, however, ("REC Phase Linearization")
is independent and may be performed even if other correction tables al-
ready exist.

Amplifier linearization can be performed in two possible ways:
» the amplifier output is connected to the external attenuator

+ the amplifier output is connected to the HPPR preamplifier (as in
an NMR experiment) and the preamplifier output is connected to
the external attenuator

The output of these two possibilities is not exactly the same. In general,
the second one, involving the preamplifier, is used because it is a better
simulation of the NMR experiment. However, the preamplifier must not
be used when a high power amplifier (> 500 W) is linearized.

The Cortab window allows you to set up the linearization experiments for
various nuclei, perform these experiments and view the results. Correc-
tion tables that already exist are displayed in a list ('Available Correction
Tables'). The list also contains a key word ('amp', 'mma', or 'rec') for each
correction table, indicating whether the respective table belongs to an

amplifier (amp), an SGU (mma), or a Receiver (rec). In case of an ampli-
fier table the respective amplifier output power at -6dB is also displayed.

A regular Cortab session involves the steps listed below. Each step is
specified by the corresponding button in the main Cortab window.

New Experiment
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Clicking this button opens a dialog box where you can define one or
more Cortab experiments. Cortab experiments should be defined for
each nucleus that you intend to use in your NMR measurements, an
exception being the Receiver Phase Linearization which is frequency
independent and needs to be performed only for one single (arbitrarily
chosen) nucleus.

The following functions are available:
BLA Linearization + Verification
SGU MULT Correction + Verification
BLA Verification
SGU MULT Verification
REC Phase Linearization + Verification
REC Phase Linearization

BLA and SGU (or REC) experiments must be executed in two sepa-

rate series because they require different hardware connections. First
you must set up one series for the SGU (and REC) functions and ex-
ecute this series (see Start Experiments below). Then you can set up

and execute a second series for the amplifier linearization.

Please note that the Cortab correction is mainly determined by the
BLA linearization (see table 3.1). However, it is strongly recommend-
ed to perform the SGU linearization first in order to achieve optimum
results. If you have a Router and you want to perform a MULT correc-
tion experiment, it is recommended that you connect the respective
router output (e.g. RO1) to the external attenuator rather than the
SGU output. This improves the quality of the resulting correction ta-
bles. The verification procedure is optional. It allows you to check the
quality of the respective linearization results. It simply repeats the lin-
earization but does not create a correction table. Instead, the existing
correction table is used and the resulting amplitude and phase values
are stored together with the calculated 'ideal' values in the verification
files (see View Verification below). Thus, the verification files are di-
rectly correlated with the quality of the correction tables used. Note
that you can also run a verification procedure without doing a lineari-
zation first. This can be useful to compare the corrected with the un-
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corrected amplifier characteristics.

New Experiment ® OK

Opens the routing table (like edasp) where you can determine the
appropriate hardware routing for the chosen experiment. Please
note that if you want to perform an SGU (or REC) calibration, the
complete and correct routing has to be chosen, though neither an
amplifier nor a preamplifier are used for this experiment. After click-
ing the SAVE' button, the selected experiment (function) is added
to the scheduled series. Instructions are displayed regarding the
required hardware connections and the recommended value for
the external attenuator is shown. Carefully follow the outlined in-
structions to prevent damaging the hardware units of the spectrom-
eter. In one Cortab series, you can add:

experiments for various nuclei
one nucleus with various routings
linearization and verification

You cannot, however, set an SGU (or even a REC) correction and
a BLA linearization in one series because they require different
hardware connections. After having scheduled the experiment, you
are prompted for the real amplifier output power at -6dB. This value
corresponds to the power (in Watts) measured at the output of the
respective HPPR preamplifier module when you are pulsing with -
6dB and using the routing you have already specified. If this power
is already known to the system, it will be displayed, otherwise zero
is shown. A valid amplifier output value is crucial for any kind of out-
put power limitation (e.g. to reduce the possibility of probe damage)
of the acquisition software. In some special situations, e.g. if you
want to use both the broadband input and the selective input of a
probe for the same nucleus, it may be necessary to define a sec-
ond amplifier power values here. In that case you may activate the
»2Additional power entry“ button and enter an additional power val-
ue. Note that in this situation the power values are associated with
the respective preamplifier modules used, i.e. the amplifier value
considered by the software depends on whether you use the XBB
or the selective preamplifier module. However, if the respective
power value is not known, you can either use zero (ignoring the
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power limitation possibilities of the acquisition software) or meas-
ure it with a wattmeter.In the following dialog window (Quick Exper-
iment Setup) you will be able to (optionally) select a variable
number of additional nuclei (together with their amplifier output
power, as mentioned above) that are to be linearized with the same
routing as the experiment you have already determined. This
saves time because you only need to set up the routing table once,
even if you want to generate a linearization table for multiple nuclei.
The nuclei are selected by applying a user defined search pattern
using the tokens "'

(separator) and '-' (nucleus range); for example, the search pattern
“1H, 31P-29Si” would select both 1H and all the nuclei in the fre-
quency range between 31P and 29Si. The system automatically
stores the last ten search patterns so that they can be reused for
further setups (e.g. with a different routing). It is also possible to edit
the search patterns by editing the respective file
quick exp setup.txt inthe cortab/etc directory.

* New Experiment ’ Finish

Closes the dialog box and returns to the main Cortab window

Start Experiments

Clicking this button executes all experiments in the currently sched-
uled series. They are performed in the order in which they appear in
the list. If a correction table already exists for the current experiment,
it is renamed by appending the current date to its name. Its file will be
overwritten if a further experiment with the identical setting is started
at the same date. Please note that you must, temporarily, switch off
the peak power limitation in order to run Cortab. To do that, run cf de-
activating POWCHK. After Cortab has finished, run cf again activat-
ing POWCHK. At the beginning of the linearization, you may be
prompted for the total external attenuation used. Cortab uses this val-
ue to generate scaled correction tables. This means the correction ta-
ble of each SGU unit is scaled to the correction table of the 'weakest'
SGU (provided that both nucleus and amplifier are the same). This
may be of interest for some experiments, but causes a small loss of
the maximum output voltage of the 'stronger' SGUs. The scaled cor-
rection table files reside in the subdirectory scale and have the ex-
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tension . scale and, as such, they are inactive. They can be
activated by removing the file extensions and copying them into the
cortab directory.

Each linearization experiment involves the following steps:

* Areceiver gain test
This determines the optimum receiver gain for the current
experiment. If this is successful, the experiment continues with
the next step. If this is not successful, the experiment aborts
and an information window will appear telling what to do (usu-
ally adjust the external attenuator). Just follow the instructions.

» The actual Cortab experiment, for example the BLA amplifier
linearization.

In principle, you are ready now. The correction table has been created
and it will automatically be used by the acquisition. If, however, you
want to check the Cortab result, you can do that with the View Verifi-
cation button, or simply double-click on an entry of the 'Available Cor-
rection Tables' list as described below.

View Verification

This button is only active when an entry is selected in the Available
Correction Tables list of the Cortab window. Clicking this button (or
double-clicking a list element) will then open a window where the re-
sults of the selected experiment are shown. The window consists of
the following fields:

» Date of the experiments
* Alist of dates at which Cortab experiments were performed.
* Name of the experiments

When a date is selected, a list of result filenames created at that date
is displayed. For example:

Amp_Power_res - theoretical and experim. amplifier output voltage
Amp_Phase_res - theoretical and experim. amplifier phase values

When you click an entry, the contents of the corresponding file are
shown. Note that files like Amp_Power_res do not contain the actual
correction values but rather the theoretical 'perfect' values and the ex-
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perimental values acquired on the base of the existing correction ta-

ble. The smaller the difference between theoretical and experimental
values, the better is the corresponding correction table. Therefore, the
result files contain two simple statistical key values which make it eas-
ier to estimate the overall quality of the correction file (average devia-
tion and standard deviation from the theoretical values). The smaller
these values are, the better is the correction table used for the verifi-
cation. Please note that verification files can be deleted to save disk

space without affecting the correction tables they correspond to.

A data field where the contents of the selected file are dis-
played.

Furthermore, the following push buttons are available:

* View Graph
opens a window with graphical and printable representation of
the Cortab result.

+ OK
closes the View Graph window and returns to the main Cortab
window

Edit Power

Clicking this button allows to modify the maximum amplifier output
power of a selected correction table (see Figure 3.15). A window is
opened where the new output power value at an arbitrary attenuation
value may be added. The software will automatically calculate the de-
sired output power value at -6dB.

* Calc Power at -6dB
Calculates the desired amplifier output power at -6dB under the
assumption that the amplifier behaves in a linear way. This
should be the case if the respective correction table has been
used during the output power measurement.

Scheduled Experiments

Clicking this button opens a dialog box where the currently scheduled
experiments are shown. The dialog box contains the following but-
tons:

*  Remove All : removes all experiments from the scheduled list
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M Edit Output Power For amp2_1H_2 B

Edit Power

Amplifier output power [YW]= |43.QD at [dB]= |-6.0

Calc Power at -6dB |

Amplifier output power at -5 dB:

Save | Cancel |

Figure 3.15

* Remove : removes the selected experiment from the list

* OK : exits the dialog box and returns to the main Cortab win-
dow

Cortab experiments use two spectrometer channels simultaneously:

» the pulse channel: selected by the user in the Cortab New
Experiment, i.e. the channel that is routed to the amplifier (or
SGU) that is being corrected.

» the observe channel: automatically selected by the Cortab pro-
gram. If the pulse channel is f1, the observe channel is f2. Oth-
erwise the observe channel is f1.

INPUT FILES
<tshome>/exp/stan/nmr/lists/pp.hwt

zg_ctb - cortab pulse program
<tshome>/exp/stan/nmr/par.avance
XCTB - cortab parameter set (high resolution NMR)

<tshome>/exp/stan/nmr/par.solids
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XCTB - cortab parameter set (solid state NMR)

OUTPUT FILES

<tshome>/conf/instr/<instrum>/cortab

amp<fcu no.> <nucl.> <ampl. RO>-amplifier correction tables
where RO is the router output number.

amp<fcu no.> <nucl.> <ampl. RO>.hp - amplifier correction
tables for high power amplifiers

raw/amp<fcu no.> <nucl.> <ampl. RO>.raw - raw data files;
for internal use only

scale/amp<fcu no.> <nucl.> <ampl. RO>.scale - correc-
tion table standardized to 'weakest' SGU

etc/amp_table -table where amplifier output power is stored; for in-
ternal use only

etc/quick exp setup.txt —table where search patterns for
Quick Experiment Setup are stored

mma<fcu no.> <nucl.> <ampl. RO>-SGU MULT correction ta-
bles

rec<receiver no.> phase -receiver phase correction table
<tshome>/QTP/<nucleus>/FCU<no>/<ampl. descr.>/<date>/

Amp Power res - theoretical and experimental amplifier output pow-
er (verification data)

Amp Phase res - theoretical and experimental amplifier phase val-
ues (verification data)

Mult Power res -theoretical and experimental SGU MULT output
voltage (verification data)

Mult Phase res -theoretical and experimental receiver phase val-
ues (verification data)

SEE ALSO
zg
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NAME

ednuc

ednuc - Edit nuclei table

DESCRIPTION

The command ednuc opens the nuclei table showing a list of nuclei with
their names, receptivity, spin and basic frequency (see Figure 3.16).

¥ Nuclei table |
4 Mucleus atme ] Freguency (rel. 1H)

1H Hyedrogen S E3E+3 112 500130000 ﬂ

2H Devteriurn 8ME-3 1 TE. 773000

SH Trititrn 1.00E-9 142 533 455553

GHe Heliurm J326E-3 112 380 995593

ELi Lithium 358 1 73509661

7L Lithiuim 154E+3 312 194 369473

HEe Beryllium 7.88E+1 342 TO.277367

106 Boron 22ME+1 3 53732257

118 Boron T54E+2 312 160 4615749

13 Carbon 1.00 152 125.?5??89l|
Al Eclit | Prirt | Delete | Restare | Save | Cloze |

Figure 3.16

The buttons of the nuclei table have the following functions:

Add/Edit

Edit a table entry or add a new one. A dialog is opened (see Fig-
ure 3.17) where you can enter or change values. If you enter a
new Nucleus, an entry is added to the list, otherwise the current
entry is edited.

Delete
Delete the selected entry/entries.

Restore
Restore the original nuclei table. All changes you made will be
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Add new nucleus
Mucleus | w
Mame
Receptivity (rel. 132 Mak
Spin 112 b

Freguency (rel. 1H) Makl

Figure 3.17

undone. This must be done once, if you have changed the basic
frequency with cf.

* Save
Save any changes the nuclei table. You will be prompted for the
NMR administration password.

* C(Close
Close the nuclei table.

Note that double-clicking a table entry also opens the dialog you see in
Figure 3.17 but only allows you to change the frequency.

INPUT FILES
<tshome>/conf/instr/<instrum>/
nuclei - nuclei table
<tshome>/exp/stan/nmr/lists/

nuclei.all - complete nuclei table (input and Restore)

OUTPUT FILES
<tshome>/conf/instr/<instrum>/

nuclei - nuclei table

SEE ALSO
edsolv, edhead, edlock, edprosol
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NAME

edprosol

edprosol - Edit probehead and solvent dependent parameters

DESCRIPTION

The command edprosol opens a dialog box in which you can set the
probehead and solvent dependent (Prosol) parameters (see Figure
3.18). This is typically done during the installation of your spectrometer
for all probeheads and solvents you want to use. However, you can also
run edprosol again at a later time to set the Prosol parameters for ad-
ditional probeheads and/or solvents.

Setting the Prosol parameters involves the following steps:

1. Select the probehead, solvent(s) and nucleus by clicking:

Probe’s name

By default, the current probehead (as defined with edhead) is
selected. Prosol parameters must be defined for each probehead
separately.

Solvent

The default value is A/l If you keep that value, the same Prosol
values will be stored for all solvents. If, however, you select a spe-
cific solvent, the Prosol parameters will be stored for that solvent
only.

Nucleus

By default, the nucleus of frequency channel f1 of the current
dataset (NUC1) is selected. Prosol parameters must be set for
each nucleus separately.

2. This step is optional. You can enter two comment lines; for example
the conditions under which the pulses/power levels have been deter-
mined (filters etc.). Note that this feature is not visible in Figure 3.18).

3. Select the channels for which you want to define the parameters.
You can do this by clicking one of the following radio buttons:

FI+F2 : Prosol parameters for the f1 and f2 frequency channel
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i edit prosol parameters

=10] %
Eile Help
Edit prosol parameters for: Frobe's name |5 rarn THLTH-21FMEC Z-GRO FEES1M002

Here you can enter two 'comment lines”:

Solvent(s) |l

3

Nucleus I‘H—Ii ﬂ

Please select the logical channel: IF Fi+Fz = Fz

i Fa
“
Standard parameters for 1H on channel F1 routed to amplifier A2: |
Descrption pulse [use: power |ewel
90 deg. transmitter Pan | 9.3 | 4
cpd PCPOP | R
mix tirme [5 pulse [usec power lewel
tocsy spin lack PTOC | ooe | 23 [ 129 eale
roesy spin lock PROE | 0z | 100 | 2dEz eale.
field [Hz] power level
s irradiation RLC | 50 | 120 eale.
[~
| | D
I {% Standard hard pulses

Save

" Standard soft pulzes

Copy to probe

Copy to salwent | Frirt screen

Exit

Figure 3.18
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» F3, F4, F5 etc. only appear if these channels exist and your spec-
trometer is configured as such.

* Global : a few Prosol parameters that count for all frequency chan-
nels

By default, FI+F2 is checked. Most experiments only use channel f1
or f1 and f2. If you are using f3, f4 etc. you have to set the Prosol pa-
rameters for these channels as well. Note that f1, f2, f3 etc. refer to the
logical frequency channels as you will see them in the routing table
(edasp). They should not be confused with the terms that are used to
indicate the directions of multidimensional dataset.

4. Select the type of pulses that you want to set. For this purpose the
following radio buttons are available at the bottom of the window:

» Standard hard pulses
shows a list of standard hard pulses and allows you to set their
pulse lengths, power levels and mixing times (tocsy and roesy

only)

* Standard soft pulses
shows a list of standard soft pulses and allows you to set their
pulse lengths, power levels, phase alignments and shape files

By default, Standard hard pulses is checked which is sufficient for most
experiments.

5. Set the pulse lengths and power levels for the selected frequency
channel(s) and pulse type(s). You should start with the 90° hard
pulse which must have been determined before you start edprosol.
Then you can define all other pulses for the current channel. You can
enter the pulse length and click the calc button to determined the cor-
responding power level. Alternatively, you can enter the power level
and click the calc button to determine the corresponding pulse length.
This, however, only works if the pulse length is set to 0 at the time
calc is clicked. Note that the relation used by calc is determined by
the 90° hard pulse.

6. Save the Prosol parameters by clicking the Save button at the bottom
of the dialog box.

To the right of the Save button, you will find the following buttons:
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* Copy to probe
Open a list of all probeheads. You can select the probehead(s) for
which you want to store the Prosol parameters and then click one
of the buttons
Save to all solvents or Save to selected solvents.

*  Copy to solvent
Open a list of all solvents.You can select the solvent(s) for which
you want to store the Prosol parameters and then click Save to
store it.

* Print screen

List the currently selected Prosol parameters on the printer.
* Exit

Quit the edproso1 dialog box.

The edprosol dialog box provides a few additional options if you switch
to expert mode. You can do that by clicking File > expert mode. Right
above the parameter table, an arrow button will appear where you can
select the amplifier connected to the currently selected channel. The de-
fault amplifier is normally correct. At the bottom of the window, two extra
radio buttons will appear:

* user-defined hard pulses
shows a list of user-defined pulses and allows you to set their
pulse length and power level.

* user-defined soft pulses
shows a list of user-defined pulses and allows you to set their
pulse length and power level.

User defined hard and soft pulses require a separate (user defined) rela-
tions file. It can be setup from the Windows Explorer or from a Linux shell
in the directory

<tshome>/conf/instr/<instrum>/prosol/<probelD>/relations
Just copy the standard relations file and modify it to your needs.

The edprosol window allows you to set up a probehead dependent

tune file. You can do that by clicking File > Edit tunefile. On first time exe-
cution, this command displays the example tune file that is delivered with
TopsPIN. When you save the file, it is stored for the probehead that is cur-
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rently defined in edprosol. Probehead dependent tune files are read by
the command tune . sx.

The Prosol parameters are interpreted by the getprosol command that
copies them to the corresponding acquisition parameters. The default re-
lations between Prosol and acquisition parameters are listed in table 7.1.
Note that getprosol is automatically performed as part of the ICON-NMR
automation.

Note that the probehead and solvent dependent lock parameters are set
with edlock.

INPUT FILES
<tshome>/exp/stan/nmr/lists/group/
example - example tune file (input for first File > Edit tunefile)
<tshome>/prog/tcl/xwish3_scripts
edprosol - Tcl/Tk script that is started by edprosol
<tshome>/prog/tcl/libtix/prosol/lib/lists

routing - default spectrometer routing

INPUT AND OUTPUT FILES
If you select Solvent(s) A/l
<tshome>/conf/instr/<instrum>/prosol/<probelD>/

nucleus.channel.amplifier - standard prosol parameters
params - global (channel independent) prosol parameters
tunefile - probe dependent tune file (input for File > Edit tunefile)

If you select a specific solvent:
<tshome>/conf/instr/<instrum>/prosol/<probelD>/<solvent>

nucleus.channel.amplifier - standard prosol parameters
paramns - global (channel independent) prosol parameters
tunefile - probe dependent tune file (input for File > Edit tunefile)

SEE ALSO
getprosol, edlock
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NAME

edscon

edscon - Edit spectrometer constants

DESCRIPTION

The command edscon opens a dialog window, where you can set cer-
tain spectrometer parameters (constants) (see Figure 3.19).

Eﬂ Edscon

Spectrameter Parameters

BLKTR [p=] = Ediit... Preset titme for amplifier blanking

DE1 [ps] = 3.20 Titme between LO switching and start of FID

DERX [p=] = 1.50 Titme between receiver enable and start of FID
DEADC [ps] = 0.50 Tirme between ADC enable and start of FID

DEPA [ps] = 3.50 Titme between preamplifier switching and start of FID
FILCOR [p=] = 0.00 Correction for fitter delay

X]

[ Unida H Save H Cloze ]

Figure 3.19

The term constant refers to the fact that these parameters count for all
datasets. edscon must be executed once as part of the spectrometer
configuration.

Changes in the edscon parameters can be stored by clicking OK. You

will be prompted for the NMR Administrator password.

BLKTR is an array of amplifier blanking preset times. This means they
only allow RF signals to pass during the time they are blanked. Because
of the finite switching time, blanking is triggered before the start of the RF
pulse. The amplifier is blanked BLKTR pusec before the pulse. It is un-
blanked (allows no further RF passing) at the end of the pulse.

The use of the edscon preset parameter BLKTR can be switched off by
inserting the statement
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preset off

at the beginning of a pulse program. This has the same effect as setting
all elements of BLKTR to zero. In this case, the blanking steps described
above occur at the beginning of the RF pulse. Nevertheless, you can en-
able the preset blanking for each individual channel, e.g.:

21 gatepulse 1 ;enable blanking for channel f1
21 gatepulse 12 ;enable blanking for channel f1 and f2

In this example, the blanking of the transmitter and preamplifier is trig-
gered 2 usec before the RF pulse.

The edscon dialog box also shows the so called pre-scan subdelays.
These are all part of the pre-scan delay DE. This is a hidden delay (it is
not specified in the pulse program) that is automatically introduced by the
go statement.

DE consists of 5 pre-scan delays DE1, DERX, DEADC, DEPA and DE
itself. The sub-delays DE1, DERX, DEPA and DEADC are global param-
eters which depend on the properties of the respective spectrometer
hardware. DE is also set globally but can be changed temporarily by de-
fining a value in the pulse program. DE mostly depends on the dead-time
of the probe. It starts with the "go = .." instruction of the pulse program.
All delays end simultaneously at the beginning of the data sampling.
They act as pre-delays to the data sampling. This is different from the be-
haviour of TopSpin1.3 and XWINNMR. With these older software ver-
sions all delays started simultaneously as post-delays to the go
instruction and the data sampling started together with the end of the
longest delay DE. Therefore, the values of the sub-delays have changed
with TopSpin2.0. Updating from an older software version to TopSpin2.0
will result in an update of the edscon parameters to default values. At the
end of each subdelay a certain action is performed:

DE1: the intermediate frequency (if required) is added to the frequen-
cy of the observe channel. This corresponds to the execution of the
syrec statement (default 2 usec). The intermediate frequency is only
used for AQ_mod = DQD or, if your spectrometers has an RX22 re-
ceiver, for any value of AQ_mod.

DERX: the receiver gate is opened (default 3 usec)
DEADC: the digitizer is enabled (default 4 pusec)
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DEPA: the preamplifier is switched from transmit to observe mode
(default 2 usec)

Normally, the default values, which have been set during the installation
of your spectrometer, can be used. Each subdelay has a maximum of DE
- 1 usec.

In most pulse programs, data sampling is performed by the go statement,
which automatically triggers the actions mentioned above after the corre-
sponding pre-scan subdelay. If, however, data sampling is performed by
the adc statement, these actions must explicitly be specified in the pulse
program. Each action can be performed by a statement with the same
name, in lower case letters, as the corresponding pre-scan subdelay. For
example, the receiver gate can be opened with the derx statement. You
can type edpul zgadc to look at an example of a pulse program using
the adc statement. For more information on this topic click:

Help’ Manuals° [Programming Manuals] Pulse Programming Manual

The prescan subdelays only play a role for digitally filtered data (DIG-
MOD = digital or digital homodecoupling). For DIGMOD = analog, the pa-
rameter DE has a different purpose. It is used to achieve a near zero first
order phase correction of the spectrum. In this case, it does not consist
of subdelays.

INPUT AND OUTPUT FILES

<tshome>/conf/instr/<instrum>/

scon - spectrometer constants

SEE ALSO

cf
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NAME
edsolv - Edit solvent table

DESCRIPTION
The command edsolv opens the solvent table (see Figure 3.20).

Eﬂ Solvents table

Acetic acetic acid-d4 L

Acetone acetone-db

CEDE henzene-dE

CEFE hexafluarohenzene

CEHICFS trifluorotoluens B

CEH3F fluorobenzens

Ch2C2 methylenechloride-d2

COECH acetonitrile-d3

CO3CH_SPE LC-5PE Saolvert (Acetonitrile)

COCIS chilaraform-d

CHICH+D20 HPLC Solvent [Acetonitril D200 bt

< [ >

| print || scEdt || Delete || Restore || save || Close |
Figure 3.20

This table contains one line for each solvent and shows the solvent name
and a short description.

You can right-click in the table to copy or export the selected entries or to
modify the table properties.

The buttons at the bottom of the solvent table have the following func-
tions:

*  Add/Edit
Edit a table entry or add a new one. A dialog is opened (see Fig-
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ure 3.21) where you can enter or change values. If you enter a
new Solvent, an entry is added to the list, otherwise the current
entry is edited.

Add or edit zalvent

Solvent
Description
[ Ok ] [ Cancel ]
Figure 3.21
* Delete
Delete the selected entry/entries.
* Restore
Restore the original solvent table. All changes that you made will
be undone.
e Save

Save any changes the solvent table. You will be prompted for the
NMR administration password.

e (Close
Close the solvent table.

Before you start an experiment, you must set the parameter SOLVENT
to an entry from the solvent table. If you do this from eda, you can click
the arrow button to the right of this parameter and select an entry from
the solvent list.

INPUT FILES
<tshome>/exp/stan/nmr/lists/

solvents.all - complete Bruker solvent list (input for first edsolv
and for edsolv’ Restore)
solvents - user solvent list (input for second or later edsolv)
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OUTPUT FILES
<tshome>/exp/stan/nmr/lists/

solvents - user solvent list

SEE ALSO
ednuc, edhead, edlock, edprosol
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edsp

NAME
edsp - Set up nuclei and spectrometer routing

DESCRIPTION

The command edsp allows you to set up the nuclei and the spectrometer
routing for the current experiment. edsp is equivalent to edasp except
for the following:

* edasp reads the irradiation frequencies offsets OFSH1, OFSX1,
OFSX2 etc. from the current dataset.

* edsp reads the irradiation frequencies offsets OFSH1, OFSX1,
OFSX2 etc. that were stored by the previous edsp or edasp.

A such, edsp allows you to transfer the frequency offset for a certain nu-
cleus from one dataset to another. For example:

DATASET 1

rpar PROTON all
edasp or edsp’

BF1 500.130 MHz NUCA1
SFO1 500.135 Mhz F1
OFSH1 5000.00 Hz 1H

SAVE
DATASET 2

rpar PROTON all
edsp’

BF1 125.757 MHz NUC1
SFO1 125.758 Mhz F1
OFSH1 1000.00 Hz 13C

BF1 500.130 MHz NUC2
SFO1 500.135 Mhz F2
OFSH1 5000.00 Hz 1H

The irradiation frequencies SFO1, SFO2 etc. are automatically adjusted
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to the corresponding frequency offsets.

The command edsp is also part of the spectrometer configuration. It
must be executed only once, after the installation of TOPSPIN.

edsp should be executed before expinstall which installs the stand-
ard parameter sets.

INPUT AND OUTPUT PARAMETERS
see edasp

INPUT AND OUTPUT FILES
see edasp

SEE ALSO

edasp, expinstall
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expinstall

NAME
expinstall - Install pulse programs, AU programs, parameter sets etc.

DESCRIPTION

The command expinstall installs pulse programs, AU programs, pa-
rameter sets and various other resources for spectrometer usage. On a
spectrometer, it must be performed once, after the installation of TOPSPIN
and after c¢f has been done. On a datastation, c¢fis not needed and you
can run expinstall immediately after the installation of TOPSPIN.

Configure a spectrometer

To configure a spectrometer:

» Click Spectrometer ’ Setup > Experiment installation or enter expin-
stall on the command line.

™ Password request E|

Pleaze enter the MMR adminiztration
pazsword:

[ ik ][ Cancel ]

* Enter NMR Administrator password as requested.
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% | Experiment installation and AL compilation @

Expinstall

Expinztall inztallz pulze programs, AU programs,

parammeter sets and various other resources for spectrometer

or datastation uzage. t must be performed once after the

installation of TOPSPIM. For spectrometer contral do cf first. -
For a customized datastation configuration copy your

spectrometer configuration directory (typically called "spect™)

o =Topspin installation dir =fconfinstr.
-

In the appearing information box:
* Click Next

E! Experiment installation and ALl compilation

Select the type of installation:
{:} Inztallation for Datastation (Default) n

{:!' Inztallation for Datastation (Customize)

@ Installation for Spectrometer
w

3 |

(o) (e |

In the appearing dialog box:

» Check Installation for Spectrometer.
* Click Next
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% | Expinstall for Spectrometer,

Select the type of acquisition:
High Rezalution Systems —

[] Solid State Systems

|:| Micro-lmading and Diffusion Systems
w

< |

(o ) (e ]

In the appearing dialog box:
» Check High Resolution Systems.
* Click Next

E! Expinstall for, Spectrometer,

Available spectrometer or datastation configurstions:

Select the configuration you want to uze:

sphect hd |

(o ] (e ]

In the appearing dialog box:

» Select the spectrometer configuration name that was defined with
cf

* Click Next
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% | Expinstall for Spectrometer,

Select the tems you want to install:
Ihstsll Pulze Programms

Ihstall Bruker Library AL Programs

|:| Recompile All Uzer AL Programs

Install Library CPD Programs

Install Likbrary Gradient Files

Install Library Shape Files

Convert Standard Parameter Sets

Install Standard Scaling Region Files

Erable Define Staterments in Pulse Programs
Install Bruker Macros

Install Bruker Python Programs

[ Select all ][ Zelect none ]

b

(o ) (e ]

In the appearing dialog box:

» Check the items you want to install, or accept the default selec-
tion.

« Click Next
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% | Expinstall for Spectrometer,

Select vour printer:

Default printer: |::ne|| Photo AIC Prirter 922

Select vour plotter:

Default plotter: |De|| Photo A1C Prirter 922 v |

Select the plotter paper format:

Paper format:
w
[ = Back ][ et = ] Finizh

In the appearing dialog box:
» Select the default printer and plotter and the desired paper format.
* Click Next
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& | Expinstall for Spectrometer

Select the basic frequency of your spectrometer:

Baszic frequency (MHZ): 30013

Select the digitizer:

Type of digitzer: 1=

Select the acguisition mode:

Acquisition mode; DD w

Select the pre-scan-delay DE:

=
—

Default pre-zcan-delay (ps):

[ = Back H Mext = ]

In the appearing dialog box:

» Enter the desired spectrometer frequency, acquisition mode and

pre-scan-delay, or accept the default values.

e Click Next
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% | Expinstall for Spectrometer, @

~
Expinztall will be executed with following options:

Installation for Spectrometer
[High Resolution)

Install Pulse Programs
Install Bruker Library AL Programs
Install Library CPD Programs hd

[ Finizh H Cancel

In the appearing information box:

» Check the configuration selection and, if it is correct, click Finish. If
it is not correct, click Back to change the incorrect settings.

The installation of the selected items, will start now. Wait until this proc-
ess has finished.

Configure a Datastation like a spectrometer

If you want to configure your datastation like your spectrometer, you must
first copy the configuration directory:

<tshome>/conf/instr/<instrum>
from that spectrometer to the datastation. Here:

<tshome> is TOPSPIN home, the directory where TOPSPIN is installed.
Note that this can be different on the spectrometer than on the dat-
astation.

<instrum> is the configuration name.
See also the description of the command nmr_save.

After copying the configuration directory, you have to perform expin-
stall as follows:

* Click Spectrometer ’ Setup > Experiment installation or enter expin-
stall on the command line.
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(™ Password request [z|

Pleaze enter the MMR adminiztration
password:

[ [8]38 ” Cancel ]

* Enter NMR Administrator password as requested.

% | Experiment installation and AL compilation E

Expinstall

Expinztall inztallz pulze programs, AU programs,

parammeter sets and various other resources for spectrometer

or datastation uzage. t must be performed once after the

installation of TOPSPIM. For spectrometer contral do cf first. o
For a customized datastation configuration copy your

spectrometer configuration directory (typically called "spect™)

o =Topspin installation dir =fconfinstr.
-

In the appearing information box:
* Click Next
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% | Experiment installation and AU compilation

Select the type of installation:
O Installation for Datastation (Detault) —

G} Inztallation for Datastation (Customize)
{:} Inztallation for Spectrometer

(<o ) (oo |

In the appearing dialog box:
» Check Installation for Datastation (Customize)
* Click Next

% | Expinstall for Spectrometer,

Select the type of acquisition:
High Rezalution Systems —

[] Solid State Systems

|:| Micro-lmading and Diffusion Systems

(o ) (o

In the appearing dialog box:
+ Check High Resolution Systems
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Click Next

Eﬂ Experiment installation and ALl compilation

Available spectrometer or datastation configurations:

Zelect the configuration you wwant to uze:

o J

W

£ | >

(oo ) (en

In the appearing dialog box:

Select the spectrometer configuration name.
Click Next

& | Expinstall for, Spectrometer E]

~
Select the tems you want to install: T
Install Pulze Programs

Inztall Bruker Libtary AU Programs

|:| Recompile Al User AU Programs

Install Library CPD Programs

Install Library Gradient Files

Install Library Shape Files

Convert Stahdard Parameter Sets

Install Standard Scaling Region Files

Enable Define Statements in Pulse Progratns
Install Bruker Macros

Inztall Bruker Python Programs

[ Select all ” Select none ] i
-

[ = Back ” Mext = l
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In the appearing dialog box:
» Check the items you want to install or, accept the default selection.
+ Click Next

E! Expinstall for, Spectrometer,

Select vour printer:

Default printer: DEII Photo A1 Printer 922

Select vour plotter:

Default plotter: |DE:II Phioto A1 Printer 922 b |

Select the platter paper farmat:

Paper formst:
-
[ = Back ][ et = ] Finizh

In the appearing dialog box:
» Select the default printer and plotter and the desired paper format.
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e Click Next

E! Expinstall for, Spectrometer,

Select the basic fregquency of your spectrometer:

Basic fregquency (MHz): 30015

Select the digitizer:

Type of digitzer: I:I

Select the acouisition mode:

Acguisition mode:

Select the pre-scan-delay DE:

Default pre-scan-delay (ps):
w
(oo ) (mon )

In the appearing dialog box:

» Enter the desired spectrometer frequency, acquisition mode and
pre-scan-delay or, accept the default values.
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e Click Next

& Experiment installation and ALl compilation @

”
Expinstall will he executed with following options:

Installation for Datastation [Customize)
[High Resolution)

Inztall Pulze Pragrams

Inztall Bruker Library AL Programs

Inztall Library CPD Programs

Inztall Library Gradient Files bt
< >

Finizh H Cancel

In the appearing information box:

» Check the configuration selection and, if it is correct, click Finish. If
it is not correct, click Back to change the incorrect settings.

The installation of the selected items, will start now. Wait until this proc-
ess has finished.

INPUT PARAMETERS

If the task Convert standard parameter sets is selected, expinstall uses
the following input parameters:

from the parameter sets as delivered with TOPSPIN:

BF1 - BF4 - basic frequencies for channel f1 to f4

SFO1- SFO4 - irradiation (carrier) frequencies for channels f1 to f4
INO - increment for delay DO (2D and 3D parameter sets only)
IN10 - increment for delay D10 (3D parameter sets only)

SW - spectral width in ppm

SPOFFS[0-7] - shaped pulse frequency offset

OUTPUT PARAMETERS
If the task Convert standard parameter sets is selected, expinstall stores
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the following parameters in the parameter sets:

BF1 - BF4 - basic frequencies for channel 1 to f4

SFO1- SFO4 - irradiation (carrier) frequencies for channels f1 to f4
SF - spectral reference frequency

INO - increment for delay DO (2D and 3D parameter sets only)

IN10 - increment for delay D10 (3D parameter sets only)

SW - spectral width in ppm

SPOFFS[0-7] - shaped pulse frequency offset

DIGTYP - digitizer type

DR - digital resolution

DIGMOD - digitizer mode

DECIM - decimation factor of the digital filter

DE - prescan delay

FCUCHAN - routing between logical frequency channels and FCU’s
RSEL - routing between FCU’s and amplifiers

SWIBOX - routing between Switchbox inputs and Switchbox outputs
PRECHAN - routing between Switchbox outputs and Preamplifier
modules

HPMOD - routing between high power amplifiers and Preamplifier
modules

INPUT FILES
<tshome>/db/bruker/

pp_dexam.xml - Sources Bruker defined pulse programs

cpd dexam.xml - Sources Bruker defined CPD programs

mac.xml - Sources Bruker defined macros

pyexam.xml - Sources Bruker defined Python programs
<tshome>/prog/au/src.exam/* - Bruker AU programs (source files)
<tshome>/conf/instr/<instrum>/specpar - routing parameters

<tshome>/exp/stan/nmr/par.avance/* - Bruker parameter sets for
Avance

<tshome>/exp/stan/nmr/gp.dexam/* - gradient files for Avance

<tshome>/exp/stan/nmr/wave.dexam/* - shape files for Avance
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<tshome>/exp/stan/nmr/scl.exam/* - scaling region files for
Avance/AMX

These are the files/directories used for high resolution experiments. For
other experiments other files/directories are used, e.g.
pp_dsolids.xml and gp.solids for Solids pulse programs.

OUTPUT FILES
<tshome>/exp/stan/nmr/au/src/* - Bruker AU programs (source files)

<tshome>/exp/stan/nmr/par/* - parameter sets for your spectrometer
<tshome>/exp/stan/nmr/lists/pp/* - pulse programs for your spectrometer

<tshome>/exp/stan/nmr/lists/cpd/* - CPD programs for your spectrome-
ter

<tshome>/exp/stan/nmr/lists/gp/* - gradient files for your spectrometer
<tshome>/exp/stan/nmr/lists/wave/* - shape files for your spectrometer

<tshome>/exp/stan/nmr/lists/scl/* - scaling region files for your spectrom-
eter

<tshome>/exp/stan/nmr/lists/mac/* - TOPSPIN macros

SEE ALSO

cf, cplbruk, cpluser, compileall, rpar, wpar
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ha

NAME
ha - Show hardware ethernet addresses

DESCRIPTION

The command ha opens the dialog window shown the addresses of the
ethernet accessible hardware devices. For each device, the ethernet ad-
dress is displayed and an Open button is available. Clicking this button
opens the default web browser showing the respective hardware config-
uration. Here, you can set various configuration settings.

E! Hardware ethernet addresses @

The hardware devices listed below can be accessed
and configured with a "WEB-Browser".

Fress the "Open" button for a browser with a
connection to this device.

hain Controller

PO 149.236.99.100

Digital Feceper Linit

DRU 149.236.99 69

Lock!Shim

BEmMs Z1008158/0020 14923699101

[ Brint H Close ]

Figure 3.22
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The command ha can also be started from the TOPSPIN menu:
click Spectrometer ’ Setup ° Ethernet addresses of hardware
or

click Options > Spectrometer Tools ° Ethernet addresses of hardware

SEE ALSO
cf
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nmr_save, nmr_restore, user_save,
user_restore

NAME

nmr_save - Save installation specific files
nmr_restore - Restore installation specific files
user_save - Save user specific files
user_restore - Restore user specific files

DESCRIPTION

The commands nmr_save and user_save save installation/user spe-
cific files in a backup TAR-file.

The commands nmr_restore and user_restore extract a backup
TAR-file to the same or to a different installation.

All these commands open the dialog window shown in Figure 3.24, the
individual commands being available as tabs.

& NMR_ Save

i Save Installation files; Restore installation files | Save user files | Restore user files

Save installation Speciic files
Installation specific files are collected and stored into a tar file. This tar file can be used
to copy the files from & previous installation to a new installation of to create a backup

of the installation specific files

Note: To save user specific files use the "Save user files' tab

Location of hackup file CHBrUKenT OPSPINYIF_kackup

Owerwrite existing backup file:

Installation to be saved (TopSpin home): CABrukenTOPSPIN

Spectrameter configuration (e.0. specty spect_av900 -
Display default information: @

Display additional infarmation,

Execute "Save installation specific files" periodically | Automatic Backup

Log

Save Close |

Figure 3.23
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Here you can specify:
* Location of the backup file: the storage directory of the backup
file
* Installation to be saved : The TOPSPIN home directory
+ Spectrometer configuration: as enter during c£.

Furthermore, you can select
» Display default information: the path of the created backup file

» Display additional information: the path of the created backup
file, information about directories being saved and convert-
ing/renaming information

The button Define cron job opens the cron dialog where you can define a
periodic save of Bruker or user files (see also command cron).

Here you can save or restore all TOPSPIN user defined files. This includes:
+ Spectrometer configuration files (cf£)
» Parameter sets (rpar, wpar)
* Pulse program (edpul, edcpul)
* AU programs (edau)
» Plot editor layouts (plot, autoplot)
* Shim files (rsh, wsh)
* Gradient shimming field maps (gradshim)
* ICON-NMR user information (iconnmr)
* Program Licenses (TOPSPIN, NMR-SIM, NMR Guide)
» Various lists like scl, f1, ds (ed1list, zg, gs)
» TOPSPIN macros (edmac)
* Probehead and solvent dependant parameters (edprosol)
* Lock parameters (edlock)
* Probehead information (edhead)
* Nucleus information (ednuc)
* RF Shapes and gradients

etc.
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For more details about the commands nmr_save, nmr_restore, user-
save and user-restore please refer to the respective Bruker TopSpin In-
stallation Guides for Windows XP, Windows Vista or Linux.

INPUT AND OUTPUT FILES
<tshome> /nmr_backup

nmr_backup <date>-<time>.tar (nmr_save)
nmr backup <username>-<date>-<time>.tar (user_save)

<tshome>/exp/stan/nmr/au/src/

nmr save - AU program executed by nmr_save

INPUT AND OUTPUT DIRECTORIES
nmr_save stores various subdirectories/files of:

<tshome>/exp/stan/nmr/py/
<tshome>/exp/stan/nmr/lists
<tshome>/exp/stan/nmr/par/
<tshome>/exp/stan/nmr/au/src/
<tshome>/plot/layouts/
<tshome>/conf/instr/
<tshome>/prog/tcl/xwish3 scripts/
<tshome>/exp/stan/nmr/parx/preemp/
<tshome>/QTP/
<tshome>/data/final/nmr/protocolfiles/
<tshome>/conf/global
<tshome>/prog/server/export.conf

user_save stores various subdirectories/files of:

<userhome>/.topspin-<hostname>
<tshome>/exp/stan/nmr/py/
<tshome>/exp/stan/nmr/lists
<tshome>/exp/stan/nmr/par/
<tshome>/exp/stan/nmr/au/src/
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INPUT AND OUTPUT DIRECTORIES
SEE ALSO

cf, expinstall, cron
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paracon

NAME
paracon - Change the basic frequency in parameter sets

DESCRIPTION

The command paracon changes the basic frequency in parameter sets.
This allows you to use parameter sets that were created on a spectrom-
eter with a different frequency. It opens dialog box shown in Figure 3.24.

E!Parameter set conversion il

Parameter zet conwversion. Available parameter etz
PROT-WT

Select parameter sets for conversion PROTOR

fram the list on the right. Use the check
PROTOM1 28

hoxes to select bruker or user defined

parameter sets. PROTORNZSE
PROTOMCOMLF

IUge the match field to apply wildcards FROTOMEXP

o the list of parameter zets. PROTOMLF
PROTOMLFEXF

Uze cf to set parameters. FROTOMME

Easic frequency; 50013 PROTOMMREXE

¥ Bruker defined parameter zets PROTORMRLF
PROTOMTI

™ User defined parameter ssts PROTOMinTO

Match: IF‘ROT*

[T Case insensitive match

Select all | Select none Cancel | QK |
Figure 3.24

Here you can setup a list of available parameter sets. You can select
Bruker and/or User defined parameter sets and use a match string. The
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matching parameter sets appear in the right part of the dialog box. To
start the conversion, select one or more parameter sets and click OK.

INPUT AND OUTPUT PARAMETERS
Acquisition parameters:

BF1 - BF8 - basic frequency for frequency channel f1 to f8

SFO1 - SFO8 - irradiation (carrier) frequencies for channels f1 to f8
01 - O8 - irradiation frequency offset for frequency channel f1 - f8 in
Hz

SW - spectral width in ppm

Processing parameters:

SF - spectral reference frequency

INPUT AND OUTPUT FILES
<tshome>/exp/stan/nmr/par/*/

acqu - acquisition parameters
proc - processing parameters

SEE ALSO

expinstall
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Chapter 4

Lock commands

This chapter describes the commands that are involved in locking the mag-
netic field. Avance spectrometers use a digital lock which is provided by the
BSMS unit. Locking the magnetic field is done by measuring the signal of a
lock nucleus and adjusting the magnetic field whenever its frequency shifts.
Common lock nuclei are 2H and 19F.
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edlock

NAME
edlock - Edit the lock table

DESCRIPTION

The command edlock opens the lock table; a dialog box in which the
lock parameters can be set (see Figure 4.1).

(=)E3
M [ % W G 72

Eclit |2H Lock File W | [Curhead 03 5 mm Dual 13C4H)

asizFredg: 300150000 [MHZ] BamzField: CDCI3100.0 Mucleus | 2H A

|[Fied-...|[Lock... |[Loop... | [Loop... | LoopFit [Lock... | [Dista... || Ret || width |[Rei-...|
400 [0 01 [oo |4 203 00 o5 oo
400 0 o1 [oo |4 204 00 05 |00
250 |15 n2 {100 |4 724 |00 05 o0
300 15 o4 {00 |1 532 00 05 |00
400 0 o4 {00 |1 1593 00 05 oo
260 15 nz  [oo |1 728 00 o5 oo
200 |5 02 200 | 470 00 05 o0

Figure 4.1

It must be executed once for each probehead and each lock nucleus.
The lock parameters can be determined from the BSMS keyboard or
from the BSMS display (command bsmsdisp). The toolbar of the ed-
lock dialog provides the following buttons:

] save the lock table

| ] add a new solvent

& delete the selected solvent(s)

- read the current values from the BSMS

55 copy the value of the selected parameter to all solvents

7 show the edlock help page
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Below the toolbar, the current probehead, the field value (HO) and the ba-
sic spectrometer frequency are displayed. The latter must be specified
when the spectrometer is configured with c£. The lock frequency is au-
tomatically calculated from the basic spectrometer frequency. You can
select the lock nucleus and the observe nucleus.

Before you run edlock, you must define the current probehead with the
command edhead. Furthermore, you must define the lock nucleus by
setting the parameter LOCNUC. This can be done with eda or by enter-
ing Iocnuc on the command line. In most experiments, the lock nucleus
is deuterium. As such, LOCNUC is set to 2H in most Bruker standard pa-
rameter sets (see rpar).

When edlock is executed for the first time on a certain probehead, a de-
fault lock table, which is delivered with TOPSPIN, is opened.

The table shows the lock nucleus and the current probehead. The sec-
ond line shows the lock frequency, the field value (HO) and the basic
spectrometer frequency. The main part of the lock table shows a list of
solvents and, for each solvent, the lock parameters.

Most lock parameters are used for locking the magnetic field during the
acquisition. Others, however, are used for referencing the spectrum after
the acquisition has finished.

Lock parameters used to lock the magnetic field:

Field-Correction - Difference between the Field value and the refer-
ence Field value. Typically used for Iock -noauto on solvents with
two or more lock signals (see the description of 1ock).

LockPower - Lock power; power used to irradiate the lock nucleus (-
60 to 0 dB)

LoopGain - Loop gain; lock regulator gain (-80 to 0 dB)

LoopTime - Loop time; lock regulator time constant (0.001 - 1.0 sec-
onds)

LoopFilt - Loop filter, lock regulator cut-off frequency of the lowpass fil-
ter (1 - 200 Hz)

LockPhase - Lock phase; the phase of the lock signal

Distance - Chemical shift of the lock nucleus (irradiation frequency off-
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set)
These parameters are interpreted by the commands l1ock and lopo.
Lock parameters used to reference the spectrum:
Ref. - chemical shift of the reference signal (default 0)
Width - width of the region where the reference signal is searched
Ref-Shift - reference shift for default calibration
These parameters are interpreted by the command sref.

The loop gain, loop time and loop filter can also be set with the TOPSPIN
commands l1gain, 1time and 1filter, respectively. Furthermore,

they can also be set from the BSMS keyboard menu. This menu can be
entered by simultaneously pressing the two keys indicated with MENU.

The lock phase can be adjusted from the BSMS keyboard while observ-
ing the lock sweep on the lock display (1ockdisp).

Note the difference between loop gain which can be set in edlock or
with 1gain and lock gain which can be set on the BSMS keyboard.

The AU program loopadj automatically optimizes the lock phase, lock
gain, loop gain, loop filter and loop time. Note that 1oopadj optimizes
these parameters for best long-term stability, but not for best lineshape,
resolution or homogeneity (for more information type edau loopadj and
look at the header of the AU program).

The Lock Power should be about 6 dB below the value where the lock
signal starts to saturate. Saturation can be observed by increasing the
lock power while observing the lock signal. When the signal no longer in-
creases or starts to decrease, it is saturated.

In ICON-NMR automation, the lock parameters are read from the lock table
and used as they are.

For information on how to determine the lock parameters click Help °
Manuals * [Acquisition User Guides] Basic 1D and 2D Experiments. Fur-
thermore, you can refer to the spectrometer hardware documentation
which is available on the BASH CDROM.
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INPUT AND OUTPUT PARAMETERS
see DESCRIPTION above

INPUT FILES
<tshome>/exp/stan/nmr/lists/

2H1ock - 2H lock parameters (input for first ed1ock on current probe)
19F1ock - 19F lock parameters (input for first ed1ock on current
probe)

INPUT AND OUTPUT FILES
<tshome>/conf/instr/<instrum>/

2Hlock - 2H lock parameters
19F1ock - 19F lock parameters

<tshome>/conf/instr/<instrum>/prosol/<probelD>/<solvent>/

bsmspar - solvent and probehead dependent lock parameters

SEE ALSO
lock, lopo, edhead, lockdisp, lgain, Itime, Ifilter
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Igain, Itime, [filter

NAME

Igain - Set the lock regulator loop gain
Itime - Set the lock regulator loop time
Ifilter - Set the lock regulator loop filter

SYNTAX

Igain [<gain>]
Itime [<time>]
Ifilter [<filter>]

DESCRIPTION

The command 1gain allows you to set the loop gain, a lock regulator pa-
rameter. It takes one argument; a loop gain value between -80 and 0 dB.
This value is only used when the lock-in process is done from the BSMS
keyboard; i.e. by pressing Lock On/Off or Autolock. When lock-in is done
with the TOPSPIN command lock, the loop gain is set to the edlock pa-
rameter LGain.

1time and 1filter work like 1gain, except that they set the regulator
parameters loop time and loop filter, respectively.

The AU program l1oopadj automatically optimizes lock gain, lock phase,
loop time, loop gain and loop filter.

The regulator (loop) parameters can also be set from the BSMS key-
board menu. This can be opened by simultaneously pressing the two
keys indicated with MENU.

For information on how to determine the lock parameters click Help ’
Manuals ° [Acquisition User Guides] Basic 1D and 2D Experiments.

Furthermore, you can refer to the spectrometer hardware documentation
which is available on the BASH CDROM.

USAGE IN AU PROGAMS

LTIME(value)
LGAIN(value)
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LFILTER(value)

SEE ALSO
lock, lopo, edlock
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lock

NAME
lock - Lock the magnetic field

SYNTAX
lock [ <solvent> | -acqu | -noauto ]

DESCRIPTION

The command lock performs the lock-in procedure. It takes one argu-
ment and can be used in the following ways:

lock

Opens a dialog box with a list of solvents (see Figure 4.2).

Eﬂ Solvents table

Acetic acetic acid-d4 4_\

Acetone acetone-ds

CEDE henzene-d6

Ch2C2 methylenechlaride-d2

COacH acetonitrile-d3

COECh_SPE LZ-SPE Solvent [Acetonitrile

DI chlarofortn-d _§

CHICH+D20 HPLZ Salvent [Acetonitrill D200

CHIOH+D2O HPLC Salvert (MethanolD2in

D20 deuteriumoxide

DEE diethylether-d10

Dioxane dimcane-ds w

< | @

[ Ok ] [ Cancel

Figure 4.2

When you select a solvent and click OK, it reads the lock parame-



Lock commands

ters for that solvent and performs an autolock accordingly.

Right-click in the table to copy or export the selected entry or to
modify the table properties.

Note that 1ock only shows the Solvents for the current lock nucle-
us (parameter LOCNUC), in this case 2H.

lock <solvent>

Reads the lock parameters for the specified solvent and performs
an autolock accordingly.

lock -acqu

Reads the lock parameters for the solvent defined by the acquisi-
tion parameter SOLVENT and performs a lock or autolock depend-
ing on the ICON-NMR configuration 1.

+ if the flag lock noauto is set, lock is performed
+ if the flag lock noauto is not set, autolock is performed

If the flag lock fieldupdate is set, the BSMSfield value is updated
2 (see also edlock). Note that ICON-NMR executes lock -acqu.

lock -noauto

Reads the lock parameters for the solvent defined by the acquisi-
tion parameter SOLVENT and performs a lock.

lock reads the lock parameters from the lock table which has been set

1. See Configuration Locking/Shimming options
2. Ifit has not been updated during the last 24 hours.
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up with the command edlock. (see table 4.1).

Lock parameters Description BSMS key-
board
Field field (HO) FIELD
LockPower lock power LOCK
POWER
LockPhase lock phase LOCKPHASE
- lock gain LOCK GAIN
LoopGain loop gain Menu @
Looptime loop time Menu @
LoopFilt loop filter Menu @
Distance lock frequency shift LOCK SHIFT
Table 4.1

a. Can be modified by simultaneously pressing the two buttons
indicated with MENU , turn the knob until Lock appear, press the
button 2nd and turn the knob again.

The autolock procedure involves the following steps:

1.

A

6.

Irradiation of the lock nucleus with frequency Lock Freq + Distance.
Acquisition of the lock nucleus FID.

Fourier transform and magnitude calculation of the acquired FID.
Determination of the position of the lock signal in the spectrum.

Adjusting the Field such that the lock signal is exactly on reso-
nance.

Optimization the lock power and lock gain.

Note that the lock irradiation frequency (Lockfieq + Distance) is solvent de-
pendent. The value of Distance is the chemical shift of the lock nucleus in
the current solvent. As such, the irradiation frequency is approximately
on resonance and Iock needs to make only minimum field adjustments
(capture range 1000 units). The advantage of this procedure is that the
signal of the reference substance (e.g. TMS) appears at approximately
the same position for each solvent.
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The command lock -noauto simply reads the lock parameters and
performs a lock-in accordingly. It does not adjust the field (capture range
10 units) and is typically used for samples with multiple lock signals (see
below).

Lock procedure for solvents with multiple lock signals

The Autolock procedure is suitable for solvents with a single lock signal.
For solvents, however, with multiple lock signals, e.g. mixed solvents, Au-
tolock is not recommended because it simply locks on the strongest sig-
nal.

For solvents with multiple lock signals, the following procedure can be
used:

1. Perform Autolock as described above for a reference solvent. For
example, for CDCI3, enter 1ock cDc13. This will set the Field for
this solvent on the BSMS. Lets assume this Field value is 5000.

2. Enter edlock and, in the lock parameter table, click 'w,to
update the Field for each solvent.

3. Insert the sample containing the solvent with multiple lock signals,
e.g. with MeOD.

4. Enter lopo <solvent>, e.g. lopo MeOD to set the lock parame-
ters on the BSMS.

5. Adjust the Field on the BSMS keyboard to put the desired lock sig-
nal exactly on resonance. Lets assume the Field value is 5100.

6. Press the BSMS Lock On/Off key to lock-in.

7. Enter edlock and, in the lock parameter table, enter the differ-
ence between the two Field values, in our case 100, for the used
solvent in the column Field correction. Save the lock parameter
table.

Note that 1ock reads the regulator parameters loop gain, loop time and
loop filter from the lock table. However, these are only used after lock-in
has been performed, i.e. after the 1ock command has finished. During
the lock-in process fixed regulator values are used.

The lock signal can be viewed in the lock display window which can be
opened with the command lockdisp (see the description of this com-
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mand).

The lock-in procedure can also be performed from the BSMS keyboard
by pressing the Autolock or Lock On/Off key. In that case the lock param-
eter values that are currently stored on the BSMS unit are used. These
can be modified from the BSMS keyboard as indicated in table 4.1 or
read from the lock table with the command Iopo. As such,

lopo’ Autolock is equivalent to 1ock
lopo’ Lock On/Off is equivalent to 1ock -noauto

For information on how to determine the lock parameters click Help °
Manuals * [Acquisition User Guides] Basic 1D and 2D Experiments. Fur-
thermore, you can refer to the spectrometer hardware documentation
which is available on the BASH CDROM.

INPUT PARAMETERS

set by the user with eda or by typing solvent etc.:

SOLVENT - sample solvent (input for Lock -acqu and lock -auto)
LOCNUC - lock nucleus

set by the user with edlock:

see table 4.1

INPUT FILES

<dir>/data/<user>/nmr/<name>/<expno>/

acqu - acquisition parameters
<tshome>/conf/instr/

probehead - current probehead as defined with edhead
<tshome>/conf/instr/<instrum>/

2Hlock - lock table for nucleus 2H
19Flock - lock table for nucleus 19F

<tshome>/conf/instr/<instrum>/prosol/<probelD>/<solvent>/
bsmspar - solvent and probehead dependent lock parameters

<tshome>/exp/stan/nmr/lists/
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solvents.fieldupdate - list of solvents for which 1ock -acqu
performs an automatic Field update (set up from ICON-NMR configura-
tion)

solvents.noauto - list of solvents for which Iock -acqu performs
lock -noauto (set up from ICON-NMR configuration)

USAGE IN AU PROGRAMS

LOCK
executes the command lock -acqu.

SEE ALSO
edlock, lopo, lockdisp, lgain, Itime, Ifilter
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NAME
lockdisp - Open the lock display window

DESCRIPTION

The command lockdisp opens the lock display window in which the
lock signal is shown (see Figure 4.3).

=10/
- WSE R J

Figure 4.3

At the top of the lock window the following buttons are available:
v¥ Open the User Preferences window [set]
* Toggle lock monitor mode
= Toggle lock display mode between single and dual color
# Switch grid mode between both, vertical, horizontal and off
L1 Make the lock display external
¢ Put focus into TOPSPIN window

J Close the lock display window



The lock signal is the NMR signal of the lock nucleus which (usually 2H).

The lock display can be used in two different ways:

1. When the field is unlocked.

In this case the lock frequency is swept and lock signal shows a
pattern of wiggles with a maximum intensity at the resonance fre-
quency. This pattern can be used to set the field value and lock
phase. The field value can be adjusted from the BSMS keyboard
until the maximum lock signal lies at the center of the lock display
window. The lock phase can be adjusted until the intensity is about
the same on both sides of the center.

2. When the field is locked.

In this case the lock frequency is kept at the resonance position of
the lock nucleus and is only adjusted in responds to changes in
the magnetic field. The lock signal is a horizontal line in the upper
part of the lock display window. Furthermore, the position of this
line can be used for shimming the magnet. When the homogeneity
of the field improves, the lock signal increases, i.e. the line moves
upward.

SEE ALSO
lock, edlock



Lock commands

lopo
NAME

lopo - Set the lock parameters

DESCRIPTION
The command l1opo shows a list of available solvents (see Figure 4.4).

Eﬂ Solvents table
Acetic acetic acid-d4 L
Acetone acetone-db
CEDE henzene-dg
CO2CI2 methylenechloride-d2
COECH acetonitrile-d3
CDECH_SPE LC-SPE Salvent (Acetanitrile)
COCIE chlaraform-d —
CHICN+D20 HPLZ Salvent (Acetonitril D200
CHIOH+D20 HPLZ Salvent (MethanolDz2o)
D20 deuteriumaxide
DEE diethylethier-d10
Dioxane dioxane-dd hat
< | >
[ Ok ] [ Cancel
Figure 4.4

When you select a solvent and click OK, it sets the lock parameters ac-
cording to the edlock table. As such, the lock power, loop gain, loop
time, loop filter, lock phase and frequency shift are set to the lock table
values of Lockpower, LoopGain, LoopTime, LoopFilt, LockPhase and
Distance, respectively. These values are set on the BSMS unit without
performing lock-in.

Right-click in the table to copy or export the selected entry or to modify
the table properties.
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lopois useful if you want to observe the lock signal first. The lock-in pro-
cedure can then be performed by pressing the Lock On/Off or Autolock
key on the BSMS keyboard. Note that:

lopo’ Autolock is equivalent to Iock -acqu

lopo’ Lock On/Off is equivalent to 1ock -noauto

INPUT PARAMETERS
set by the user with eda or by typing solvent etc.:

SOLVENT - sample solvent
LOCNUC - lock nucleus

set by the user with edlock:

see table 4.1

INPUT FILES
<dir>/data/<user>/nmr/<name>/<expno>/
acqu - acquisition parameters
<tshome>/conf/instr/
probehead - current probehead as defined by edhead
<tshome>/conf/instr/<instrum>/

2Hlock - lock table for nucleus 2H
19Flock - lock table for nucleus 19F

<tshome>/conf/instr/<instrum>/prosol/<probelD>/<solvent>/

bsmspar - solvent and probehead dependent lock parameters

USAGE IN AU PROGRAMS
LOPO

SEE ALSO
lock, edlock, lockdisp, lgain, Itime, Ifilter
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Chapter 5

Shim commands

This chapter describes the commands which are involved in shimming the
magnet. Shimming can be started with reading an appropriate shim set for
the current sample and then optimizing the shim from the BSMS keyboard.
In automation, the optimization is performed by an automatic shimming
procedure. Furthermore, if you are using a gradient probehead, you can
perform gradient shimming.
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autoshim

NAME
autoshim - Autoshim switching

DESCRIPTION

The command autoshim controls the autoshim function of the BSMS
unit. It takes one argument and can be used as follows:

autoshim on
turn autoshimming on

autoshim off
turn autoshimming off

Entering autoshim on the command line has the same effect as press-
ing the AUTOSHIM key on the BSMS keyboard. The shims for which the
step size is set to a value greater than 0 are optimized. It is typically used
in automation.

USAGE IN AU PROGRAMS
AUTOSHIM_ON
AUTOSHIM_OFF

SEE ALSO

tune, edtune, rsh, wsh, vish, delsh
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edtune

NAME
edtune - Edit the tune file

SYNTAX
edtune [<name>]

DESCRIPTION

The command edtune opens a dialog box where you can edit an exist-
ing tune file or create a new one (see Figure 5.1). The tunefiles you see
listed here are delivered with TOPSPIN.

E! Select tunefile E'
=elect one of the available tune files:

ey tune file: | |
Edit probe tunefile ] [ Edit ] [ Execute ] [ Delete ] [ Cancel ]
Figure 5.1
The following buttons are available:
Edit probe tunefile
Edit the probehead specific tune file as it was created with edprosol.
Edit
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Edit the selected tune file. The file will be opened in an editable win-
dow which offers a Save and a Save as button. The latter one allows you
to save the tune file under a different name, i.e. create a new tune file.

Execute
Execute the selected tune file. This will run the command tune.

Delete
Delete the selected tune file.

Cancel
Quit the edtune dialog box.

Tune files are used by the tune command which performs automatic
shimming.

edtune can take one argument and can be used as follows:

edtune <name>
Edits the specified tune file. If the specified file does not exist, an error
message will appear.

The format of a tune file is described for the tune command.

INPUT AND OUTPUT FILES
<tshome>/exp/stan/nmr/lists/group/

example - standard tune file
my tunefile - user defined tune file

<tshome>/conf/instr/<instrum>/prosol/<probelD>/
tunefile - probe dependent tune file (input for edtune * Probe tune-

file)
SEE ALSO

tune, rsh, wsh, vish, delsh, gradshim
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rsh, wsh, vish

NAME

rsh - Read a set of shim values
wsh - Write a set of shim values
vish - View a shim file

SYNTAX
rsh [<name>]
wsh [<name>]

vish [<name>]

DESCRIPTION

The *sh all open the shim dialog box when they are entered without ar-
guments (see Figure 5.2)

[® Read shim values from disk: Select a file or typ... @

sl 2006-03-04 &t 13:46:32 (Thu)
shiml  2006-03-04 & 13:46:13 (Thu)

Filehatne: Options: | date w
[ ey ” Delete H Close l
Figure 5.2

Here, you can enter the shim file and then do one of the following actions.
The following buttons are available:

Read

executes the command rsh, reading the specified shim file. When you
click on a shim set, its values are loaded to the shim unit. rsh can also
be entered on the command line with a shim file as an argument. After
reading a shim file, is usually necessary to optimize the shims, especially
the Z and Z2 shim. You can do that from the BSMS keyboard or from the

A-151



Shim commands

A-152

BSMS display (command bsmsdisp). rsh switches the autoshim func-
tion of the BSMS unit off. If you press the AUTOSHIM key on the BSMS
keyboard or enter autoshim on, the shims will be continuously opti-
mized during the experiment.

Write

executes the command wsh writing the shim values which are currently
installed on the shim unit to the specified shim file. wsh can also be en-
tered on the command line with a shim file as an argument.

View

executes the command vish opening the specified shim file with an ed-
itor. vish can also be entered on the command line with a shim file as
an argument.

command line with a shim file as an argument.
Delete
deletes the selected shim file.

Note that rsh, wsh and vish open the dialog box with the Read, Write
and View button activated, respectively.

If he *sh commands are entered the command line with an argument,
then they may contain wildcards; for example:

rsh a*lists all shim files beginning with «

INPUT FILES

<tshome>/exp/stan/nmr/lists/bsms/

shim files

USAGE IN AU PROGRAMS

RSH(name)
WSH(name)

SEE ALSO

edtune, tune, gradshim
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tune

NAME
tune -Perform automatic shimming of the magnet

SYNTAX
tune [<tunefile> | .sx]

DESCRIPTION

The command tune shims the magnet in an automatic procedure ac-
cording to a shim definition file. This file is called the tune file and can be
set up with the command edtune. The command tune takes one argu-
ment and can be used in one of the following ways:

tune
displays a list of available tune files (see Figure 5.3).

E! Select tunefile f@

of the available tune files:

example

cuickall
tunesll
tunezz2

Execute H Cancel

Figure 5.3

When you select an entry and click the Execute button, the corresponding
tune file is interpreted and auto shimming is performed accordingly.

tune <tunefile>
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Perform auto shimming according to the specified tune file.

tune .sx

Perform auto shimming according to the tune file as it is specified for the
current probehead. This tune file can be setup from the edproso1l dialog
box by clicking File > Edit Tunefile.

A example tune file is delivered with TOPSPIN. You can use this as it is or
modify it to your needs and store it under a different name. The state-
ments you can use in a tune file are listed below. Note that some of these
statements are settings whereas others are commands.

Settings in a tune file:
USE_FIDAREA

Flag indicating to use the area under the FID envelope as a criterion
for field homogeneity.

USE_LOCKLEVEL
Flag indicating to use the lock level as a criterion for field homogeneity.
LOCKDWELL n

The number of measurements used for determining the current lock
level. The measured values are averaged to suppress the effects of
the noise on the lock level. Only used when USE_LOCKLEVEL is de-
fined.

MAXLOCK m

The maximum lock level. Can be used to keep the lock signal from
moving out of the display during the shimming procedure.
The lock level is displayed at the TOPSPIN status line while tune is run-
ning.

DELAY n

The time (in seconds) between adjusting a shim and reading the new
lock level. In the example tune file, DELAY is set to one second which
is usually enough for the lock level to settle.

SET <shim> w c

Set the maximum step size (width) and the convergence limit for the
s1tMPLEX command. These parameters can be set for each shim sep-



arately. An example is:
SETZ1203

TIMES n

END
Loop structure; all statements within the loop will be executed n times.
Nested loops are possible to a depth of five.

Commands in a tune file
ROTATION ON WAIT

Switches the sample rotation on, using the spin rate currently set on
the BSMS unit.

ROTATION OFF WAIT
Switches the sample rotation off.

RSH, RSH <filename>

Reads a shim file. If an argument is specified, RSH will read the cor-
responding shim file. If not, it will read the shim file with the name of
the solvent defined by the acquisition parameter SOLVENT.

Z s 1,22 s i, ..., XY s i
Optimizes single shims. These commands take two arguments:
s = step size; the shim increment used as long as the lock level in-
creases
i = iterations; the maximum number of steps after passing the max-
imum

A shim is first changed s units in one direction. If this increases the lock
level, the shim is changed again s units in the same direction. This is
repeated until a shim change decreases the lock level. Then the direc-
tion of change is reversed and the step size is reduced. This process
is continued until one of the following criteria has been met:

+ the lock level has not changed significantly during the last step
» the maximum number of iterations (i) has been performed
+ the step size has been reduced to one
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Examples of shim commands are:

Z 10 3
Z2 10 3
Z3 10 3

SIMPLEX <shiml shim2 etc.>

Optimizes the specified shims according to the simplex algorithm
which can be used for lock level and FID area shimming. SIMPLEX
uses the step size and convergence limit defined by the SET state-
ment (see above). The simplex algorithm is described in the example
file (see INPUT FILES below).

AUTOSHIM ON <shiml=m, shim2=n, ...>

Switches on the automatic shimming function on the shim unit after
the tune command has finished. This command allows you to adjust
the shims continuously during the entire experiment. Only the shims
that are specified as arguments to the auTosaIM oN command will be
optimized. For each shim, you can specify the step size used for auto
shimming. If you do not specify the step size, the default value of 5 is
used. An example of this command is:

AUTOSHIM ON Z1=2 Z2

Since this command becomes effective after the tune command has
finished, it can be specified anywhere in the tune file.

AUTOSHIM OFF

Switches off automatic shimming on the shim unit. It makes sure that
automatic shimming is switched off when it was switched on before,
either from the last executed tune file or manually from the BSMS key-
board. Note that it would not make sense to use AUTOSHIM ON and
AUTOSHIM OFF within one tune file.

LOCKPHASE s 1

Optimize the lock phase. This command takes two arguments:

s = step size
i = iterations; the maximum number of steps

As an alternative to the automatic shimming with tune, you can optimize
the shims manually from the BSMS keyboard. If the shims are far away
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from the optimum, you can read a standard shim set with the command
rsh and then do manual shimming.

An alternative to the simplex procedure in tune is the AU program sim-
plex.

INPUT FILES
<tshome>/exp/stan/nmr/lists/group/

example - tune file
<tshome>/conf/instr/<instrum>/prosol/<probelD>/

tunefile - tune file for the current probehead (input for tune . sx)

USAGE IN AU PROGRAMS
TUNE((tunefile)
TUNESX
executes the command tune . sx

SEE ALSO
edtune, gradshim, rsh, wsh, vish, delsh
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Chapter 6

Probehead commands

This chapter describes the commands which are involved in probehead
handling. This includes probehead selection, the tuning and matching pro-
cedure and sample insert and eject.
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atma

NAME
atma - Automatic tuning and matching of ATM probeheads

USAGE
atma [exact | course] [high]

Type atma ? for a complete list of options.

DESCRIPTION

The command atma performs tuning and matching of an ATM probe-
head. It will automatically perform the following steps:

1. Stop the sample rotation if it is on.

2. Read the nucleus with the lowest frequency as it was set up with
edasp.

3. Determine the optimum sweep width and number of steps.
4. Tune and match the probehead.

5. Repeat step 3 to 4 for all other nuclei which were set up with
edasp in the order of increasing frequency.

6. Turn on the sample rotation if it was on before atma was started.

The command atma can be used with various options, for example:

atma exact will determine the optimum tuning and matching more
precisely then atma without an argument and will therefore be slower.

atma course will determine the optimum tuning and matching less
precisely then atma without an argument and will therefore be faster.

atma high will start with the nucleus with the highest frequency, and
tune and match the probehead for each nucleus in the order of de-
creasing frequency.

atma storeWobb <x> will automatically save the wobble curve after
optimisation. <x> stands for the respective procno of the used data-
set.

If more than one nucleus should be stored than the respectively next
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wobble curve n+1 will bei stored in the procno number <x+1> (see
also command wbwr).

Type atma ? for a complete list of options.

On ATM probeheads, atma can be used instead of the wobb. These two
commands differ in the following respects:

» atmais fully automatic whereas wobb requires the user to perform
the tuning and matching manually.

* atma automatically determines the optimal sweep width and

number of steps whereas wobb uses the values of WBSW and
WBST, respectively.

* wobb must be terminated with stop or halt whereas atma auto-
matically finishes when optimum tuning and matching is reached.

If you want to interrupt atma, you can do that with the command
kill.

Automatic tuning and matching is not only convenient, it also allows you
to tune and match the probehead during automaton. In ICON-NMR, you
can choose to do that before each experiment, after each sample change
or after each solvent change.

For more information on the tuning and matching process, see wobb.

For more information on the command atma and ATM probeheads, see
Help > Manuals ° [Technical Manuals] Automatic Tuning/Matching.

INPUT PARAMETERS
NUC1 - NUC4 - nuclei as defined with edasp

INPUT FILES
<dir>/data/<user>/nmr/<name>/<expno>/
acqu - acquisition parameters
<tshome>/conf/instr/<instrum>/
nuclei - nuclei table
<tshome>/prog/wobble/

acqu_go4 - wobble parameters
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Pulsprog X - wobble pulse program

SEE ALSO

atmm, wobb, wbwr
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atmm

NAME
atmm - Manual tuning and matching of ATM probeheads

USAGE
atmm [manWbsw]

Type atmm ? for a complete list of options.

DESCRIPTION

The command atmmis a manual tuning and matching procedure for ATM
probeheads. It is not needed very often because ATM probes are de-
signed for automatic tuning and matching with atma. Sometimes, how-
ever, the probeheads resonance frequency is so far away from the
optimum that atma would take very long to finish or would fail. In practice,
this only occurs for certain nuclei at broadband probeheads. In that case,
atmm allows you to manually tune and match the probehead for that nu-
cleus.

atmm performs the following steps:

1. It reads the nucleus with the lowest frequency as it was set up with
edasp.

2. It determines the optimum sweep width and number of steps.

3. It shows the reflected power (tuning/matching curve) in the Top-
SPIN acquisition data field.

4. It opens the atmm control window from where you can:

» Select the nucleus for which you want to tune and match the
probehead. By default, the nucleus with the lowest frequency is
selected.

* Perform course tuning/matching on broadband probeheads.
This is the equivalent of setting the sliders on a non ATM
probehead to predefined numbers.

» Perform fine tuning/matching while observing the curve in the
ToPsPIN acquisition data field. This is the equivalent of turning
the knobs or moving the sliders on a non ATM probehead. See
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wobb for a description on how to reach the optimum tuning and
matching.

» Click File > Quit to finish the tuning/matching process.

if atmm is used with the argument manWbsw, it does not determine the
sweep width and number of steps automatically but interprets the param-
eters WBSW and WBST, respectively. atmm ? will show you a complete
list of arguments.

The difference between atmm and wobb is that:
* atmm can only be used on ATM probeheads.

* atmm, when used without arguments, automatically determines
the optimum sweep width and number of steps whereas wobb
uses the values of WBSW and WBST, respectively.

* atmmallows you to optimize tuning and matching from TOPSPIN
whereas wobb requires you to turn the knobs (or move the sliders)
on the probehead.

For more information on the tuning and matching process, see wobb.
For more information on the command atmm and ATM probeheads, see
Help > Manuals ° [Technical Manuals] Automatic Tuning/Matching.

INPUT PARAMETERS

NUC1 - NUC4 - nuclei as defined with edasp
WBSW - sweep width (only used by atmm Manwbsw)
WBST - number of steps (only used by atmm Manwbsw)

INPUT FILES
<dir>/data/<user>/nmr/<name>/<expno>/
acqu - acquisition parameters
<tshome>/prog/wobble/
acqu_go4 - wobble parameters
Pulsprog X - wobble pulse program

SEE ALSO

atma, wobb
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edhead

NAME

edhead - Edit the probehead table

DESCRIPTION
The command edhead opens the probehead table (see Figure 6.1).

i edhead
Probe

-1o/
|

Current probe: 5 mm TXI 1H-31PS13C Z-GRD 2685178882 [33]

[ B B R I R . [ R I B I - - B |

1H
1H

QHP
QHP
OHP
QHP

SEfE8ERE

Dual 13Cf1H
Dual 19Ff1H

1H/15H/13C/31P
1H/13C/31P /19F
1Hf13C/31Pf19F Z-grad
1H/295i/13C/31P

mn Multinuclear

mm Multinuclear inverse

mm Multinuclear inverse Z-grad

mm TXT

Define as current probe

J31P Z-grad

Edit Probe Parameters

Exit |

[o1] =
[02]
[03]
[04]
[05] —
[06]
[07]
[0&]
[09]
[10]
[11]

[12] =i

Figure 6.1

Each entry in this table contains a probehead name and reference

number. A typical entry is:
5 mm Dual 13C/1H

[03]
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The entry which is defined as the current probehead, is highlighted.

The probehead table has a menu Options in the upper left corner that of-
fers the following commands:

Enter New Probe

The probehead parameter editor will be opened where you can define
a new probehead. You can do that by setting the probehead parame-
ters (see below). The name of the new probe will be the combination:

Sample diameter Probe Type Coil Nuclei Part number Serial number

Note that the Part number and Serial Number are only part of newly de-
fined probes, not of the probes in the standard list delivered with Top-
SPIN. The reference number of a new probe will be the first unused

number available. This usually the number of the last entry plus one 1.

Rename Probe
The current probehead will be renamed.
Copy Probe

The current probehead will be copied to a new probehead with the
same name. The new probe is added at the end of the list. The refer-
ence number will be the first unused number available. This usually
the number of the last entry plus one 1,

Delete Probe

The current probehead will be deleted. Its reference number will be
unused until a new probehead is defined.

Define as Current Probe

The highlighted entry will be defined as current probehead. If no entry
is highlighted, an error message will appear. If the highlighted probe-
head has not been defined before, you will be prompted you with the
question:

Do you want to create the probe parameterset?

If you click No, no probehead parameters will be stored but the high-
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lighted entry will still be defined as current probehead. If you click Yes,
the probehead parameter editor will be opened (see below).

Edit Probe parameters

When you click this button, a dialog box with various probehead pa-
rameters will appear (see below).

Exit
Close the probehead table, saving all changes.

The menu entries Define as current probe, Edit probe parameters and Exit
are also available as buttons at the bottom of the edhead dialog box.

The probehead parameter editor displays four groups of parameters:
Production parameters like:

Probe type
Part number
Serial number

Sample parameters like:

Sample diameter
Sample depth

Temperature parameters like:

Type of sensor
Lowest allowed temperature
Highest allowed temperature

Coils parameters like:

Number of coils
Gas compensation
Inside coil nuclei
Outside coil nuclei

History:
A text field where any information about the probe can be entered

Some probeheads have an additional parameter group, e.g.:
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Broadband probes: Tuning and Matching parameters
Flow probes: Probe flow parameters

Note the probe parameters are just information for the user. They are not
required for the acquisition and they are not interpreted by any ToPsPIN
command.

The current probehead as defined with edhead, is interpreted by the
commands edprosol, edlock, lock, lopo and setpre as well as
during ICON-NMR automation. At the end of an acquisition the current
probehead is stored as the acquisition status parameter PROBHD (see
dpa).

By exiting edhead it displays a new window where the preamplifier probe
connection can be defined (see Figure 6.2). This is used vor power check

;V Edit Spectrometer Parameter

Preamplifier Probe

1H LNA 1 BB 1 Inner Coil
XBB19F 2HS BB \ 2 Inner Coil

HPHP 19F/1H 1H 3 Inner Coil

2H

HPHP XEB3 1P
136
15N

Save Clear cable connections ‘ Info H Param Close ‘,

Figure 6.2

to find out the correct peak power limit of the probe.

INPUT FILES
<tshome>/exp/stan/nmr/lists/

probeheads.all - default probehead list (input of first time edhead)

<tshome>/prog/tcl/xwish3_scripts
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edhead - Tcl/Tk script that is started by edhead

INPUT AND OUTPUT FILES
<tshome>/exp/stan/nmr/lists/

probeheads - probehead list (input of 2"d and later edhead and out-
put)
<tshome>/conf/instr/
probehead - current probeheads name and reference number
<tshome>/conf/instr/probeheads

<part #> <serial #> <reference #>.par - probe parameters

SEE ALSO

cf, atma, atmm, wobb
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ej, ij

NAME

ej - Eject the sample from the magnet
ij - Insert the sample into the magnet

DESCRIPTION

The command ej ejects the sample from the magnet. It switches on the
air flow and keeps it on until it is explicitly switched off, for example with

ij.

The command i j inserts the sample into the magnet. This command is
used when the magnet air flow is on and the sample is floating on top of
it. i j gradually reduces the air flow to zero so that the sample is lowered
into the magnet.

As an alternative to the command ej and i j, you can also press the LIFT
ON/OFF button on the BSMS keyboard.

The SAMPLE DOWN indicator in the shimming panel of the BSMS key-
board is lit when the sample is positioned correctly in the probe. The
SAMPLE UP indicator is lit when the sample has reached the top of the
magnet. The SAMPLE MISSING indicator is lit if the sample is somehow
positioned between the magnet top and the probehead, either moving up
or down or being stuck. The latter can happen, for instance, when the air
flow is too high.

USAGE IN AUTOMATION

EJ
IJ

SEE ALSO

10
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ro

NAME
ro - Switch the sample rotation on or off

SYNTAX
ro [ acqu | on | off | off wait ]

DESCRIPTION

The command ro switches the sample rotation on or off. When entered
without arguments, it opens a dialog box (see Figure 6.3)

(4 ro (%]

Start or stop rotation of zample

Rotation frequency of sample [Hz]: | 20

Zet value H Ztart rotation H Stop rotation H Cancel

Figure 6.3

Here, you can set the rotation frequency and start/stop the rotation.
ro takes up to two parameters and an be used as follows:

ro on
Switches the sample rotation on with the spin rate currently set on the
BSMS keyboard (visible when you press the SPIN RATE key).

ro acqu

Sets the spin rate to the value of the acquisition parameter RO, then
switches rotation on and waits for 60 seconds. If spin rate has not
been reached within that time, an error message appears.

ro off
Switches the sample rotation off.

ro off wait
Switches the sample rotation off and waits until the rotation has
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reached zero. During the waiting time the BSMS unit cannot be ac-
cessed by other commands.

ro <value>
Sets the acquisition parameter RO to <value>.

As an alternative to the command ro, you can press the SPIN ON/OFF,
and SPIN RATE keys on the BSMS keyboard or BSMS display (com-
mand bsmsdisp)

INPUT PARAMETERS
RO - sample rotation frequency (input for ro acqu)

INPUT FILES
<dir>/data/<user>/nmr/<name>/<expno>/

acqu - acquisition parameters

USAGE IN AU PROGRAMS

ROT
executes the command ro acqu.

ROTOFF
executes the command ro off wait.

SEE ALSO
ij, €
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NAME
wbwr - save wobble curve to disk

DESCRIPTION

The command wbwr saves the wobble curve to disk. Please note that the
command is only valid in the wobble mode(first enter command wobble).

When typing wbwr in the command line a the user is prompted to enter
a PROCNO which will later on be used to store the wobble curve in the
appearing dialogue:

[ save wobb curve E|

Flease specify the procno where you
want to save the wobhb curve.

Procno: | G

| ok || cancel

Figure 6.4

As an alternative to wbwr entered in the command line the
button can be clicked in the TOPSPIN toolbar.

The wobble curve is stored as processed data (1r) and not as raw data
(fid.). This provides the additional option of using standard processing
tools lieke e. g. multiple display.

In addition wbwzr can directly be entered together with an additional pa-
rameter denoting the PROCNO that shuld be used, i.e. "wbwr 4".

OUTPUT FILES

<dir>/data/<user>/nmr/<name>/<expno>/<procno>/
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1r - the wobble curve
procs - processing status bar

SEE ALSO
wobble

A-174



Probehead commands

wobb

NAME
wobb - Manual tuning and matching of the probehead

USAGE
wobb [high][ext50][raw][f1]f2]

DESCRIPTITION

The command wobb allows you to manually tune and match the probe-
head. It opens the wobble window showing the wobble curve (see Figure

6.5) .
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Figure 6.5

The buttons have the following functions:

" Change the number of wobble steps [wbst]

£+ Change the wobble sweep width [wbsw]
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5 Change the wobble frequency

i

Switch to the next channel/nucleus (if available)
gy Stop the wobble procedure

Turn the tuning and matching knobs on the probehead until the wobble
curve is exactly in the middle and its minimum reaches the zero line (see
Figure 6.6).

An NMR probehead must be tuned and matched because it is a reso-
nance circuit. If its resonance frequency and impedance are the same as
the transmitter frequency and impedance, respectively, the full transmit-
ter power is transferred to the probehead. However, if either or both are
different, part of the transmitter power is reflected by the probehead. This
results in a longer 90° pulse or, for a given pulse length, a smaller flip an-
gle. Note that a multi nuclear probehead has a resonance circuit for each
nucleus and each nucleus must be tuned and matched separately.
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Figure 6.6

The command wobb is normally used without argument. It can, however,
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be used with arguments. For example:

wobb high
starts with the nucleus with the highest frequency and continues in the
order of decreasing frequency.

wobb ext50
uses an external 50 ohm resistor as a reference.

wobb £1
starts with frequency channel 1. It continues with the next higher fre-
quency or, if the argument high s also used, with the next lower frequen-

cy.
wobb f2

starts with frequency channel f2. It continues with the next higher fre-
quency or, if the argument high s also used, with the next lower frequen-
cy.

The wobb command allows you to optimize both the probeheads reso-
nance frequency (tuning) and impedance (matching). It sends a low pow-
er RF signal to the probe and sweeps that signal over a certain frequency
range. The number of steps (frequencies) within that range is defined by
the acquisition parameter WBST. The width of the frequency range is de-
fined by WBSW. The center frequency depends on the nucleus; SFO1 for
NUC1, SFO2 for NUC2 etc. The deviation of the probe impedance from
the nominal 50 ohm is shown as function of the frequency in the TOPSPIN
data field. This is the so called wobble curve. At the probeheads reso-
nance frequency, the curve shows a dip, the minimum reflected power.
Tuning the probehead means adjusting its resonance frequency until it
reaches SFO1. Matching the probehead means adjusting its impedance
until the reflected power reaches zero.

The entire wobble procedure involves the following steps:

1. Stop the sample rotation if this is on, for example with ro off£, or
by pressing the SPIN ON/OFF button on the BSMS keyboard.

2. Setup the nucleus or nuclei for the current experiment with edasp.
This will automatically set the parameters SFO1, SFO2 etc.

3. Click Acquire * Observe fid window or enter acqu to switch to the
TOPSPIN acquisition menu. If, however, tuning and matching is
observed on the preamplifier, this step can be skipped (see
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below).

. Enter wobb. The wobble curve will appear in the TOPSPIN data field

showing a dip at a certain frequency. At the center of the data
field, you will see a vertical line. If you do not see the dip, it proba-
bly lies outside of the data field. In that case, you should click the
&~ button or enter wbchan to increase the sweep width. You can
do this while wobb is running.

. When the dip is visible, you can start tuning and matching as fol-

lows:

» turn the tuning knob until the dip lies across the vertical
line

+ turn the matching knob until the dip has reached a mini-
mum. Matching influences tuning, so the dip probably
moves away from the center.

* turn the tuning knob until the dip lies at the center again.
Tuning influences matching, so the dip probably moves
up again.

* turn the matching knob until the dip reaches a minimum
again

» continue this process until the dip lies exactly across the
vertical line and reaches the x-axis.

. In case of a multi nuclei experiment, you have to switch to the next

the nucleus. Note that wobb automatically starts with the nucleus
with the lowest basic frequency. You can switch to the nucleus
with the next higher frequency in two possible ways:

* press Channel Select at the HPPR. This will automatically
select the nucleus with the next higher frequency.

« click 57 or enter wbchan in TOPSPIN. Answer the ques-
tion "Do you want to change the nucleus" with yes.

Repeat step 5 for the current nucleus.

. If your experiment involves more than two nuclei, repeat step 6 for

each further nucleus.

8. Click & or enter stop on the command line to finish the wobble
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procedure.

A probehead has a tuning knob (labelled T) and matching knob (labelled
M) for each resonance circuit. Most probeheads have two, one for 1H
and one for X-nuclei. When the tuning knob reaches the end of its range
before the probehead is properly tuned, you should turn it to the middle
of its range, adjust matching, then tuning, then matching etc. A similar
procedure can be used if the matching knob reaches the end of its range.

The process of tuning and matching can also be followed on the HPPR
preamplifier. Some people find that more convenient and it is necessary
when the computer screen is not visible from the position of the probe-
head. The horizontal row of LED’s indicates tuning, the vertical row indi-
cates matching. When you turn the tuning or matching knob at the
probehead, you will see how the number of lit LED’s changes. The probe-
head is perfectly tuned when only one LED (a green one) is lit. The same
holds for matching. In practice, proper tuning and matching means that
only green LED’s are lit. If the LED update seems to be very slow, this
might be caused by the time consuming update of the wobble curve in
the TOPSPIN acquisition display. In that case, you can simply click | to
close the wobble window.

Broadband probeheads usually have sliders for tuning and matching
rather than turning knobs. These have the advantage that their positions
are numbered. The default slider positions for each nucleus are usually
written on cards that are kept with the probehead. When wobbling is
started with these default values, only some fine tuning and matching is
required.

The probehead resonance frequency and impedance is dependent on
the sample. This can be a problem in automation, where several samples
are measured but the probehead is only matched and tuned on one of
them. Bruker ATM probeheads support automatic tuning and matching
which can be preformed on every sample during automation (see de-
scription of the commands atmm and atma).

INPUT PARAMETERS
set by the user with eda or by typing wbst, wbsw etc.:

WBST - number of wobble steps
WBSW - wobble sweep width
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set by the user with edasp or eda > NUC1:

NUC1 - NUC4 - the nuclei for which the probehead is tuned and
matched
SFO1 - SFO4 - irradiation frequency

INPUT FILES
<dir>/data/<user>/nmr/<name>/<expno>/
acqu - acquisition parameters
<tshome>/prog/wobble/

acqu_go4 - wobble parameters
Pulsprog X - wobble pulse program

SEE ALSO

atma, atmm, edasp
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Chapter 7

Parameter handling
commands

This chapter describes commands which are involved in parameter han-
dling. This involves the setting of acquisition parameters, probehead/sol-
vent dependent parameters and nuclei assignment. Furthermore, the
usage of predefined parameters sets is discussed.
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ased

NAME
ased - Edit acquisition parameters used in pulse program

DESCRIPTION

The command ased opens a dialog box with the acquisition parameters
which are used for the current experiment (see Figure 7.1).

1 exam1d_13C 1 1 C:BrukerTOPSPIN\data'guestinmr

Spectrum | ProcPars| AcquPars | Title | PulseProg | Peaks | Integrals | Sample | Structure | Fid

v |Lis| i3 ¥ & Instzlled probe: 5 mm Dual 13C/1H 1234/5678
Experiment ¥ Experiment
Wyidth ——
S PULPROG 70pga0 [ .|l E | current puise program
NuCleus AQ_mod DaD - Acquisition mode
Durations TD 65536 Size of fid
Power NS 1024 Mumber of scans
Program DS 4 Number af dummy scans
hiohe TDO 1 L t for 'tad’
il oop count far
Wokhle ¥ idth
Lock SV [pm] 236 6369 Spectral width
PUEITERER SWH [H] 29761 904 Spectral width
Miscellaneous
Uil AQ [3] 1.1010548 Acquisition time
s FIDRES [Hz] 0464131 Fid resalution

Fy¥ [Hz] 525000.00 Filter width

Figure 7.1

This means that ased shows much less parameters then eda which
shows all acquisition parameters. Entering ased on the command line is
equivalent to clicking the AcquPars tab and then clicking the J1 button.

The following buttons are available:

v Undo the last modification (unused for status parameters)
* Force parse of the pulse program
& Switch to all acquisition parameters

B Set probehead/solvent dependant parameters
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Open the nuclei and routing table

g4 Search for the parameter specified in the search field

ased compiles and interprets the pulse program defined by PULPROG.
For pulses, delays and constants, the parameter description in the right
column of the ased window is taken from the comment section at the end
of the pulse program.

INPUT AND OUTPUT PARAMETERS
for all experiments:

PULPROG - pulse program used for the acquisition
TD - time domain; number of raw data points

NS - number of scans

DS - number of dummy scans

SWH - spectral width in Hz

AQ - acquisition time in seconds

RG - receiver gain

DW - dwell time

DE - pre-scan delay

for each frequency channel defined with edasp:

NUCX - nucleus for channel x
SFOx - irradiation frequency for channel x

all delays, pulse lengths, power levels etc. defined in the pulse program,
e.g.:

D[1] - relaxation delay

P[1] - 90° pulse length

PL[1] - power level for pulse

PCPDI[1] - CPD pulse length

INPUT FILES
<tshome>/exp/stan/nmr/lists/pp/

the pulse program defined by PULPROG

<dir>/data/<user>/nmr/<name>/<expno>/
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acqu - acquisition parameters

OUTPUT FILES
<dir>/data/<user>/nmr/<name>/<expno>/

acqu - acquisition parameters

SEE ALSO
eda, edcpul
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dpa

NAME
dpa - Display the acquisition status parameters

DESCRIPTION

The command dpa displays the acquisition status parameters (see Fig-
ure 7.2).

exam1d_13C 1 1 C:Bio guest [Z”E”s__q

Spectrum F'rn:n::F'ars| AcouPars |T'rt|e PulzeProg | Peaks | Integrals | Sample | Structure || Fid |>|

S
¥ Experiment =
DATE = March 30, 2004 10:43:33 &AM BST Acojuizition dat 1
PULPROG = Zopg S0 | E] current pulse ¢

A _mod = DD Acquizitian ma
D = ES536 Size of fid

MS = 256 Mumber of scal
0s = 4 Mumber af dum
TDO = 1 Loop court for
PARMODE = 10 Dimension of rz

MC = | -1 Mortnalization o

¥ \Widdth

W [ppm] = | 238.2980 Spectral wicth
< »

Figure 7.2

These are set by acquisition commands and represent the status of the
raw data. Entering dpa on the command line is equivalent to clicking the
AcquPars tab and then clicking the s button.

The following buttons are available:

v Undo the last modification (unused for status parameters)
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I'L Undo the last modification (unused for status parameters)
5 Switch to acquisition parameters

B Set probehead/solvent dependant parameters

Open the nuclei and routing table

@4 Search for the parameter specified in the search field

Acquisition status parameters can also be viewed by entering their
names on the command line. For example:

s ns
displays the acquisition status parameter NS

s td
displays the acquisition status parameter TD

On multidimensional data, the parameter values for each direction are
shown.

INPUT FILES
<dir>/data/<user>/<name>/nmr/<expno>/
acqus - acquisition status parameters

On 2D and 3D data the files acqu2s and acqu3s are used for the indi-
rect directions, respectively (see also chapter 2.3).

SEE ALSO
eda, dpp
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eda

NAME
eda - Edit acquisition parameters

DESCRIPTION

The command eda opens a dialog box in which you can set all acquisi-
tion parameters (see Figure 7.3).

examid_1H 1 1 C:ibio guest

Spectrum F'ru:u:F'arsl AcouPars | Title | PulzePrag || Peaks | Integrals | Sample | Structure | Fid | Acqu
oS W E Y8
- v ~
—| ¥ Expetiment =
PULPROG = s | |E]E] Current pulze pr
A pmod = Drizalr b Acquisition mode
TC = F:5556 Size of fid
MS = 16 Mumber of scan:
DE = 4 Murnber of durmrr
TDO = 1 Loop count for 't
¥ Wicth
S [ppmm] = | 12.01E0 Spectral width -+
vl ¢ >
Figure 7.3

Entering eda on the command line is equivalent to clicking AcquPars in
the tab bar of the data window.

The following buttons are available:
«7 Undo the last modification. Can be used repeatedly.

I1 Undo the last modification.

5 Switch to acquisition status parameters.
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B Set probehead/solvent dependant parameters.
= Open the nuclei and routing table.

12 Change raw dataset dimensionality (parameter PARMODE).

v Collapse/expand all parameter sections.

@4 Search for the parameter specified in the search field.

Inside the parameter editor, you can do the following actions:

+ click an acquisition step, e.g Experiment at the left of the dialog
box. The step becomes highlighted and the corresponding param-
eters will appear in the right part of the dialog box.

» click in a parameter field, e.g. TD to set the parameter value. It is
automatically stored.

 hit the Tab key to jump to the next parameter field
* hit Shift-Tab to jump to the previous parameter field

» use the scroll bar at the right of the dialog box to move to parame-
ters further up or down in the dialog box.

Note that the ... and E button to the right of the PULPROG parameter al-
low you to show the pulse program list or edit the current pulse program,
respectively.

Parameters can also be set by entering there names on the command
line. A dialog window will appear where you can enter the parameter val-
ue(s). For example:

td
on a 1D dataset.

Size of fid

D =

[ ik H Cancel




or on a 2D dataset:

Size of fid (F2, F1)

D = 1024 128

[ Qi ][ Cancel ]

Alternatively, you can specify the parameter value as an argument on
the command line, For example;

td 8k
The time domain will be set to 8k.

INPUT AND OUTPUT PARAMETERS
All acquisition parameters.

INPUT FILES
<tshome>/classes/prop/

pared.prop - parameter properties file
<tshome>/exp/stan/nmr/form/

acqu.e - format file for eda

INPUT AND OUTPUT FILES
<dir>/data/<user>/<name>/nmr/<expno>/

acqu - acquisition parameters for the acquisition (direct) direction
acqu? - acquisition parameters for F1 (2D) or F2 (3D) indirect direc-
tion

acqu3 - acquisition parameters for the F1 direction (3D)

SEE ALSO
edp, dpa
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edasp

NAME

edasp - Set up nuclei and spectrometer routing

DESCRIPTION

The command edasp allows you to set up the nuclei and the spectrom-
eter routing for the current experiment. It opens the routing table showing
the current nuclei selection and amplifier routing. Here you can specify
the nucleus or nuclei to be used for the experiment. For the f1 logical fre-
quency channel, you can click the NUC1 button and select a nucleus
from the appearing list. The basic frequency, BF1, is automatically set.
Then you can specify the frequency offset; OFSH1 for 1H or OFSX1 for
X nuclei. The irradiation frequency SFO1 is automatically calculated as
the sum of the basic frequency and frequency offset. Note that the pa-
rameters NUC1, BF1 and SFO1 also appear in eda but cannot be set
from there. However, the frequency offset (OFSH1 or OFSX1) appears
in eda as O1 and can be set from there. In a multi nuclear experiment,
you can set up the parameters for channel 2, f3 etc. in the same way as
described for f1.

The routing table also shows the spectrometer routing. The hardware el-
ements which have been detected when the spectrometer was config-
ured (with e£) will appear in this list. When you select a nucleus for a
certain channel, the default routing is automatically set. Normally, this
can be left as itis. Only in very special cases it is useful to change it. The
routing table consists of the following stages:

Channel---FCU---Amplifier---Swibox/I ---Swibox/O---Preamplifier

You can set up the routing by connecting an element from one stage to

an element of the next stage. A connection can be installed or removed

by clicking the two elements involved. The routing must follow the follow-
ing rules:

a) Between the logical frequency channels and FCU’s any combina-
tion is allowed but only one to one.

b) An FCU can be connected to one amplifier only but an amplifier
can be connected to multiple FCU’s. Furthermore, FCU1 can only
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be connected to the first three amplifiers and FCU2 can only be
connected to the first four amplifiers.

c) The first four Amplifiers are automatically connected to Switchbox
input in a fixed way. These connections cannot be changed.

d) Between the Switchbox input and Switchbox output, any connec-
tion is allowed but only one to one.

e) Between the Switchbox output and the Preamplifier modules, any
connection is allowed but only one to one. Make sure that the
cables are connected accordingly.

f) The output of the fifth and sixth amplifier must be connected
directly to the Preamplifier modules. Any combination is allowed
but only one to one and only to Preamplifier modules which are
not connected to a Switchbox output.

Avance spectrometers which are used for solid state experiments usually
contain high power amplifiers with two output stages:

» alow power output: typically 150 W for 1H or 300 W for X nuclei.
» a high power output: typically 1000 W for 1H or X nuclei

The second output appears as an extra stage in the routing table to the

right of the switchbox. If you use the second output stage, the switchbox
is always bypassed.

If you make a routing connection which is not allowed, you will get a mes-
sage that it is illegal. You must remove it before you can save the routing

table. Some connections are allowed but not recommended. In that case,

you only get a warning.

At the bottom of the routing table you will find the following buttons:

SAVE - save the routing table and quit

SWITCH F1/F2 - exchange the F1 and F2 nucleus including the fre-
quency and frequency offset

SWITCH F1/F3 - exchange the F1 and F3 nucleus including the fre-
quency and frequency offset

DEFAULT - set the default amplifier routing for the current nuclei
CANCEL - quit without saving any changes

PARAM - shows the routing parameters

In a 2D dataset, NUC1 has a different function in the two directions. In
F2, it works like in 1D experiments; it opens the routing table. In F1, it
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opens the nuclei list and allows you to select the nucleus for this direc-
tion. The same principle holds for 3D data; in F3, NUC1 opens the routing
table, in F2 and F1 it opens the nuclei list.

The spectrometer routing is stored under the current dataset in the acqui-
sition parameters FCUCHAN, RSEL, SWIBOX, PRECHAN and HPMOD
(see the description of these parameters). These can be viewed by click-
ing the PARAM button in the routing table. Note that these parameters
appear in eda and can be set from there. This, however is not very com-
mon as setting them from the routing table is much more convenient. In
Bruker parameter sets (see rpar), the routing parameters have been set
according to the configured hardware. This corresponds to the routing
that will be set by clicking the default button in the routing table.

The connections between the Switchbox output and the Preamplifier
modules are fixed; they cannot be changed. However, if you start edasp
with the argument setpreamp, you can change these connections or re-
move them all by clicking Clear preamplifier connections. If you make any
changes here, you must make sure that the cables at the spectrometer
are connected accordingly. The command edasp setpreamp is implic-
itly called as a part of spectrometer configuration (command cf).

INPUT AND OUTPUT PARAMETERS

set graphically from edasp by connecting routing elements:

FCUCHAN - logical frequency channel - FCU connections

RSEL - FCU - amplifier connections

SWIBOX - Switchbox input - Switchbox output connections
PRECHAN - Switchbox output - Preamplifier module connections
HPMOD - high power amplifier - Preamplifier module connections

INPUT AND OUTPUT FILES

<dir>/data/<user>/<name>/nmr/<expno>/
acqu - acquisition parameters

<tshome>/conf/instr/<INSTRUM>/
specpar - routing parameters

SEE ALSO

edsp, eda, cf, expinstall



Parameter handling commands

getprosol

NAME
getprosol - Get probehead and solvent dependent parameters

DESCRIPTION

The command getprosol reads the probehead and solvent dependent
parameters (the prosol parameters) and copies them to the correspond-
ing acquisition parameters. Entering getprosol on the command line is
equivalent to clicking the AcquPars tab and then clicking the ] button.
The relations between the prosol and acquisition parameters are shown
in table 7.1. These are the default relations which apply to most standard
high resolution experiments. Protein, DNA/RNA and LC-NMR experi-
ments require different relations which are defined in the files, triple,
triple na and lcnmr, respectively (see INPUT FILES). To use rela-
tions other then default, the so called relations file must be specified in
the pulse program. You can do that by editing the pulse program (with
edpul or edcpul) and adding the line:

prosol relations=<filename>

before the actual pulse sequence. To look at an example, you can enter
edpul 1c2or edpul zgesgp. Note that the file default, for default re-
lations can, but does not need to be specified in the pulse program.
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Description edprosol eda
F1 90° hard pulse length  P90[F1] P[0], P[1]
F1 180° hard pulse length  P90[F1]*2 P[2]
F2 90 ° hard pulse length  P90[F2] P[3]
F2 180° hard pulse length  P9O[F2]*2 P[4]
F1 Tocsy spin lock 60° pulse length PTOC[F1]*0.66 P[5]
F1 Tocsy spin lock 90° pulse length PTOC[F1] P[6]
F1 Tocsy spin lock 180° pulse length PTOC[F1]*2 P[7]
F1 Roesy spin lock pulse length PROE[F1] P[15]
Gradient 1 pulse length  P_gradl P[16]
F1 Tocsy trim pulse length  P_mlev P[17]
Gradient 2 pulse length  P_grad2 P[19]
F3 90° hard pulse length  P90[F3] P[21]
F3 90° hard pulse length  P90[F3]*2 P[22]
F1 HSQC trim pulse length P_hsqc P[28]
F2 Roesy spin lock pulse length PROE[F2] P[31]
F1 90° hard pulse power level PL90[F1] PL[1]
F2 90° hard pulse power level PL90[F2] PL[2]
F3 90° hard pulse power level PL90[F3] PL[3]
F1 Tocsy spin lock power level PLTOC[F1] PL[10]
F1 Roesy spin lock power level PLROE[F1] PL[11]
F2 CPD power level PLCPDP[F2] PL[12]
F2 Second CPD (bilev) power level PLCPD2[F2] PL[13]
F3 CPD power level PLCPDP[F3] PL[16]
F2 Homodecoupling power level PLHDI[F2] PL[24]
Gradient recovery delay D_grad D[16]
F2 CPD pulse length PCPDP[F2] PCPD[2]
F2 CPD pulse length PCPDP[F3] PCPDJ[3]

Table 7.1 Default relations between prosol and acquisition parameters
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INPUT AND OUTPUT PARAMETERS
see table 7.1

INPUT FILES
<tshome>/conf/instr/<instrum>/prosol/relations

default - relations file for most experiments
triple - relations file for Protein experiments
triple na - relations file for DNA experiments
lcnmr - relations file for LC-NMR

<tshome>/conf/instr/<instrum>/prosol/<probelD>/<solvent>

nucleus.channel.amplifier - prosol parameters

OUTPUT FILES
<dir>/data/<user>/nmr/<name>/<expno>/
acqu - acquisition parameters
relations - copy of the input relations file

SEE ALSO

edprosol, eda
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Chapter 8

Pulse and AU program
commands

This chapter describes commands for the setup of pulse programs, gradi-
ent programs, CPD programs etc. Furthermore, it describes the setup of
various lists which can be used in acquisition like variable pulse or variable
delay lists.
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edcpul

NAME
edcpul - Edit the current pulse program

SYNTAX
edcpul [<name>]

DESCRIPTION

The command edcpul opens the TOPSPIN editor showing the current
pulse program (see Figure 8.1). The current pulse program is defined as
the pulse program of the foreground dataset as defined by the acquisition
parameter PULPROG.

%] zape30 (Bruker)

Eile Edit Search

Graphical Edit

sEogpoEi

savance-wersion (023/04717)

;1D sedquence with power-gated decoupling
susing 30 degree flip angle

;FCLARS=HighPRes
;¥DIM=1D
;#TYPE= b

W0 -1 om0
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Figure 8.1

Bruker pulse programs are opened in view mode which means they can-
not be modified. The dialog File menu offers you the following functions:
* Open
this will open the edpul dialog where you can open any available
pulse program.
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e Saveas...

allows you to save the pulse program under a different name
s Print

this will print the pulse program

User defined pulse programs are opened in editr mode and can be mod-
ified. The dialog File menu offers you the following extra functions:

e New

allows you to open a new pulse program.
¢ Save

allows you to save the pulse program under the same name

Besides the File menu, the dialog offers the edit and search menu with
common edit/search functions.

INPUT PARAMETERS
to be set with eda or by typing pulprog:
PULPROG - the current pulse program (input of edcpul)
INPUT FILES
<tshome>/exp/stan/nmr/lists/pp
Bruker and user defined pulse programs
<dir>/data/<user>/nmr/<name>/<expno>/
acqu - acquisition parameters
OUTPUT FILES
<dir>/data/<user>/nmr/<name>/<expno>/
acqu - acquisition parameters (output of edcpul <name>)

SEE ALSO
edpul, edcpd, edgp
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edgp

NAME
edgp - Edit gradient programs

SYNTAX
edgp [<name>]

DESCRIPTION

The command edgp allows you to list, create or edit gradient programs.
If you enter edgp without arguments, a list of all gradient programs is dis-
played (see Figure 8.2).

E_!Eradient program list ﬂ
File Options
FE2, GRADRECSm RECT A SIME. 100

=IME. 32 SIME. S0 Ipdate.info
Eclit | Delete | 8 | Cancel |
Figure 8.2

This shows a list of all Bruker and/or User gradient programs and allows
you to edit or delete them.

To list Bruker gradient programs:
Click Options > Bruker defined

To list User gradient programs:
Click Options ’ User defined

To list all gradient programs:
Click Options > All defined

To edit the selected gradient program:

Double-click the gradient program or select the gradient program and
click Edit. The gradient program will be shown in an editor and can be
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Acquisition commands

This chapter describes all commands involved in data acquisition. This
includes parameter optimization, the actual data acquisition and stopping a
running experiment. Most experiments which involve a single acquisition
are started with the command zg and run until they are finished. Other
experiments involve multiple acquisitions executed with an AU program or
with ICON-NMR.
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aqguide

NAME
aqgguide - Open the Acquisition Guide

DESCRIPTION

The command agguide opens the TOPSPIN Acquisition Guide (see Fig-
ure 8.3). This contains a workflow for acquiring data, especially suited for
new or occasional users. In Automatic mode, the Acquisition Guide will
simply execute a acquisition command when you click the corresponding
button. This requires the acquisition parameters to be set correctly. In in-
teractive mode (4dutomatic mode unchecked), the Acquisition Guide will,
at each step, open a dialog box offering you the available options and re-
quired parameters.

Experienced users normally enter the individual acquisition commands
from the command line. This requires that, for each command, the acqui-
sition parameters are properly set.
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SEE ALSO
prguide, tlguide, solaguide
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bnmr

NAME
bnmr - Acquisition panel for basic and selective experiments

DESCRIPTION

The command bnmr opens an icon box from which you can run basic or
selective 1D and 2D NMR experiments (see Figure 8.4). It is especially
meant for new or occasional users. bnmr can be entered on the com-

mand line or started by clicking Spectrometer * Basic/Selective Experiments.

Basic MMR Experiments

Close | Selective | ™ Tips
Lok Tune Auto
match Shim

Figure 8.4

At the top of the window, you find the buttons:

Close: closes the bnmr window
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Selective: switches to the bnmr window for selective experiments
Tips: allows you to switch on/off the tooltips

The first row of icons (yellow) provide the following functions:

* Lock
Allows you to select the solvent and then performs the auto lock-in
(executes the TOPSPIN command lock).

* Tune/Match
Switches to the acquisition menu and allows you to tune and
match the probehead (executes xau buttonau match which
calls the TOPSPIN command wobb).

*  Auto Shim
Performs shimming according to the tune file defined for the cur-
rent probehead L (executes the TOPSPIN command tune . sx).

The second and third row of icons (blue) provide 1D experiment, with or
without decoupoling.The fourth, fifth and sixth row of icons (green) pro-
vide 2D experiments, with or without gradients.

For a description of the individual experiments, check the Tips button and
hold the cursor over the experiment icon to show the corresponding toop-
tip.

Clicking the button Selective switches the bnmr window to selective ex-
periments (see Figure 8.5)

1. A probehead dependent tune file can be defined from the edprosol dialog box.
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Selective NMRE Expetiments

Close | Basic | i Tips
Lock Tune Auto
Match Shim

Figure 8.5

bnmr is an example of a button panel. You can create your own button
panels with the command bpan (see ToPsPIN Users Guide).

INPUT FOLDERS
<tshome>/exp/stan/nmr/par/

PROTON/* - routine proton experiment
C13CPD/* - routine 13C experiment
C13DEPT90/* - DEPT90 13C experiment
C13DEPT135/* - DEPT135 13C experiment
COSY90SW/* - COSY experiment
NOESYPHSWY/* - NOESY experiment
MLEVPHSW/* - COSY experiment
COSYGPSW/* - gradient COSY experiment
INVBPHSW/* - HMQC experiment

A-206



Acquisition commands

INV4ALPLRNDSW/* - HMBC experiment
INVIETGPSW/* - gradient HMQC experiment
INVAGPLPLRNDSW/* - gradient HMBC experiment

<tshome>/prog/au/bin/
Binary AU programs

buttonau - bnmr AU program
butselau - bnmr AU program for selective experiments
butsel90 - bnmr AU program for calibrating the selective 90° pulse

<tshome>/exp/stan/nmr/au/src/
Source AU programs

buttonau - bnnmr AU program
butselau - bnnmr AU program for selective experiments
butsel90 - bnnmr AU program for calibrating the selective 90° pulse

<tshome>/classes/prop/English/

cmdpanel bnmr.prop - bnmr properties file
cmdpanel bnmrsel.prop - bnmr properties file for selective exper-
iments

SEE ALSO
bpan
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expt

NAME
expt - Display the experiment time

DESCRIPTION

The command expt calculates and displays the experiment time for the
current data set (see Figure 8.6).

[ experiment time x|
experiment titme = Tsac
file size #0 = B4 Khyte

Details .. |

Figure 8.6

If this exceeds the time you have available, you can reduce the number
of scans (parameter NS) until the experiment time is acceptable.

For 2D and 3D experiments, expt also compares the file size of the raw
data with the available disk space.

expt can also be executed by clicking the [ button in the upper tool-
bar.

INPUT PARAMETERS

NS - number of scans
AQ - acquisition time in seconds

SEE ALSO
7g, gs
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go

NAME
go - Perform an acquisition, adding to existing data

DESCRIPTION

The command go starts an acquisition on the current dataset adding to
possibly existing raw data. It works like zg, except that it does not over-
write existing data. If raw data already exist, go will add the new data to
them. This is, for example, useful if the signal to noise of your spectrum
is too low and you want to acquire additional scans. If no data exist, go
has the same result as zg.

If you have stopped an acquisition with halt or stop, you can, in princi-
ple, continue it with go. Note, however, that the acquisition might have
been stopped in the middle of a phase cycle and go starts a new phase
cycle. Therefore, if you want to be able to stop and continue an acquisi-
tion, we recommend to use the commands suspend and resume (see
the description of these commands).

Note that if you enter halt or stop during a 2D or 3D acquisition it might
stop in the middle of a second or third direction increment (see above).
However, this problem only occurs when you use the wr statement to
write the data to disk. If you use the mc statement, the go command con-
tinues a 2D or 3D acquisition at the position where it was stopped. Cau-
tion: if you increment or decrement any pulses, delays or phases within
the acquisition loop, you must do that within one of the mc arguments
F1PH, F1QF etc., for example:

dl mc #1 to 1 F1PH(idO, ipl)

Most acquisitions are started with zg and run until they have finished. As
such, the command go is not used very often. It is, however, used in
some Bruker AU programs like noediff, noemult, deptcycand mul-
ticyec.

Note the difference between the ToPSPIN command go and the pulse pro-
gram statement go (See pulse programming manual).
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INPUT AND OUTPUT PARAMETERS
see zg

INPUT AND OUTPUT FILES
see zg

USAGE IN AU PROGRAMS
GO

SEE ALSO

zg, suspend, resume
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gs

NAME
gs - Interactive parameter optimization during acquisition

DESCRIPTITION

The command gs opens a dialog box that consists of two panels. In the
left panel, you can adjust parameters interactively during an acquisition
(see Figure 8.7). The right panel shows the FID display window where
the fid is continuously updated showing the effect of each parameter
change (see Figure 8.8).

gs repeatedly executes the current pulse program but only up to the first
go=n Or rcyc=n statement. Therefore, gs:

» does not accumulate data
» does not interpret the phase list
» does not write data to disk

The dialog box only shows the parameters which are typically set during
gs like irradiation frequencies and offsets, pulse lengths and power lev-
els. By default, the irradiation frequency Offset is selected for adjustment.
You can adjust the indicated parameter by putting the cursor on the slid-
er, pressing the left mouse button and moving the mouse. Alternatively,
you can click above or below the slider bar. The slider sensitivity can be
changed from the Sensitivity field. The following parameters can be
changed from the gs dialog box:

SFO1 - SFO8 - irradiation frequency for channel f1- f8
O1 - O8 - irradiation frequency offset for channel f1- f8
PL[0-31] - square power levels

AMP[0-31] - amplitude

PHCOR][0-31] - reference phases

PH_ref - receiver phase correction

RG - receiver gain

P[0-31] - pulse lengths

D[0-31] - delays

Frequency, Offset and Square Power appear for each channel that has
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Figure 8.7

been setup with edasp.

Note that moving the RG slider causes an exponential change in the re-
ceiver gain. The effect of changing RG will be shown immediately in the
FID display. For all other parameters in the above list, the effect of a
change will be shown after one or two scans.
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Figure 8.8

The buttons of the FID window have the following functions:
I Show FID in shuffled mode

ki Show FID in unshuffled mode, horizontally arranged
i Show FID in unshuffled mode, vertically arranged
li- Show FID in unshuffled mode, interleaved

ki Switch between FID and spectrum

&y Stop the acquisition [stop]

Clicking the m button to switch to real time FT, turns the button

green and opens two extra buttons:

ki Switch between FID and spectrum.
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W

~¢ Real time FT settings.

S Toggle calculation of peak width at 50%, 5.5% and 1.1%
height

(Shown as status parameters).
The GS dialog box also contains the following buttons:
* Save - save the parameter that was changed last
* Save all - save all changes
* Restore - restore the parameter that was changed last
* Restore all - restore all changes
* Stop - stop the acquisition and leave the gs dialog box

If you click Stop without having saved your changes, gs shows you the
changed parameters and allows you to select the ones to be saved (see
8.9)

E!Eave changed GS parameters |

Select the modified G= parameters to be saved:

V¥ o1 [3092.51 Hz]
¥ P1[10.3 ps]

Select al Select none Cancel

Figure 8.9

INPUT AND OUTPUT PARAMETERS
See the parameter list above.

INPUT AND OUTPUT FILES
<dir>/data/<user>/nmr/<name>/<expno>/

acqu - acquisition parameters

SEE ALSO
zg, 2o, rga
A-214



Acquisition commands

halt

NAME
halt - Halt the acquisition after the current scan

DESCRIPTION

The command halt stops the acquisition after the current scan and
writes the data to disk. It is the regular command to stop a running acqui-
sition. Note that halt does not complete the current phase cycle.

As an alternative to entering halt on the command line, you can click
the m button of the TOPSPIN toolbar or in the acquisition window toolbar.
If, for some reason, a running or hanging acquisition cannot be stopped
with halt, you can try the stop command. If that does not work either,
you can use kill. This command will show all active processes and you
can click the go module to stop the acquisition.

The command halt can even be entered with an optional parameter as
command halt <1...-NS>(please note that <1...-NS> must be inte-
ger and > 0). If <1...-Ns> is defined the execution of halt is delyed until
the total number of scans reaches a multiple of <1...-NS>. This option is
useful if a fid with a complete phase cycle should be stored to disk.

As an alternative to typing halt <1...-NS> in the command line the
button can be used from the TOPSPIN toolbar with this botton:

This button opens the following dialogue:
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[_! Execute halt g|

Please specify the scan number when you want
to halt the acquisition and save the FID to disk.

Scan (NS):

| ok || cancel
Figure 8.10

OUTPUT PARAMETERS
all acquisition parameters

OUTPUT FILES
In a 1D dataset:
<dir>/data/<user>/nmr/<name>/<expno>/

fid - raw data
acqus - acquisition parameters

In a 2D dataset:
<dir>/data/<user>/nmr/<name>/<expno>/

ser - raw data
acqus - F2 acquisition status parameters
acqu2s - F1 acquisition status parameters

In a 3D dataset:
<dir>/data/<user>/nmr/<name>/<expno>/

ser - raw data

acqus - F3 acquisition status parameters
acqu2s - F2 acquisition status parameters
acqu3s - F1 acquisition status parameters

SEE ALSO
stop, zg, go, rga, wobb
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iconnmr

NAME
iconnmr - User interface for automation and routine spectroscopy

DESCRIPTITION

The command iconnmr starts the an icon driven user interface ICON-
NMR for routine spectroscopy and automation (see Figure 8.11).

=10] |

File Help

Figure 8.11

It is fully described the ICON-NMR manual. The online version of this man-
ual can opened by clicking Help ° Manuals ° [Automation and Plotting]
ICON-NMR Automation Interface.
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NAME

ii - Initialize spectrometer interface

DESCRIPTION

The command ii initializes the spectrometer interface. It tries to access
all hardware parts of the spectrometer that are needed for the current ex-
periment and loads the acquisition parameters.

ii must be executed once, when the spectrometer has been switched
off.

INPUT PARAMETERS
all acquisition parameters

USAGE IN AU PROGRAMS
Il

SEE ALSO
zg
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popt

NAME
popt - Open the parameter optimization window

DESCRIPTION

The command popt allows you to optimize acquisition parameters like

pulses and delays (see Figure 8.12).

.exam1d_13c 1 1 C:Bio guest

S[=1E9

|:| stare as 20 data (=ser file)
D The AU program specified in AUNM will be exec... WiDw= En
Ferform autematic bazeline comection (ABSF) FH_muod= no
|:| Cheenwrite existing files (disable confirmation hie... FT_maod= no
|:| Run optimisation in background

OFTIMIZE GROUP PARA... COFTIM... STAR.. EMDAL MEXF WAR... IMC
Step by step | | [POSMax | | | [LIN | |
[ Start opti... ”Skip current u:-pt...][ Show pra... ][ Add para... ” Rastare ” Save
[ Read ama... ][Save array file ][ Stop opti... ][ Lelete pa... ” Help ]

Figure 8.12

Before you start an optimization, you must run one acquisition with the
acquisition parameters as they are (not optimized) and process the data.
On the resulting spectrum, you must define the spectral range (a peak or
group of peaks) to be used for optimization. To do that, click-hold the left
mouse button at one edge of the desired region and drag the cursor to
the other edge. The ToPsSPIN display will automatically be adjusted to
show the selected region only. You must now store this region by entering
dpll.
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The popt dialog box allows you to create an entry for each parameter
you want to optimize. By default, it shows only one entry; more parame-
ters can be added by clicking the button Add parameter. Furthermore the
following fields are offered:

OPTIMIZE : Optimization of the parameters in the group

Step by Step

The parameters of a group are optimized one after the other.
NEXP can be different for each parameter. The total number of
experiments is the sum of the NEXP value of each parameter.
The result of each parameter optimization is stored in a sepa-
rate PROCNO.

Simultaneous

The parameters of a group a optimized simultaneously. NEXP
must be the same for each parameter and represents the total
number of experiments. The result of the parameter optimiza-
tion is stored in one PROCNO.

Array

The parameters of a group a optimized according to an N-
dimensional array (N is the number of parameters in a group).
NEXP can be different for each parameter. The total number of
experiments is the product of the NEXP value of each parame-
ter. The result of the parameter optimization is stored in one
PROCNO.

No Optimization

The parameter is not optimized.

GROUP : group number. Optimization starts with the lowest group
number.

PARAMETER : The parameter to be optimized. If OPTIMIZE is set to No
Optimization, the parameter will be stored as comment in the optimiza-
tion setup.

OPTIMUM : Optimization criterion (see below).
STARTVAL : First value of the parameter.
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ENDVAL : Last value of the parameter.

NEXP : Number of experiments.

VARMOD : Parameter variation mode: linear or logarithmic.

INC : Parameter increment value. Unused for VARMOD = log.
The optimization criterion OPTIMUM can take the following values:

POSMAX - the maximum value of a positive peak
NEGMAX - the maximum value of a negative peak
MAGMAX - the maximum magnitude value of a peak
MAGMIN - the minimum magnitude value of a peak
INTMAX - the maximum value of an integral

INTMIN - the minimum value of an integral

ZERO - zero intensity of a peak

At the bottom of the dialog box you will find the following buttons:
Start optimize - start the optimization for all checked parameters

Skip current optimization - stop the optimization for the current param-
eter

Show protocol - show the optimization result. A dialog appears with a
list of protocol files:

popt.protocol : the entire optimization result
popt.protocol. 999 : the optimization result in PROCNO 999
popt.protocol. 998: the optimization result in PROCNO 998
etc.

Add parameter - add a parameter entry

Restore - restore the last saved optimization setup

Save - save the current optimization setup to current dataset EXPNO

Read array file - read optimization setup

Save array file as.. - save current optimization setup for general usage

Stop optimization - stop the optimization for all checked parameters

Delete parameter - delete the selected parameter
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Help - open the popt help page

Clicking the button Start optimize will start the optimization process. Note
that it runs on the current dataset. For each parameter/group, a series of
acquisitions will be performed. The result of this is a series of spectra (ac-
tually spectral regions) that are displayed in one screen and show the op-
timum parameter value. They are stored as one or more processed data

files under the current dataset name and experiment number but under

different processing numbers. For the first parameter/group that is opti-

mized this is PROCNO 999, for the second parameter/group PROCNO

998 etc. As such, you must start popt on a dataset with PROCNO < 900.

The result will also be stored in the so called protocol file (see OUTPUT
FILES)

At the top of the dialog box you will find the following check buttons:

Store as 2D data (ser file)

If checked, the result of the optimization (a series of 1D spectra) will
be stored as a 2D dataset in EXPNO 899. However, if the source da-
taset PROCNO is greater than 100, the EXPNO of the destination 2D
data will be

PROCNO - 100.

The AU program specified in AUNM will be executed
If checked, the AU program defined by AUNM will be executed instead
of the command zg.

Perform automatic baseline correction (ABSF)

If checked, the output data will be baseline corrected with abs£. Note
that this command corrects the selected region (determined by the
processing parameters ABSF1 and ABSF2).

Overwrite existing files (disable confirmation message)
If checked, the output PROCNO, if it exists, will be overwritten without
warning.

Run optimization in background

If checked, the foreground dataset will remain the same during the op-
timization. If it is not checked, the ToPsPIN display will change to
PROCNO 999 where the optimization result is displayed.

To the right of the above checkbuttons, the current values of the param-
eters WDW (window multiplication mode), PH_mod (phase correction
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mode) and FT_mod (Fourier Transform mode) are displayed.

If you want to rerun an optimization, you must first return to the starting
PROCNO.

INPUT FILES
<tshome>/exp/stan/nmr/lists/popt/

<name> - parameter optimization setup for general usage (input of
Read array file..)

<dir>/data/<user>/nmr/<name>/<expno>/

acqu - acquisition parameters
popt.array - parameter optimization setup (input of Restore)
popt.protocol - parameter optimization result (input of Show proto-

col)
<dir>/data/<user>/nmr/<name>/<expno>/pdata/<procno>/
proc - processing parameters
<tshome>/prog/au/bin/

poptau - AU program that runs the optimization (executable)
popthalt - AU program that halts the current optimization (executa-

ble)

OUTPUT FILES
<tshome>/exp/stan/nmr/lists/popt/

<name> - parameter optimization setup for general usage (output of
Save array file as..)

<dir>/data/<user>/nmr/<name>/<expno>/pdata/999

1r - processed data containing the optimization result of the first pa-
rameter/group

<dir>/data/<user>/nmr/<name>/<expno>/pdata/998

1r - processed data containing the optimization result of the 2nd pa-
rameter/group

<dir>/data/<user>/nmr/<name>/<expno>/
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popt.array - parameter optimization setup (output of Save)
popt.protocol - parameter optimization result (output of Start opti-
mize)

<dir>/data/<user>/nmr/<name>/899/

ser - 2D raw data containing the optimization result

SEE ALSO
gs, 28
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resume

NAME
resume - Resume a suspended acquisition

DESCRIPTITION

The command resume resumes an acquisition that has been suspend-
ed.

An acquisition can be suspended with the command suspend. When
this is entered, the acquisition holds as soon as the pulse program state-
ment suspend Or calcsuspend is encountered. If the pulse program
does not contain such a statement, suspend has no effect. Alternatively,
an acquisition can be suspended with the pulse program statement au-
tosuspend Or calcautosuspend. They automatically hold the acquisi-
tion, without user interaction. The command resume continues
acquisition that was suspended, either automatically or with the com-
mand suspend.

For more information on the suspend pulse program statements click:
Help’ Manuals ° [Programming Manuals] Pulse Programming Manual

A resumed acquisition does not start with dummy scans. This can be a
problem if the recycle delay is shorter then 4 times the T1 value of the
measured nucleus.

Note that the suspend information is temporarily stored on the spectrom-
eter FCU, not on disk. As soon as you enter stop or halt, or switch of
the spectrometer, the suspend information is lost and the acquisition can-
not be resumed.

SEE ALSO

suspend, zg, go
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rga

NAME
rga - Automatic receiver gain optimization

DESCRIPTION

The command rga automatically optimizes the receiver gain. It performs
an acquisition with varying receiver gain and finally sets this just below

the value where no overflow occurs. In fact, rga repeatedly executes the
current pulse program but only up to the first go=n or rcyc=n statement.

If you already know the proper value for the receiver gain, you can simply
set RG in eda or by typing rg on the command line.

OUTPUT PARAMETERS
can be viewed with eda or by typing rg:

RG - receiver gain

USAGE IN AUTOMATION
RGA

SEE ALSO
gs, zg, go
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stop

NAME
stop - Stop the acquisition immediately

DESCRIPTION

The command stop stops the acquisition immediately without writing the
data to disk. Note that in most 1D experiments, the data are only written
at the end of the acquisition and using stop would cause a complete loss
of data. As such, itis used in case of emergency. To stop a normal acqui-
sition the halt command is used.

Instead of entering stop on the command line, you can also click the
button in TOPSPIN tool bar or in the acquisition window toolbar.

If, for some reason, a running or hanging acquisition cannot be stopped
with haltor stop, you can use kill. This command will show all active
processes and you can click the go module to stop the acquisition.

SEE ALSO
halt, zg, go, rga, wobb
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suspend

NAME

suspend - Suspend a running acquisition

DESCRIPTITION

The command suspend allows you to hold a running acquisition. When
it is entered, the acquisition holds as soon as the pulse program state-
ment suspend Or calcsuspend is encountered. If the pulse program
does not contains such a statement, suspend has no effect. Alternative-
ly, an acquisition can be suspended with the pulse program statement
autosuspend Or calcautosuspend. They automatically hold the acquisi-
tion, without user interaction. The command resume continues acquisi-
tion that was suspended, either automatically or with the command
suspend.

Note that the suspend information is temporarily stored on the spectrom-
eter FCU, not on disk. As soon as you enter stop or halt, or switch of
the spectrometer, this information is lost and the acquisition cannot be re-
sumed.

Standard Bruker pulse programs do not contain any suspend statements.
Therefore, suspend can only be used with user defined pulse programs
which contain a suspend statement at a certain position.

SEE ALSO

resume, zg, go
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topguide

NAME
topguide - Open the TopGuide acquisition and processing tool

DESCRIPTITION

The command topguide opens a guided acquisition and processing
tool; TopGuide. This is a new tool in TOPSPIN 2.0 for setting up and
processing NMR experiments. As the name implies, it is an interactive
guide, which guides the user through the necessary and important steps
after the insert of a new sample (tuning & matching the sample, locking,
shimming) and the following process of running a basic 1H 1D (refer-
ence) experiment. After these initial steps it offers a database with the ba-
sic 1D and 2D NMR experiments and helps the user to set those up.

The special user interface of TopGuide guides the user through all the
steps and decisions the user has to make. Each item within the user in-
terface has its own help context. The help text describes the action the
user has to take, gives explanations for parameters, provides explana-
tions for procedures and/or some background information.

TopGuide keeps track of the experiments which were run using TopGuide
and stores this information in a database. For each sample (i.e. Name)
the status window (Performed Experiments) shows the list of experi-
ments which are setup (Acquisition no) or done (Acquisition yes) and if
processing has been done or not (Processing yes/no). The status list pro-
vides an easy way to access these datasets: a simple left click will load
the dataset into the upper part of the window, a right click pops up a con-
text menu which gives access to either acquisition or processing param-
eters or some other dataset related commands.

On the right is a tool bar with 4 buttons for the basic operation. GO starts
the acquisition on the current dataset. New in TopSpin 2.0 is a spooler
mechanism (acquisition queue), which enables the user to run more than
1 experiment in a row. It is an option and the user should enable auto-
queuing in the Preference dialog. If enabled all acquisition commands are
automatically send into this queue. The Queue button offers the possibil-
ity to use the queue even if auto-queuing is disabled or to delay the start
of an acquisition by entering a certain start time. The Tools button gives
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access to preferences and some other options and to leave TopGuide
(Quit). STOP will stop the current acquisition and will disable the spooler.
This is meant to be used as an emergency stop. If the user wants to end
a running acquisition in a defined manner, he should type halt instead
of stop (or halt 8 on an Avance Il system). Halt will finish the current
scan and writes the acquired data to disk.

General concept of TopGuide

If a new sample should be measured some initial set up steps are strong-
ly advised: tuning & matching the probe to the sample susceptibility, lock-
ing and shimming. TopGuide will lead the user through these initial steps
by either doing all this automatically or giving help information for manual
operation. The automatic execution, of course, depends on the hardware
configuration. A probe equipped with ATMA and a Z-gradient coil allows
this. Without this hardware, some manual steps are necessary and the
user is guided through manual tuning & matching and/or manual shim-
ming. If a Z-gradient is present, TopGuide assumes that automatic gradi-
ent shimming is set up and it will be used by TopGuide. TopGuide caches
the information about these steps executed, so further measurements
(within the same TopGuide session) on the same sample will not ask for
this again, unless the user changes the nucleus to be measured. If, for
example, a 1H,13C-HSQC had been measured and therefore TopGuide
knows that the probe is tuned to 1H and 13C, and you now want to run a
1H,15N-HSQC (let's assume you have a BBI probe and therefore this is
possible), TopGuide will request to tune & match again, now to 15N in-
stead of 13C.

The use of TopGuide to setup new experiments is based on a recorded

1H 1D spectrum. This proton spectrum is used to determine the signal to
noise ratio (S/N) for this sample. TopGuide will select the highest signal

in the spectrum (solvent peaks are automatically excluded), but the user
may select a different peak/area for the S/N calculation. This may be of

interest if the highest signal doesn't belong to the investigated compound
in the case of mixtures or impurities. The determined S/N is used to esti-
mate the number of scans (NS) for further experiments, to obtain a spec-
trum with reasonable S/N.

TopGuide provides a database with basic 1D and 2D experiments.
TopGuide will only offer those experiments, which may be run on the cur-
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rent hardware, i.e. if the current probe doesn't have a gradient, TopGuide
will not offer any experiment using gradients, but if the probe is equipped
with a gradient, TopGuide will preferably offer experiments using gradi-
ents. If the current probe is a 13C/1H dual probe, TopGuide will not offer
any 15N experiment. There are some more filter criteria based on the
field strength. TopGuide doesn't use parameter sets like Icon-NMR.
Therefore TopGuide will never show the same experiments as you would
see in the listing of parameter sets, it will always show recommended ex-
periments.

Before an additional experiment is performed, TopGuide will ask you to
determine the spectral width (SW) to be used in the proton dimension. It
will pre-select the region with peaks found in the reference spectrum. You
may change this to your needs, but be aware that for homonuclear 2D
measurements this SW will be applied to the indirect dimension as well.
If you select a region which cuts off some signals, you may get folding of
these peaks in the indirect dimension of a homonuclear 2D. The informa-
tion about your selected SW is stored together with the reference spec-
trum and will be used in all further 1H dimensions for this sample.

The database contains reasonable acquisition and processing parame-
ters for all experiments in it. Some parameters are fixed (typical coupling
constants), some are dynamic and are chosen based on the molecular
size (like relaxation times or NOESY mixing times), the field strength
(TD) or the actual experiment (different SW for 13C in HSQC and HM-
BC).

Tools button

The Tools button gives access to some preferences and options. Data Di-
rectory: the user can select the data directory where the NMR data is
stored (disk unit). The initial setting depends on how TopGuide has been
started. If you start TopGuide on a loaded dataset, it will keep that disk
unit, if you start with no active dataset this will open a new windows and
the data path defaults to the ToOPSPIN installation directory (i.e. C:\Bruk-
en\TopSpin under Windows or /opt/topspin under Linux).

User: if additional Icon-NMR users are defined, you can login as one of
those.

Preferences: you can enable or disable '‘auto-processing'. Depending on
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this setting newly acquired data is automatically processed with default
processing parameters and options, or not.

Protected acquisition: this means that once an FID or SER file has been
acquired it is protected by TopGuide, you are not allowed to overwrite it.
The start of a new acquisition on a dataset with an existing FID/SER file
will automatically create a new dataset (i.e. expno).

Protected processing: the same protection as described above is applied
to processed data. Existing ones are not overwritten, but instead a new
procno is created.

Import reference 1D: Setting up experiments with TopGuide requires a
reference 1D spectrum, which is measured with TopGuide by default. If
a 1D spectrum has already been recorded outside of TopGuide and you
want to use this one as a reference for further experiments, you can im-
port it into TopGuide. The import searches all expnos of the current data-
set and displays the available 1D 1H spectra.

SEE ALSO

zg
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tr

NAME
tr - Transfer data to disk during the acquisition

DESCRIPTITION

The command tr transfers (writes) data to disk during a 1D acquisition.
This is, for example, useful if you want to do a Fourier transform and view
the spectrum before the acquisition has finished. Another reason to use
tris to save the currently acquired scans of a long term acquisition. This
avoids losing all data in case of a power loss.

As an alternative to entering halt on the command line, you can click
the MW button of the TOPSPIN toolbar.

The command tr can even be entered with an optional parameter as
command tr <1...-NS>(please note that <1...-NS> must be integer
and > 0). If <1...-NS> is defined the execution of tris delyed until the
total number of scans reaches a multiple of <1...-NS>. This option is use-
ful if a fid with a complete phase cycle should be stored to disk.

As an alternative to typing tr <1...-NS> inthe command line the but-
ton can be used from the TOPSPIN toolbar with this botton:

=

This button opens the following dialogue:

& Save FID to disk [E5C

Flease specify the scan number when you
want to save the FID to disk.

scan (NS 128

| ok || cancel

Figure 8.13
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OUTPUT FILES
<dir>/data/<user>/nmr/<name>/<expno>/
fid - 1D raw data
acqus - acquisition status parameters
SEE ALSO
zg, 80
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Xaua, xaup

NAME

xaua - Execute the AU program specified with AUNM
xaup - Execute the AU program specified with AUNMP

DESCRIPTION

The commands xaua and xaup execute the AU program which is spec-
ified by the parameters AUNM and AUNMP, respectively. In all Bruker pa-
rameter sets, these parameters are set to relevant Bruker AU programs.
For example, in the parameter set PROTON, AUNM = au_zg and
AUNMP = proc_1d. When parameter sets are used in automation (ICON-
NMR), the AU programs specified by AUNM and AUNMP perform the ac-
quisition and the processing, respectively.

For details on writing, compiling, and executing AU programs please re-
fer to the ToPsPIN AU reference manual (click Help > Manuals ° [Automa-
tion] AU Programming.

INPUT PARAMETERS
set by the user with eda or by typing aunm :

AUNM - acquisition AU program name for xaua
set by the user with edp or by typing aunmp :
AUNMP - processing AU program name for xaup

INPUT FILES
<tshome>/exp/stan/nmr/au/src/

AU program source files (only input if the AU program is not compiled
yet)
<tshome>/prog/au/bin/
AU program binary executables
<dir>/data/<user>/<name>/nmr/<expno>/

acqu - acquisition parameters (input file for xaua)
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<dir>/data/<user>/<name>/nmr/<expno>/pdata/<procno>/

proc - processing parameters (input file for xaup)

USAGE IN AU PROGRAMS
XAUA

XAUP
XAUPW

XAUPW waits until the AU program has finished before the next state-
ment is executed whereas XAUP doesn’t. XAUA works like XAUPW
is this respect.

SEE ALSO

xau, edau, delau, expinstall, compileall, cplbruk, cpluser
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zg

NAME
zg - Perform an acquisition, overwriting possibly existing data

DESCRIPTION

The command zg performs an acquisition on the current dataset. A new
data window will appear showing the currently acquired fid (see Figure
8.14).

FID: protona 1 1 C:bio guest [T”E”‘S_q
Title | PulseProg | Peaks | Integrals | Sample | Structure Fid| Acqu 4] v

S el e b | D
© Cyclosponn

[*1e6

-05 00

1 2 3 4 [s]

Figure 8.14

Furthermore, the data window selection bar is extended as follows:

o

The buttons of the FID window have the following functions:
- Show FID in shuffled mode
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ki Show FID in unshuffled mode, horizontally arranged
i Show FID in unshuffled mode, vertically arranged
- Show FID in unshuffled mode, interleaved

k4 Switch between FID and spectrum
m Halt the acquisition [halt]

gy Stop the acquisition [stop]

Clicking the = button to switch to real time FT, turns the button
green and opens an extra button to set real time FT settings:
I Switch between FID and spectrum

=¥ Real time FT settings

S Toggle calculation of peak with at 50%, 5.5% and 1.1% height
(Shown as status parameters)

Clicking this button opens the following dialog window:

E! Configure realtime ft

Configure properties of current realtime  display.
all can also setthese propeties in the
processing parameters ofthis dataset.

Window function: v

Fhase correction mode: no

Baseline correction mode: | gquad

’ 0] ” izancel

The command zg performs the following sequence of actions:
1. Read the acquisition parameters
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2. Compile the pulse program defined by the acquisition parameter
PULPROG

3. Execute the pulse program. For most pulse programs this
involves:

» the acquisition of DS dummy scans
+ the acquisition of NS real scans, accumulating the data
» storing the accumulated data to disk

4. Update the acquisition status parameters

Acquisition sequence

Before you can start an acquisition with zg, you will normally have to pre-
pare the experiment. This typically involves the following command se-
quence:

edhead - define the current probehead
edprosol - define the probehead and solvent dependent parameters
new - define a new dataset and make it the current dataset

wobb or atma - tune and match the probehead (atma only for ATM
probes)

lockdisp - open the lock display window

lock - lock the magnetic field

rshor gradshim - read shim values or use gradient shimming
rpar - read a standard parameter set for the desired experiment
getprosol - get the probehead and solvent dependent parameters

edasp - set up nuclei (NUC1, NUC2 etc.) and the spectrometer rout-
ing
ased or eda - adjust the acquisition parameters to your needs

zg - acquire the data
Pulse Program

The type of experiment is mainly determined by the pulse program. A
simple 1D Bruker pulse program is zg, which contains the following lines:
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1 ze ;zero memory, reset scan counter and phase
lists,
enable dummy scans, label 1
2 d1l ;relaxation delay with length D1, label 2
pl phl ;pulse with length P1 and phase ph1
go=2 ph31 ;sample TD points with phase ph31, loop to 2
: times NS+DS
wr #0 :write the data to the current dataset
exit ;end of the pulse program

phl1=0 2 2 0 1 3 3 1;phase program (list) used for the RF pulse
ph31=0 2 2 0 1 3 3 1;phase program (list) used for the receiver

The RF pulse p1 is executed on the default channel (f1) with the default
power level (PL1). The loop to label 2 will be performed NS times to ac-
cumulate this number of scans. The wr statement lies outside of this loop
which means the data are only written to disk once, at the end of the ex-
periment.

Furthermore, an information window will appear showing the current
scan, the total number of scans and the residual experiment time.

The purpose of dummy scans is to reach steady state conditions con-
cerning T1 relaxation. This is necessary whenever the recycle delay of
the experiment is shorter then 4 times the T1 value of the measured nu-
cleus. Furthermore, dummy scans can be used to establish a stable tem-
perature. This is especially important in decoupling experiments where
the irradiation high power increases the sample temperature. The
number of dummy scans is determined by the acquisition parameter DS.
In the pulse program, the ze statement explicitly enables the go state-
ment to perform dummy scans. In contrast, the zd statement disables the
execution of dummy scans.

Transfer to disk

In most 1D experiments, the acquired data are written to disk only once,
at the end of the experiment. You can, however, use the command tr to
write data to disk while the acquisition is running. This is, for example,

useful if you want to do a Fourier transform and view the spectrum after
a few scans. Another reason to use tris to save the currently acquired
scans of a long term experiment. This avoids losing all data in case of a
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power loss. In multidimensional experiments, the wr statement is part of
a loop, and as such, is executed for each increment in the indirect direc-
tion(s). Note that in many pulse programs the wr statement has been re-
placed by the mc statement which performs both the disk write and loop
back function.

Multidimensional data

zg allows you to perform 1D or multi dimensional acquisition. The dimen-
sionality of the data is determined by the pulse program. If this contains
an if and/or st statement, zg assumes a 2D or 3D dataset. Further-
more, if the pulse program contains a nested loop with loop counters td1
and td2, zg assumes a 3D dataset. Finally, the acquisition parameter
PARMODE is evaluated. If the value of PARMODE is not consistent with
the pulse program, zg will display a warning but allow you to continue the
acquisition. 1D data are stored a file named fid under the experiment
number (expno) of the current dataset. 2D and 3D data are stored in a
file named ser in the same directory. The pulse program is not limited to
3D and allows you to acquire data in 4 or more directions. TOPSPIN 2.0
and newer supports processing of nD data. Datasets up to dimension 5
have been tested by Bruker.

Stopping acquisition

Normally, an acquisition will run until it has finished. If, however, you want
to interrupt it, you can do that by clicking the = button or entering the
command halt. This will finish the current scan, write the data to disk
and then stop the acquisition. Note that halt finishes the current scan
but not the current phase cycle. Clicking the ¢} button or entering the
command stop immediately stops the acquisiuon. It does not finish the
current scan or write the data to disk. If, for some reason, haltand stop
do not work, you can use the command kil1 to stop the acquisition.

When an acquisition has finished but the signal to noise is insufficient,
you can accumulate additional scans. Just set the parameter NS to the
number of extra scans and enter go. This command does not overwrite
the existing data but adds the extra scans to them. Caution: go works
correctly if the previous acquisition has finished normally but should not
be used if this has been interrupted with halt or stop (see the descrip-
tion of go).
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Preventing Data Overflow

In TopsPIN 2.0 and newer, 1D raw data are, if necessary, stored as double
precision (64-bit) data. If, based on the number of scans and the current
accumulated signal, data overflow is expected to occur, data are trans-

ferred to the computer that controls the spectrometer, i.e. an automatic

tr command is executed. Here the data are stored in 64-bit double pre-
cision format. The acquisition status parameter DTYPA shows whether

data are stored as integers (DTYPA = 0) or doubles (DTYPA = 2). Cau-
tion: raw data with DTYPA 2 can only be processed with TOPSPIN 2.0 or
newer. Note that processed data are always stored as integer data.

Preventing Data Overwrite

zg overwrites possibly existing raw data. Each user can configure Top-
SPIN to get a warning about existing data or not. Click Preferences > Op-
tions, click Acquisition and uncheck the entry "Overwrite existing FID
without inquiry". Note the difference between zg and go. The latter com-
mand does not overwrite existing data but adds new data to them.

After a manually performed acquisition has finished, it is normally proc-
essed with processing commands like em, £t, apk etc. Processing com-
mands are described in the Processing Reference Manual.

The command zgis automatically executed by AU programs that contain
the ZG macro. Examples of these are au_zg*, au_getl* and multi-
zg. Furthermore, zg is automatically executed when experiments are
started from the automation interfaces ICON-NMR and bnmr.

Note that an acquisition always runs in background which means that
ToPsPIN can do other tasks simultaneously. You can change the focus to
a different data window and process data there. This is actually what hap-
pens all the time during an automation sequence performed by ICON-
NMR.

Pulse programming

ToPsPIN is supplied with a large number of pulse programs from simple

1D to sophisticated multidimensional experiments. Furthermore, you can
write your own pulse programs with the edpul command using the Bruk-
er pulse programs as an example. For a detailed description of the pulse
program syntax click:
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Help’ Manuals’ [Programming Manuals] Pulse Programming Manual

In TopsPIN 2.0 and newer, Python programs and pulse programs can
be integrated. Python programs can calculate pulse program pa-
rameters such as delays, pulses, phases and shapes using Py-
thon, and generate or execute a pulse program by executing a
Python program (cf . Help > Manuals > [Programming Manuals] Pulse
Programming With Python).

Command spooling/queuing

zg, like other acquisition commands, are automatically queued.This al-
lows you to enter multiple zg commands, for example on different data-
sets. Queued commands can be viewed in the Spooling field of the
acquisition status bar. Automatic command spooling as well as the dis-
play of the spooling field in the status bar can be enabled/disabled in the
User Preferences window (command set).

INPUT PARAMETERS

All acquisition parameters as described in chapter 2 of the Acquisition
Reference Guide.

OUTPUT PARAMETERS

All acquisition status parameters as described in chapter 2 of the Acqui-
sition Reference Guide.

INPUT FILES
1D data

<dir>/data/<user>/nmr/<name>/<expno>/
acqu - acquisition parameters
2D data
<dir>/data/<user>/nmr/<name>/<expno>/

acqu - acquisition parameters direct direction (F2)
acqu?2 - acquisition parameters indirect direction (F1)

3D data

<dir>/data/<user>/nmr/<name>/<expno>/
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acqu - acquisition parameters direct direction (F3)
acqu?2 - acquisition parameters indirect direction (F2)
acqu3 - acquisition parameters indirect direction (F1)

All data
<tshome>/exp/stan/nmr/lists/pp
<PULPROG> - the pulse program defined by PULPROG
<tshome>/conf/instr/<curinst>/

scon - spectrometer parameters (created with edscon)

OUTPUT FILES
1D data

<dir>/data/<user>/nmr/<name>/<expno>/

fid - raw data
acqus - acquisition status parameters

2D data
<dir>/data/<user>/nmr/<name>/<expno>/

ser - raw data
acqus - acquisition status parameters direct direction (F2)
acqu2s - acquisition status parameters indirect direction (F1)

3D data
<dir>/data/<user>/nmr/<name>/<expno>/

ser - raw data

acqus - acquisition status parameters direct direction (F3)
acqu2s - acquisition status parameters indirect direction (F2)
acqu3s - acquisition status parameters indirect direction (F1)

All data
<dir>/data/<user>/nmr/<name>/<expno>/

pulseprogram - the precompiled pulse program

audita.txt - acquisition audit trail

scon - spectrometer parameters

cpdprgl - CPD program (output if a cpd1: £2 statement is used)
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cpdprg2 - CPD program (output if a cpd2: £2 statement is used)
.etc.

fgllist - variable frequency list (output if a £q1 statement is used)
fg21list - variable frequency list (output if a fq2 statement is used)
ect.

spnaml - shaped pulse definition (output if a sp1 statement is used)
spnam?2 - shaped pulse definition (output if a sp2 statement is used)
ect.

gpnaml - shaped gradient definition (output if a gp1 statement is
used)

gpnam? - shaped gradient definition (output if a gp2 statement is
used)

ect.

vclist - variable counter list (output if a vc statement is used)
vdlist - variable delay list (output if a vd statement is used)
vplist - variable pulse list (output if a vp statement is used)
dslist - dataset list (outputif a wr #n or wr ## statement is used)
cag_par - rotation matrices for gradients used for imaging
grdprog - shaped gradient definition (output if a ngrad statement is
used)

USAGE IN AU PROGRAMS
ZG

SEE ALSO

g0, gs, rga, wobb, atma, suspend, resume
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Chapter 9

Temperature commands

This chapter describes commands which configure, control or monitor the
temperature unit. Temperature units which are delivered with Bruker spec-
trometers are often referred to as a eurotherm; the make of most units.
They are used to warm up or cool down the NMR sample and keep it at a
certain temperature during the experiment.
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edte

NAME
edte - Edit the temperature parameters

DESCRIPTION

The command edte opens a dialog box from which the temperature unit
can be controlled (see Figure 9.1).

Qs =0l x|

Main display | Monitaring | Corrections| Self-tune | Ramp | Recarding| «|»

Sample temp. £ HOIL

Target termp. mERER  Change.

Probe Heater off SEL max...

Gas flow 2l [/hk - | +

Cooling off Change. ..
|Rec Off | I | BvT3200 |

Figure 9.1

The functionality of this window is described in a separate manual that
can be opened from the ToPsSPIN window by clicking Help > Manuals ’
[Technical Manuals] Temperature Regulation or from the edte window
by clicking Help ° Edte Users Manual

SEE ALSO
teget, te2get, teset, te2set
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teget, te2get

NAME

teget - Get the temperature from the temperature unit
te2get - Get the second temperature from the temperature unit

DESCRIPTION

The command teget gets the temperature from the temperature unit
and stores it in the acquisition status parameter TE.

te2get gets the so called second temperature from a temperature unit
with two regulators. The value is stored in the acquisition status parame-
ter TE2. Temperature units with two regulators are, for example, used in
BEST NMR where the first regulator controls the sample temperature
and the second regulator controls the inlet capillary temperature.

OUTPUT PARAMETERS

TE - demand temperate on the temperature unit
TE2 - demand second temperate on the temperature unit

OUTPUT FILES
<dir>/data/<user>/nmr/<name>/<expno>/

acqus - acquisition status parameters

USAGE IN AU PROGRAMS
TEGET

TE2GET

SEE ALSO
edte, teset, te2set
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teset, te2set

NAME

teset - Set the temperature on the temperature unit
te2set - Set the second temperature on the temperature unit

SYNTAX

teset [<temperature>]
te2set [<temperature>]

DESCRIPTION

The command teset sets the temperature on the temperature unit. It
takes one argument and can be used as follows:

teset

sets the temperature to the value of the acquisition parameter TE. Before
you enter teset without argument you must set TE to the desired tem-
perature, in Kelvin, either from eda or by typing te on the command line.

teset <temperature>
sets the temperature to the specified value.

The command teset is, for example, used in the AU programs
au_zgte and multi zgvt.

te2set Works like teset except that it sets the so called second tem-

perature to the value of the acquisition parameter TE2. This value is set
on the second regulator of a temperature unit with two regulators. Such

units are, for example, used in BEST NMR where the first regulator con-
trols the sample temperature and the second regulator controls the inlet
capillary temperature.

INPUT PARAMETERS

TE - demand temperature on the temperature unit (input of teset)
TE2 - demand second temperature on the temperature unit (input of
teZset)
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INPUT FILES
<dir>/data/<user>/nmr/<name>/<expno>/
acqu - acquisition parameters
USAGE IN AU PROGRAMS
TESET
TE2SET

VT executes the command teset <vt_list index>

SEE ALSO
edte, teget, te2get
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Chapter 10

Miscellaneous

This chapter describes TOPSPIN commands that are somehow acquisition
related and have not been described in previous chapters.
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account

NAME
account - Show acquisition accounting statistics

DESCRIPTION

The command account prints statistics derived from the experiments
performed during a desired time.

Statistics are only available if accounting is switched on. You can do this
as follows:

1. Click Options ’ Preferences [set].

2. Click Acquisition in the left part of the dialog box.
3. Check the item Enable data-acquisition protocol .
4. Click OK

INPUT FOLDERS
<tshome>/prog/curdir/acghistory - acquisition accounting files

SEE ALSO
set, hist
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crpon, crpoff, crplock, crpobs

NAME

crpon - Switch the cryo preamplifier on for the lock and observe channel
crpoff - Switch the cryo preampilifier off for the lock and observe channel
crpobs - Switch the cryo preamplifier on for the observe channel
crplock - Switch the cryo preamplifier on for the lock channel

DESCRIPTION

The ecrp* commands listed above control the internal preamplifier of a
cryoprobe. Cryo probeheads operate at a reduced coil and preamplifier
temperature which improves the signal to noise with a factor of 4. They
are available as Dual or Triple resonance probeheads.

The command crpon switches from the external (HPPR) preamplifier to
the internal cryo preamplifier. This happens for both the observe and the
lock channel.

The command crpoff switches from the internal cryo preamplifier to the
external (HPPR) preamplifier. This happens for both the observe and the
lock channel.

The command czrplock switches from the external (HPPR) preamplifier
to the internal cryo preamplifier. This happens for the lock channel only.

The command crpobs switches from the external (HPPR) preamplifier
to the internal cryo preamplifier. This happens for the observe channel
only.

SEE ALSO
edhead
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delpar, delgp, delsh

NAME

delpar - Delete parameter sets

delgp - Delete gradient programs

delsh - Delete shim files
SYNTAX

delpar [<name>]

delgp and delsh have the same syntax as delpar
DESCRIPTION

The del* commands without argument open a dialog box with a list of
the available entries. They are equivalent to the respective edit com-
mands rpar, edgp and rsh. From the dialog box, you can select entries
and click Delete to delete them. Alternatively, you can use the del* com-
mand with one argument, for example:

delpar myparset

deletes the parameter set myparset.
Note that only user defined entries can be removed.

INPUT FOLDERS
<tshome>/exp/stan/nmr/par - Bruker and user defined parameter sets

<tshome>/exp/stan/nmr/lists/gp - Bruker and user defined gradient pro-
grams

<tshome>/exp/stan/nmr/lists/bsms - shim files

USAGE IN AU PROGRAMS
DELPAR(name)
No AU macros are available for the other del1* commands.

SEE ALSO
dellist, delau, delpul, delcpd, delpy, delmac
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exprof

NAME

exprof - Display excitation profile of selective experiment

DESCRIPTION

The command exprof displays the excitation profile of a selective ex-
periment. The experiment must have been completely setup for acquisi-
tion, before exprof is executed.

exprof opens the dialog shown in Figure 10.1.

E! exprof E|
Select parameters
Reference pulse
Select reference P1:11 [-20dEB, 805 ps] »
Selective pulze

Selective pulze | Gaus! 1000 P12 [64.8 dB, 80000.0 ps] »
Selective pulze type

(%) Excitation (lz-=lv)

(3 Inversion (1z-=-1)

{:} Refocussing (ly-=-Iy1
{:} Mat yet knowen

Calculated region

{:} Full spectrum
(%) vizible region

Keep previous results |:|

[ Ok H Cancel ]

Figure 10.1
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The dialog offers the following options:

Reference pulse
The 90° hard pulse in the same channel as the selective pulse.

Selective pulse

The selective pulse to be examined. If your pulse programs con-
tains only one selective pulse, and it follows the Bruker style guide
(P1=90°, etc.) exprof automatically selects the correct reference
pulse.

Selective pulse type

The rotation type. Automatically set to the value stored in the
shape file. If the shape file does not contain a rotation type Titis
set to ,not yet known® and must be selected in the dialog.

Calculated region (greyed if no spectrum exists)
The profile can be calculated for the entire spectrum or for the cur-
rently displayed region. It always consist of 1000 points.

Keep previous results
If enabled, the result of previous exprof command(s) is kept,
allowing simultaneous display of multiple profiles.

If your pulse program contains only one selective pulse and the wave-
form contains rotation type, you don’t have to set anything in the exprof
dialog. Just click OK, to confirm the dialog.

exprof requires that the NMR-SIM program, delivered on the TOPSPIN
DVD, is installed.

OUTPUT PARAMETERS

PULPROG - pulse program used for the acquisition
SHAPE - array of shaped pulse parameters

INPUT FILES
<dir>/data/<user>/nmr/<name>/<expno>/

acqu - acquisition parameters

1. Shapes created with TOPSPIN 1.3 or older, or with external programs do not contain
the rotation type.
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Figure 10.2
<tshome>/exp/stan/nmr/lists/wave/*

Shape files
SEE ALSO

nmrsim
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getlim1d, geticosy, getixhco, getljres, getlinv

A-260

NAME

getlim1d - Calc. 1D spectral width according to integral ranges
getlcosy - Calc. 2D cosy spectral width from 1D int. ranges
getixhco - Calc. 2D xhco spectral width from 1D int. ranges
getljres - Calc. 2D jres spectral width from 1D int. ranges
getlinv - Calc. 2D inverse spectral width from 1D int. ranges

DESCRIPTION

The getl* commands listed above calculate and set the optimum spec-
tral width for the specified experiment types. The optimum spectral width
is determined from one or two associated 1D datasets, which are defined
as the so called second and third dataset. Before the actual experiment
is performed, the second (and if necessary the third) dataset must be ac-
quired, Fourier transformed and baseline corrected. The latter process-
ing step implicitly determines the integral ranges. The getl1* commands
determine the spectral width such that it includes all integral ranges, in
other words, all signals.

getl*commands are typically used in automation. They are called from
AU programs like au_getlld, au_getlcosy, au_getlinvand
au_getlxhco. These, in turn, are called by ICON-NMR where the prepa-
ration and the actual experiment are defined as a so-called composite 2D
experiment (see ICON-NMR Online help for more information).

getlimld determines the optimum spectral width on a 1D preparation
experiment and then sets the parameter SW on the current 1D dataset
accordingly.

getlcosy determines the optimum spectral width on one 1D prepara-
tion experiment. Then it sets the F2-SW and F1-SW on the current 2D
COSY dataset accordingly.

getlxhco determines the optimum spectral width for F2 and F1 on two
different 1D preparation experiments (typically 1H and X). Then it and
sets the F2-SW and F1-SW on the current 2D XH correlation dataset ac-
cordingly.

getljres determines the optimum spectral width on one 1D prepara-
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tion experiment. Then it sets F2-SW on the current 2D J-resolved dataset
in accordingly.

getlinv determines the spectral width on one 1D preparation experi-
ment. Then it sets F2-SW on the current 2D INVERSE dataset accord-

ingly.
Note that F2-SW refers to the acquisition parameter SW in the F2 direc-
tion and F1-SW refers to the same parameter in the F1 direction.

The first 1D preparation experiment is defined as the so called second
dataset. The second 1D preparation experiment is defined as the so
called third dataset.

OUTPUT PARAMETERS
SW - spectral width in ppm

INPUT FILES
<dir>/data/<user>/nmr/<name>/<expno>/pdata/<procno>
intrng - integral regions
curdat?2 - definition of second and third dataset

OUTPUT FILES
<dir>/data/<user>/nmr/<name>/<expno>/
acqu - acquisition parameters
acqu? - F1 acquisition parameters of a 2D dataset

USAGE IN AU PROGRAMS

GETLIM
executes the command getlimid

GETLCOSY
GETLXHCO
GETLJRES
GETLINV

A-261
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hpdisp

NAME

hpdisp - pulse program display showing signals going to spectrometer
hardware, inclusive exact timing, phase and amplitude.

DESCRIPTION

The command hpdisp opens a new window with a display of all hard-
ware events on selected channels.

hpdisp presents the results of the results of the pulse program simula-
tion using the same software which sends the commands to hardware in
a real experiment. Please note that displaying each event going to the
spectrometer hardware may lead to a very large number of displayed en-
tries, even for simple pulse programs (see Figure 10.3).

FHardware pulse program display (HPDISP) £|E|E|

& 05 B F G EE e e e W Wy T

" » » * = @ o

Figure 10.3

E.g. simple 1D experiment using adiabatic pulses for decoupling may
generate millions of spectrometer events.

SEE ALSO
spdisp
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spdisp

NAME
spdisp - Symbolic (graphical) pulse program display

DESCRIPTION
The command spdisp opens a new window with a symbolic pulse pro-
gram display. It takes one argument and can be used as follows:

spdisp

displays the pulse program defined by the acquisition parameter PUL-
PROG

spdisp <name>

displays the pulse program <name>

spdisp starts the pulse program display part of NMR-SIM. The function-
ality of this program is described in the NMR-SIM manual. This can be
opened by clicking Help > Manuals ° [Analysis and Simulation] NMR-

SIM Experiment Simulation.

spdisp can only start if the following conditions are met:
+ the Bruker AU programs have been installed (with expinstall)
+ the NMR-sIM program is installed (from the TopspPIN DVD)

SEE ALSO

nmrsim

A-263
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stdisp

NAME
stdisp - Shape tool for handling RF shapes and gradients

DESCRIPTION

The command stdisp opens the shape tool window where you can cre-
ate, manipulate and analyse RF shapes and gradients (see Figure 10.4).

=10l x|
ERY BN

Gauss 2 Amplituce

Parameters

|1E|IZ|IZ| Size of Bhape
|1.D Truncation Lewel [%]

Fhase

*

Figure 10.4

The ToPSPIN menu bar will change, showing the entries Shape and Manipu-
late and Shape Tool submenus in Analysis and Options.

File Edit “iew Shapes Analysis Manipulate Options

The functions of the buttons are available as tooltips. A detailed description
of stdisp can be found under Help ° Manuals ’ [Acquisition Application
Manuals] Shapetool.

SEE ALSO
st

A-264
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st

NAME
st - Generate, manipulate and analyse RF shapes and gradients

DESCRIPTPION

De command st allows you to generate, manipulate and analyse RF
shapes and gradients. It is described in a separate manual which can be
opened as follows:

click Help > Manuals ° [Acquisition Application Manuals] Shapetool

SEE ALSO
stdisp

A-265
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commands A-63

directory A-110

name A-106, A-110, A-113
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programs A-14, A-38
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crpoff command A-253
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cryo preamplifier A-253
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dataset list A-19
decimation factor A-16, A-22, A-54
default
printer A-108, A-114
selection in expinstall A-107, A-114
define statement A-50
delete
gradient programs A-254
parameter sets A-254
shim files A-254
delgp command A-254
delpar command A-254
delsh command A-254
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temperature A-46, A-247, A-248
deuterium A-129
digital
digitizer resolution A-15, A-18
filtering A-5, A-16, A-17, A-20, A-22, A-54
lock A-127
quadrature detection A-12, A-18
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mode A-17
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resolution A-15, A-18
start A-16
type A-11, A-17, A-18, A-25, A-117
dimension
2D direct A-4
2D indirect A-4, A-33, A-43, A-45
3D indirect A-4
dimensionality of data A-35
display mode
of the lock window A-140
DNA/RNA experiments A-191
dpa command A-7, A-8, A-52, A-183
DQD mode A-18
DSP firmware A-56
dummy scans A-19, A-181, A-237, A-238
dwell time A-17, A-21, A-22, A-43, A-181
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eda command A-7, A-8, A-10, A-11, A-185, A-
192

edasp command A-13, A-23, A-27, A-33, A-38,
A-59, A-188, A-237

edau command A-5, A-37

edcpd command A-15

edcpul command A-39, A-196

edgp command A-198

edhead command A-39, A-58, A-70, A-91, A-
129, A-163, A-237

edlist command A-19, A-25, A-47, A-48, A-49, A-
50

edlock command A-8, A-31, A-95, A-128, A-132,
A-136

edmac command A-5

ednuc command A-13, A-72, A-89

edprosol command A-8, A-42, A-91, A-152, A-
192, A-237

edpul command A-35

edscon command A-16, A-96, A-242

edsolv command A-99

edsp command A-102

edte command A-246

edtune command A-147, A-151

ej command A-168

eject the sample A-168

em command A-240



eurotherm temperature unit A-245

experiment time A-32, A-206

expinstall command A-18, A-39, A-103, A-104,
A-110

exprof A-255

expt command A-32, A-206

F

FID
area A-154
display A-33, A-41, A-209, A-210
envelope A-152
number A-35
resolution A-23, A-45
signal A-39
field value A-129, A-141
font conventions A-3
frequency
list A-24, A-243
ft command A-35, A-240

G

getlcosy command A-258
getlim1d command A-258
getlinv command A-258
getljres command A-258
getprosol command A-8, A-42, A-95, A-191, A-
237
getxhco command A-258
go command A-11, A-207, A-239
gradient
experiment A-204
file A-26, A-27
parameter table A-25
parameters A-25, A-27
program A-27, A-117, A-198, A-254
pulse length A-192
recovery delay A-192
shaped A-26
shimming A-27, A-237
static A-26
strength A-26
gradshim command A-237
grid display A-140
group delay A-5

gs command A-11, A-33, A-41, A-209
H

ha command A-119
halt command A-32, A-159, A-207, A-213, A-
223, A-225, A-226, A-239
hard pulse A-93, A-94, A-192
hardware resolution A-16, A-18
high power
accessory A-38
amplifier A-27, A-189
output A-189
preamplifier A-27
routing A-60, A-117, A-190
holder position A-58
homodecoupling
duty cycle A-27
experiment A-17
power level A-192
homogeneity of the magnetic field A-141, A-152
hosts file A-66
hpdisp command A-260
HPPR preamplifier A-27, A-177, A-253

iconnmr command A-215

ii command A-11, A-216

ij command A-168

impedance of a probehead A-174, A-175, A-177

input parameters A-8

insert the sample A-168

integral ranges A-258

interface

of the spectrometer A-216

irradiation frequency A-24, A-33, A-34, A-40, A-
41, A-59, A-61, A-116, A-117, A-136, A-
181, A-188, A-209

irradiation frequency offset A-34, A-59, A-61, A-
129, A-209

K
kill command A-159, A-213, A-225, A-239

L
LC-NMR A-191



least significant byte A-54
Ifilter command A-130, A-132
Igain command A-57, A-130, A-132
list
of CPD programs A-198
little endian A-54
lock
channel A-253
display A-130, A-140
frequency A-129, A-141
gain A-136
irradiation frequency A-61
level A-152, A-153
nucleus A-30, A-128, A-129, A-141
parameters A-7, A-31, A-61, A-128, A-129,
A-134, A-142
phase A-61, A-129, A-130, A-141, A-142, A-
154
power A-57, A-61, A-129, A-130, A-136, A-
142
regulator cut-off frequency A-57, A-61, A-
129
regulator filter A-132
regulator gain A-57, A-61, A-129, A-132
regulator time A-57, A-61, A-129, A-132
shift A-57
signal A-129, A-130, A-137, A-141, A-143
status A-59
sweep A-130
table A-128
lock command A-8, A-31, A-42, A-61, A-130, A-
132, A-134, A-143, A-203, A-237
lock display
mode A-140
lockdisp command A-130, A-137, A-140, A-237
lock-in procedure A-61, A-134, A-143
logical frequency channel A-22, A-60, A-93, A-
117, A-188, A-190
loop counter A-29
loop filter A-57, A-61, A-129, A-130, A-132, A-
136, A-137, A-142
loop gain A-57, A-61, A-130, A-132, A-136, A-
137, A-142
loop time A-57, A-61, A-129, A-130, A-132, A-
136, A-137, A-142

-4

loopadj AU program A-130, A-132

lopo command A-8, A-31, A-42, A-61, A-130, A-
138, A-142

[time command A-130, A-132

macros
in AU programs A-5
in TOPSPIN A-5
magnet
air flow A-168
strength A-67
MAS
monitor A-58
spin rate A-58
masr command A-58
matching knob A-176, A-177
matching the probehead A-51, A-158, A-159, A-
161, A-173, A-203
mc command A-46
mixing time A-93
most significant byte A-54
multizg AU program A-240

N

new command A-237
new dataset A-237
next
channel for wobbling A-174
NMR Superuser A-13
nmr_restore command A-121
nmr_save command A-121
nuclei
selection A-188
table A-13, A-72, A-77, A-89, A-90

(o)

O1 spikes A-12
observe nucleus A-61
optimization
of acquisition parameters A-209, A-217
of the lock parameters A-136
of the receiver gain A-224
protocol of popt A-218
output parameters A-8



overflow A-19, A-34, A-224
oversampling A-17, A-19, A-22, A-25, A-55
dwell time A-17, A-22

P

paper format A-108, A-114
paracon command A-125
parameter
editor A-8, A-10
optimization A-209, A-217
sets A-104, A-233, A-254
value types A-10
phase
alignment A-41, A-42, A-93
correction factor A-36
correction of a pulse A-36
correction of the receiver A-37, A-209
correction of the spectrum A-16, A-98
cycle A-19, A-36, A-207, A-213, A-239
list A-209
of the lock signal A-61, A-129, A-130, A-
136, A-141, A-142, A-154
program A-36
phtran AU program A-37
popt command A-217
power
level A-8, A-37, A-41, A-42, A-93, A-94, A-
181, A-192, A-209
mode A-38
preamplifier
gain A-38
modules A-27, A-38, A-60, A-117, A-189, A-
190
of a cryoprobe A-253
of an MSL A-38
routing A-188
switching A-16, A-98
tuning and matching A-175
pre-scan
delay A-16, A-97, A-109, A-181
subdelays A-16, A-97
pre-scan-delay A-115
probehead A-39, A-128
acquisition parameter A-58
ATM A-158, A-161

broadband A-161, A-177
commands A-157
cryo A-253
current A-129, A-164, A-237
dependent lock parameters A-95
dependent parameters A-8, A-42, A-61, A-
91, A-191, A-237
dependent tunefile A-94
impedance A-175
name A-163
parameter editor A-164
parameters A-164
resonance circuit A-174
resonance frequency A-161, A-175, A-177
table A-163
tuning and matching A-51, A-158, A-161, A-
173, A-203, A-237
processing
commands A-3, A-7, A-35, A-46, A-52, A-
53, A-55, A-56, A-240
parameters A-7
prosol parameters A-7, A-8, A-91, A-191
protein experiments A-191
pulse length
CPD A-36, A-181, A-192
decrement A-28
increment A-28
of a 180 degree pulse A-192
of a 90 degree pulse A-93, A-174, A-192
of a gradient pulse A-192
of a hard pulse A-93
of a soft pulse A-93
parameter A-35
reset A-28
pulse program
Bruker defined A-196
compilation A-237
constants A-13
current A-196
edit A-196
for wobble A-160
installation A-104
label A-29, A-32, A-48
user defined A-197
pulse programs A-260



Q

QNP probe A-39

gnpset AU program A-39
quad images A-12
quadrature detection A-12

R

raw data A-5, A-7, A-9, A-31, A-35, A-45, A-54,
A-183, A-207, A-214, A-240, A-242
receiver
channel A-39
gain A-39, A-181, A-209, A-210
gain optimization A-224
gate A-16, A-97
phase A-37, A-209
rs232 channel A-77
recycle delay A-19, A-223, A-238
reference
50 ohm resistor A-175
frequency A-39, A-117, A-126
number A-163
phase A-209
shift A-61, A-130
signal A-61, A-130
substance A-13, A-136
referencing the spectrum A-129
relations
file A-94, A-191
prosol-acquisition A-95, A-191
relaxation delay A-181
resonance circuit A-174, A-177
resonance frequency
of a probehead A-161, A-174, A-175, A-177
resume command A-11, A-207, A-223
rga command A-11, A-224
ro command A-169
ROESY experiment A-93, A-192
rotation of the sample A-40, A-153, A-158, A-
169, A-170, A-175
routing
parameters A-189
table A-13, A-59, A-188, A-189
rpar command A-18, A-35, A-36, A-39, A-237
rsh command A-149, A-155, A-237
RX22

-6

receiver A-16, A-97
rs232 channel A-77

S

sample
depth A-165
diameter A-164, A-165
eject A-168
insert A-168
position A-168
rotation A-153, A-158, A-169, A-175
rotation frequency A-40, A-170
solvent A-42, A-61
temperature A-19, A-238, A-247, A-248
SampleRail A-72
SampleTrack A-72
saturation of the lock signal A-130
sequential mode A-12, A-18
SGI workstation A-54
shape files A-41, A-93, A-117
Shape Tool A-26, A-41
shaped gradient
file name A-243
shaped pulse
file name A-243
frequency offset A-116
in CPD programs A-38
parameters A-41
power A-38
shim
commands A-145, A-154
definition file A-151
file A-149, A-153, A-254
increment A-153
set A-145
unit A-154
value A-149, A-237
shimming
automatically A-151, A-203
manually A-149
on the FID A-152
on the lock signal A-141, A-152
using simplex A-154
simplex algorithm A-154
simplex AU program A-155



simultaneous mode A-12
single channel detection A-12
sliders
on a probehead A-161, A-177
smilies A-55
soft pulse A-93, A-94
solid state A-189
solvent
acquisition parameter A-42
dependent lock parameters A-61, A-95, A-
136
dependent parameters A-8, A-91, A-191, A-
237
list A-100, A-129, A-134
table A-99
spdisp command A-261
spectral width
acquisition parameter A-42
adjustment A-22
in 2D data A-28, A-32
maximum A-43
optimization A-258
parameter A-42, A-44
spectrometer
communication problems A-65
configuration A-63, A-65, A-103
constants A-96
frequency A-129
interface A-216
routing A-59, A-102, A-188, A-190
spectrum
edges A-55
noise A-207
phase correction A-16, A-37, A-98
referencing A-61
resolution A-45
spin rate A-58, A-153
sref command A-31, A-42, A-61, A-130
st command A-263
status of the raw data A-7, A-9, A-183
status parameter
display A-186
stdisp command A-26, A-42, A-262
steady state conditions A-19, A-238
stop command A-159, A-176, A-207, A-213, A-

223, A-225, A-226, A-239
suspend command A-207, A-223, A-226
Switchbox A-38, A-45, A-60, A-189, A-190

T

T1 relaxation A-19, A-238
te2get command A-247
te2set command A-248
teget command A-247
temperature
acquisition parameter A-46
commands A-245
list A-50
of the inlet capillary A-247
of the probe preamplifier A-253
of the probehead coil A-253
of the second regulator A-247, A-248
parameters A-246
stabilization A-19, A-238
unit A-46, A-245, A-246, A-247, A-248
unit rs232 channel A-77
temporary parameters A-8
teset command A-46, A-248
tf3 command A-53
time domain A-45, A-181
TMS A-136
TOCSY experiment A-32, A-93, A-192
topguide command A-227
TOPSPIN
command sequence A-5
display A-220, A-240
file handling A-3
home directory A-4
installation A-103, A-104
macros A-5
menu A-5
parameters A-7
popup menus A-5
status line A-152
tr command A-231, A-238
transfer data to disk A-231
transmitter
frequency A-174
gate A-15
power A-174



tshome directory A-110

tune command A-95, A-148, A-151, A-154, A-
203

tune file A-94, A-95, A-147, A-151, A-152, A-203

tuning knob A-176, A-177

tuning the probehead A-51, A-158, A-159, A-
161, A-173, A-203

U

user defined
CPD programs A-15
gradient files A-26
gradient programs A-254
hard pulses A-94
parameter sets A-254
pulse programs A-39, A-197, A-226
relations file A-94
shape files A-41
soft pulses A-94
user_restore command A-121
user_save command A-121

\'

variable
amplitude list A-46
counter list A-48
dataset list A-19
delay list A-48
pulse list A-49
temperature list A-50

w

wbst command A-173
wbsw command A-173
wbwr A-160
wbwr command A-171
well-plate A-58
wobb command A-51, A-159, A-162, A-173, A-
203, A-237
wobble
curve A-51, A-175
frequency A-174
parameters A-159, A-162, A-178
procedure A-175
pulse program A-160, A-162, A-178

steps A-50, A-173, A-177
sweep width A-51, A-173, A-177

X

xaua command A-13, A-233
xaup command A-233
XCMD macro A-5

z

zg command A-7, A-8, A-11, A-207, A-235, A-
237
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